
USER´S MANUAL
BEDIENUNGSANLEITUNG
MANUEL D’UTILISATION
MANUAL DE USUARIO
INSTRUKCJA OBSŁUGI
MANUALE UTENTE

ZONE X 1208 (D) 
HYBRID ARCHITECTURE DSP MATRIX - 12 IN / 8 OUT 
LDZONEX1208, LDZONEX1208D



CONTENTS / INHALTSVERZEICHNIS / TABLE DES MATIÈRES / INDICE / SPIS TREŚCI / INDICE

ENGLISH
SAFETY INFORMATION� 3
FEATURES� 5
PACKAGING CONTENT� 5
CONNECTIONS, CONTROLS AND DISPLAY ELEMENTS� 5
CONNECTING DEVICES� 6
XILICA DESIGNER SOFTWARE� 8
STARTING THE SOFTWARE� 10
NETWORK VIEW� 10
FIRMWARE UPGRADE� 11
FIRMWARE UPGRADE PROCEDURE� 11
PROJECT VIEW� 14
DESIGN� 15
ONLINE MODE� 18
GPI/O - CONNECTION EXAMPLES� 24
TECHNICAL DATA� 25
MANUFACTURER´S DECLARATIONS� 27

DEUTSCH
SICHERHEITSHINWEISE � 28
EIGENSCHAFTEN� 30
LIEFERUMFANG� 30
ANSCHLÜSSE, BEDIEN- UND ANZEIGEELEMENTE� 30
GERÄTE VERBINDEN� 31
XILICA DESIGNER-SOFTWARE� 33
SOFTWARE STARTEN� 35
NETWORK VIEW� 35
FIRMWARE-UPGRADE� 36
FIRMWARE-UPGRADE DURCHFÜHREN� 36
PROJECT VIEW� 39
DESIGN� 40
ONLINE-BETRIEB� 43
GPI/O – ANSCHLUSSBEISPIELE� 49
TECHNISCHE DATEN� 50
HERSTELLERERKLÄRUNGEN� 52

FRANÇAIS
INFORMATIONS DE SÉCURITÉ� 53
CARACTÉRISTIQUES� 55
CONTENU DE L’EMBALLAGE� 55
CONNEXIONS, DISPOSITIFS DE COMMANDE ET D’AFFICHAGE� 55
CONNEXION DES APPAREILS� 56
LOGICIEL XILICA DESIGNER� 58
DÉMARRAGE DU LOGICIEL� 60
VUE RÉSEAU� 60
MISE À NIVEAU DU MICROLOGICIEL� 61
PROCÉDURE DE MISE À NIVEAU DU MICROLOGICIEL� 61
VUE PROJET� 64
CONCEPTION� 65
MODE EN LIGNE� 68
EXEMPLES DE CONNEXION DES PORTS GPIO� 74
CARACTÉRISTIQUES TECHNIQUES� 75
DÉCLARATIONS DU FABRICANT� 77

ESPAÑOL
INFORMACIÓN DE SEGURIDAD� 78
CARACTERISTICAS� 80
CONTENIDO DEL PAQUETE� 80
CONEXIONES, CONTROLES Y ELEMENTOS DE VISUALIZACIÓN� 80
DISPOSITIVOS DE CONEXIÓN� 81
SOFTWARE XILICA DESIGNER� 83
INICIO DEL SOFTWARE� 85
VISTA DE RED� 85
ACTUALIZACIÓN DEL FIRMWARE� 86
PROCEDIMIENTO DE ACTUALIZACIÓN DEL FIRMWARE� 86
VISTA DE PROYECTO� 89
DISEÑO� 90
MODO ONLINE� 93
EJEMPLOS DE CONEXIÓN DE GPI/O� 99
DATOS TÉCNICOS� 100
DECLARACIONES DEL FABRICANTE� 102

POLSKI
INFORMACJE DOTYCZĄCE BEZPIECZEŃSTWA� 103
WŁAŚCIWOŚCI� 105
ZAWARTOŚĆ ZESTAWU� 105
PODŁĄCZENIE, KONTROLKI I WYŚWIETLANE ELEMENTY� 105
PODŁĄCZANIE URZĄDZEŃ� 106
OPROGRAMOWANIE XILICA DESIGNER� 108
URUCHAMIANIE OPROGRAMOWANIA� 110
WIDOK SIECIOWY� 110
AKTUALIZACJA OPROGRAMOWANIA UKŁADOWEGO� 111
PROCEDURA AKTUALIZACJI OPROGRAMOWANIA UKŁADOWEGO� 111
WIDOK PROJEKTU� 114
DESIGN� 115
TRYB ONLINE� 118
GPI/O – PRZYKŁADOWE PODŁĄCZENIA� 124
DANE TECHNICZNE� 125
OŚWIADCZENIA PRODUCENTA� 127

ITALIANO
INFORMAZIONI SULLA SICUREZZA� 128
CARATTERISTICHE� 130
CONTENUTO DELLA CONFEZIONE� 130
COLLEGAMENTI, CONTROLLI ED ELEMENTI DEL DISPLAY� 130
COLLEGAMENTO DI DISPOSITVI� 131
SOFTWARE XILICA DESIGNER� 133
AVVIO DEL SOFTWARE� 135
NETWORK VIEW� 135
AGGIORNAMENTO DEL FIRMWARE� 136
PROCEDURA DI AGGIORNAMENTO DEL FIRMWARE� 136
PROJECT VIEW� 139
DESIGN� 140
MODALITÀ ONLINE� 143
GPI/O - ESEMPI DI COLLEGAMENTI� 149
DATI TECNICI� 150
DICHIARAZIONI DEL PRODUTTORE� 152



3

ENGLISH

YOU‘VE MADE THE RIGHT CHOICE!
We have designed this product to operate reliably over many years. LD Systems stands for this with its name and many years of experience as 
a manufacturer of high-quality audio products. Please read this User‘s Manual carefully, so that you can begin making optimum use of your LD 
Systems product quickly.
You can find more information about LD-SYSTEMS at our Internet site  WWW.LD-SYSTEMS.COM

SAFETY INFORMATION
1.	 Please read these instructions carefully. 
2.	 Keep all information and instructions in a safe place. 
3.	 Follow the instructions. 
4.	 Observe all safety warnings. Never remove safety warnings or other information from the equipment. 
5.	 Use the equipment only in the intended manner and for the intended purpose. 
6.	 Use only sufficiently stable and compatible stands and/or mounts (for fixed installations). Make certain that wall mounts are properly installed 

and secured. Make certain that the equipment is installed securely and cannot fall down. 
7.	 During installation, observ  e the applicable safety regulations for your country. 
8.	 Never install and operate the equipment near radiators, heat registers, ovens or other sources of heat. Make certain that the equipment is 

always installed so that is cooled sufficiently and cannot overheat. 
9.	 Never place sources of ignition, e.g., burning candles, on the equipment. 
10.	 Ventilation slits must not be blocked.
11.	 Do not use this equipment in the immediate vicinity of water (does not apply to special outdoor equipment - in this case, observe the special 

instructions noted below. Do not expose this equipment to flammable materials, fluids or gases. Avoid direct sunlight!
12.	 Make certain that dripping or splashed water cannot enter the equipment. Do not place containers filled with liquids, such as vases or drinking 

vessels, on the equipment. 
13.	 Make certain that objects cannot fall into the device. 
14.	 Use this equipment only with the accessories recommended and intended by the manufacturer. 
15.	 Do not open or modify this equipment. 
16.	 After connecting the equipment, check all cables in order to prevent damage or accidents, e.g., due to tripping hazards. 
17.	 During transport, make certain that the equipment cannot fall down and possibly cause property damage and personal injuries.
18.	 If your equipment is no longer functioning properly, if fluids or objects have gotten inside the equipment or if it has been damaged in anot 

her way, switch it off immediately and unplug it from the mains outlet (if it is a powered device). This equipment may only be repaired by 
authorized, qualified personnel. 

19.	 Clean the equipment using a dry cloth. 
20.	Comply with all applicable disposal laws in your country. During disposal of packaging, please separate plastic and paper/cardboard. 
21.	 Plastic bags must be kept out of reach of children.
22.	Please note that changes or modifications not expressly approved by the party responsible for compliance could void the user´s  

authority to operate the equipment.

FOR EQUIPMENT THAT CONNECTS TO THE POWER MAINS
23.	CAUTION: If the power cord of the device is equipped with an earthing contact, then it must be connected to an outlet with a protective ground. 

Never deactivate the protective ground of a power cord. 
24.	 If the equipment has been exposed to strong fluctuations in temperature (for example, after transport), do not switch it on immediately. 

Moisture and condensation could damage the equipment. Do not switch on the equipment until it has reached room temperature. 
25.	Before connecting the equipment to the power outlet, first verify that the mains voltage and frequency match the values specified on the 

equipment. If the equipment has a voltage selection switch, connect the equipment to the power outlet only if the equipment values and the 
mains power values match. If the included power cord or power adapter does not fit in your wall outlet, contact your electrician. 

26.	Do not step on the power cord. Make certain that the power cable does not become kinked, especially at the mains outlet and/or power adapter 
and the equipment connector. 

27.	 When connecting the equipment, make certain that the power cord or power adapter is always freely accessible. Always disconnect the equipment 
from the power supply if the equipment is not in use or if you want to clean the equipment. Always unplug the power cord and power adapter from 
the power outlet at the plug or adapter and not by pulling on the cord. Never touch the power cord and power adapter with wet hands. 

28.	Whenever possible, avoid switching the equipment on and off in quick succession because otherwise this can shorten the useful life of the equipment.
29.	IMPORTANT INFORMATION: Replace fuses only with fuses of the same type and rating. If a fuse blows repeatedly, please contact an authorised 

service centre. 
30.	To disconnect the equipment from the power mains completely, unplug the power cord or power adapter from the power outlet. 
31.	 If your device is equipped with a Volex power connector, the mating Volex equipment connector must be unlocked before it can be removed. 

However, this also means that the equipment can slide and fall down if the power cable is pulled, which can lead to personal injuries and/or 
other damage. For this reason, always be careful when laying cables. 

32.	Unplug the power cord and power adapter from the power outlet if there is a risk of a lightning strike or before extended periods of disuse.
33.	 The appliance is not to be used by persons (including children) with reduced physical, sensory or mental capabilities, or lack of experience  

and knowledge.
34.	Children must be instructed not to play with the device.
35.	If the power cord of the device is damaged, do not use the device. The power cord must be replaced by an adequate cable or assembly from an 

authorized service center.
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FEATURES
•	 Hybrid architecture DSP processor 
•	 DSP templates available for different installation requirements
•	 40-bit floating point DSP engine with analog devices dual core SHARC+ and ARM Cortex A5 processor
•	 New generation Linux operating system
•	 Premium grade microphone preamps and high-performance 32 bit AD/DA converters
•	 12 balanced mic/line inputs with 48V phantom power selection per input
•	 8 balanced outputs
•	 8 GPI and 8 GPO logic ports
•	 6-pole terminal block connectors (pitch 3.81 mm) for all audio and control inputs/outputs
•	 REMOTE bus for integration with wall panels and paging microphones from LD Systems
•	 Clean and intuitive front panel design
•	 Ethernet interface for remote control via the universal control software Xilica Designer
•	 Remote control apps available in both iOS and Android, for custom user panels
•	 Integrated event scheduler
•	 Optional 64x64 Dante expansion (audio over IP connectivity)
•	 19” rack device, 1 RU

PACKAGING CONTENT
•	 LD ZoneX hardware
•	 Power cable
•	 User manual

CONNECTIONS, CONTROLS AND DISPLAY ELEMENTS
FRONT

1  GLOBAL STATUS LEDS
POWER = device is powered on
NETWORK = network connection established
REMOTE = LD Systems remote devices connected  
		  (paging microphones, control panels, etc)

2  INPUT & OUTPUT LEDS
White = Signal present
Red = Signal overdriven

2 1 2

CAUTION:
To reduce the risk of electric shock, do not remove cover (or back). There are no user serviceable parts 
inside. Maintenance and repairs should be exclusively carried out by qualified service personnel.

The warning triangle with lightning symbol indicates dangerous uninsulated voltage inside the unit, which may cause an  
electrical shock.

The warning triangle with exclamation mark indicates important operating and maintenance instructions.

Warning! This symbol indicates a hot surface. Certain parts of the housing can become hot during operation. After use, wait for a 
cool-down period of at least 10 minutes before handling or transporting the device.

Warning! This device is designed for use below 2000 metres in altitude.

Warning! This product is not intended for use in tropical climates.

CAUTION! HIGH VOLUMES IN AUDIO PRODUCTS!
This device is meant for professional use. Therefore, commercial use of this equipment is subject to the respectively applicable national accident 
prevention rules and regulations. As a manufacturer, Adam Hall is obligated to notify you formally about the existence of potential health risks.
Hearing damage due to high volume and prolonged exposure: When in use, this product is capable of producing high sound-pressure levels (SPL) 
that can lead to irreversible hearing damage in performers, employees, and audience members. For this reason, avoid prolonged exposure to 
volumes in excess of 90 dB.

NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment genera-
tes, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause
harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this 
equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the 
user is encouraged to try to correct the interference by one or more of the following measures:
– Reorient or relocate the receiving antenna.
– Increase the separation between the equipment and receiver.
– Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
– Consult the dealer or an experienced radio/TV technician for help.
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FEATURES
•	 Hybrid architecture DSP processor 
•	 DSP templates available for different installation requirements
•	 40-bit floating point DSP engine with analog devices dual core SHARC+ and ARM Cortex A5 processor
•	 New generation Linux operating system
•	 Premium grade microphone preamps and high-performance 32 bit AD/DA converters
•	 12 balanced mic/line inputs with 48V phantom power selection per input
•	 8 balanced outputs
•	 8 GPI and 8 GPO logic ports
•	 6-pole terminal block connectors (pitch 3.81 mm) for all audio and control inputs/outputs
•	 REMOTE bus for integration with wall panels and paging microphones from LD Systems
•	 Clean and intuitive front panel design
•	 Ethernet interface for remote control via the universal control software Xilica Designer
•	 Remote control apps available in both iOS and Android, for custom user panels
•	 Integrated event scheduler
•	 Optional 64x64 Dante expansion (audio over IP connectivity)
•	 19” rack device, 1 RU

PACKAGING CONTENT
•	 LD ZoneX hardware
•	 Power cable
•	 User manual

CONNECTIONS, CONTROLS AND DISPLAY ELEMENTS
FRONT

1  GLOBAL STATUS LEDS
POWER = device is powered on
NETWORK = network connection established
REMOTE = LD Systems remote devices connected  
		  (paging microphones, control panels, etc)

2  INPUT & OUTPUT LEDS
White = Signal present
Red = Signal overdriven

2 1 2

DE
UT

SC
H

EN
GL

ISH
FR

AN
ÇA

IS
ES

PA
ÑO

L
PO

LS
KI

ITA
LIA

NO



6

BACK

3  POWER CONNECTOR AND FUSE HOLDER
IEC power connector with fuse holder. The packaging content includes a suitable power cable.
CAUTION: Only replace the fuse with another of the same type and with the same ratings. See information on the housing. If the fuse repeatedly 
blows, please contact an authorised service centre. 

4  ON/OFF SWITCH
Rocker switch to turn the device on and off.

5  ETHERNET - USB - RESET
Communication expansion card with Ethernet connector, or Ethernet + Dante (64 x 64 I/O) on “D” model, for communication between the ZoneX 
processor and the host computer, Micro USB recovery port for firmware recovery and IP reset button.

6  REMOTE
LD Systems remote bus for the integration with future control panels and paging microphones from LD Systems. Please note that this connector 
only supports LD Systems remote bus-compatible devices and not Ethernet switch ports!

7  GPO
8 GPO outputs (logic ports) with two selectable modes per output: LED (3 mA) or sink (300 mA). 3-pole terminal blocks (pitch 3.81 mm). Please also 
note the connection examples in this user manual (see GPI/O – CONNECTION EXAMPLES)

8  GPI
8 GPI inputs (logic ports), with short to ground activation. 3-pole terminal blocks (pitch 3.81 mm). Please also note the connection examples in this 
user manual (see GPI/O – CONNECTION EXAMPLES)

9   OUTPUTS
8 balanced audio outputs. 3-pole terminal blocks (pitch 3.81 mm).

10   INPUTS
12 balanced audio mic/line inputs with switchable 48V phantom power per channel. 3-pole terminal blocks (pitch 3.81 mm).

CONNECTING DEVICES
LD Systems ZoneX DSP processor and other control units run on a network-based infrastructure and are configured and controlled via a computer 
with the Xilica Designer software.

PREREQUISITES FOR OPERATION
•	 Computer
•	 Network interface (router, PoE switch) 

A router is required for the IP address assignment and quick and easy connection to your computer and connected control units. A PoE switch is 
required for control units without local power supply.

•	 Ethernet cable. All wired connections use a standard RJ45 Ethernet cable (Cat 5e or better).

4

6

3

7 8 9 10

5

Don‘t connect to any 
ethernet switch port!

This port is only for LD 
Systems remote bus 
compatible devices.
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A NETWORK CONNECTION BETWEEN HOST COMPUTER AND ZONEX PROCESSOR CAN BE CREATED AS FOLLOWS:

A. ROUTER WITH ACTIVATED DHCP SERVER (RECOMMENDED)
When using a router with an enabled DHCP server, the ZoneX processor automatically acquires the IP address during start-up, as soon as the 
connection exists. It is recommended to use a router and PoE switch if further control units/controllers from other manufacturers are connected to 
the network. This combination provides a DHCP server and also facilitates the power supply for the connected devices. We recommend using Linksys 
routers and Netgear switches.

Note: Routers/switches with activated DHCP server should generally be switched on first. And all Ethernet cables should be connected to the 
hardware before the devices are switched on. This will allow for a correct IP address assignment.

•	 First, turn on the router/switch.
•	 Then connect the host computer to a DHCP enabled router via an Ethernet cable.
•	 Connect the router to the ZoneX processor via an Ethernet cable.
•	 Connect the ZoneX processor to the mains and switch it on.

B. NON-DHCP-BASED DIRECT CONNECTION OR INDIRECT CONNECTION VIA ETHERNET SWITCH
If the processor is directly connected to a computer or indirectly via a switch and no DHCP server is available, the connection cannot be established 
automatically.
Therefore, non-DHCP-based connections must be configured manually. Further details can be found in the Xilica Designer help file or in the LD 
Systems ZoneX FAQ.

BACK
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XILICA DESIGNER SOFTWARE
The Xilica Designer software not only enables a detailed configuration of the ZoneX processor, but also offers access to the configuration of 
third-party remote control units, facilitates the management of optional Dante network devices and provides universal third-party device control 
integration.

MAC OS X INSTALLATION
System requirements:
•	 Mac OS X 10.8 or higher
•	 1 GHz processor or higher
•	 500 MB free hard disk space
•	 1 GB graphics card
•	 4 GB RAM

1. Download the latest version of Xilica Designer software to your computer from the LD Systems website (www.ld-systems.com).
2. Open the downloaded .zip file.
3. Then open the file XilicaDesigner.mpkg.
4. An installation window now appears. Follow the individual steps.

5. If the installation process is successful, the installation window displays the message: “The installation was successful”.

7. The Xilica Designer software is now installed.
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WINDOWS INSTALLATION
System requirements:
•	 Windows 7 or higher
•	 1 GHz processor or higher
•	 500 MB free hard disk space
•	 1 GB graphics card
•	 4 GB RAM

1. Download the latest version of Xilica Designer software to your computer from the LD Systems website (www.ld-systems.com).
2. Open the downloaded .zip file.
3. Then open the file XilicaDesigner.exe.
4. An installation window nor appears. Click “Install” to continue.

5. Wait until the installation process is complete. This may take a few minutes.
6. If the installation process is successful, Windows asks you for permission to allow firewall access. We recommend setting up the system so that 

communication for Xilica Designer is authorized on private networks such as home or business networks. Public networks can be included if 
required. 

Select the desired options via the control panel and then click on “Allow Access” to complete the configuration.

7. The Xilica Designer software is now installed.
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STARTING THE SOFTWARE
Find the Xilica Designer software on your desktop or in the application folder. Double-click the software to start it.
You can now create a new design project or open a design project, start the network view, or start the Dante view.

NETWORK VIEW
The network view displays all processors and control units on the network. Here you can find device information such as connection status, 
computer IP address, device IP address, Mac address, device name, manufacturer and firmware version.

The connected processor(s) should be visible in network view. There is a connection status indicator in the top left corner of each device block.

Green: The device is connected and ready for operation.

Yellow: The device is connected and online but is not ready for operation. Move the cursor over the network indicator, and a pop-up window will 
display a message with information about the detected problem. (The message usually says that no device design is loaded).

Red:  The device is not connected and is offline. There is no communication between Xilica Designer software and the device. Please check all cables 
and connections and make sure that the device is switched on. If the processor is performing a firmware upgrade or restarting, there may be a 
temporary interruption. 

From time to time, you may see an exclamation mark (!). This means that a firmware upgrade is available. This does not normally require 
immediate intervention, but the project file does not contain updated models since the earlier firmware is not supported. Further details can be 
found in the Xilica Designer help file or in the LD Systems ZoneX FAQ.
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FIRMWARE UPGRADE
Please note that the use of an old software version with new firmware or the use of new software with old firmware works in principle but the 
range of functions may be limited or the functionality may not be optimal in all cases. 

We recommend always using the latest versions of software and firmware.

Before you start, check the software and firmware versions.

To check the device’s firmware version, ensure that your device is switched on and online. The network view marks devices available for a firmware 
upgrade with a yellow triangle using an exclamation mark. In addition, the device’s firmware version is also listed in the device block for the 
respective device.

The current software version is displayed when you click on About in the menu in the top bar.

FIRMWARE UPGRADE PROCEDURE
Save the device’s design file on your computer as all programmed data will be deleted from the device during the upgrade. When the firmware 
upgrade is complete, the design file can be reloaded on the device.

•	 The device must be online and ready for operation to perform a firmware upgrade.

•	 The newest firmware version for the corresponding Zone X model can be downloaded from the LD Systems website (www.ld-systems.com).
•	 Right-click in network view on a device block and select “Firmware Upgrade”.
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A warning then appears that the firmware upgrade will delete all data from your device. Confirm with “OK” to continue.

A dropdown menu now appears from which you can select the desired firmware file from a file system or a firmware version previously 
downloaded via the “Device Firmware Manager” (in the “Device Management” menu). Confirm with “Ok” and find the folder where you saved the 
new firmware file. Select the file and click “Open”.
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A status bar in the device window shows the progress of the firmware upgrade.

DO NOT SWITCH THE DEVICE OFF OR DISCONNECT IT FROM THE COMPUTER. If the device if switched off or disconnected from the computer during the 
firmware upgrade, this may result in a complete corruption of the processor. In this case, a “USB Firmware Recovery” must be performed.

As soon as the firmware file is successfully downloaded to the device, it automatically restarts and the internal data is updated. This may take a few 
minutes. During this time, the network indicator is RED and the device is offline.

When the firmware upgrade is complete, the green “ON” indication reappears. 

NOTE: The yellow area with the message “No Data” means that no design has been loaded to the device.
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PROJECT VIEW
There are two ways to create a new project:

AUTO CONFIGURATION
If your device is listed in network view, select it and click in the top right on Create New Project from Selected Device(s). This automatically takes 
you to the project view and enables you to select a design template.

EMPTY PROJECT

The second option is to create a new project via File > New Project.
If you start with an empty project, Xilica Designer asks which DSP series you want to use. ZoneX is based on the Solaro DSP series, so choose 
 Solaro Series.

1. “COMPONENT LIBRARY” MENU
This menu provides a list of devices and design modules for use in your project. Find the ZoneX processor in LD Systems > Processors.

2. WORK AREA
The work area is used to create and configure devices.

3. “OBJECT PROPERTY” MENU
 This menu lets you configure the object features for the corresponding design.

1

2
3
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DESIGN
For demonstration purposes, in this case only one DSP hardware block will be used, however a design can also include several DSP hardware objects.
A project design can be created offline (without connected hardware) and loaded on your device later.

1. Drag and drop the desired DSP module, ZoneX1208 in this case, from the "Component Library" into the work area.

2. A selection window appears with all design templates (Select Design Template). Select one of the templates offered and you’ll see a brief 
description and overview of its key features. Select a suitable template for your project, and confirm with Ok. 

Detailed descriptions of the different templates can be found in the FAQ on LD Systems ZoneX.

3. The ZoneX processor is configured accordingly.
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4. Select the ZoneX module to highlight it. You can now adjust the device features in the “Object Property“ menu on the right.
 Note: The object features depend on the device and vary depending on the selected object. 

5. Double-click on the ZoneX module to open the schematic design overview. The “Global Dante” template is selected in this example. The window 
size can be changed by dragging on the corner of the window.
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6. All DSP modules can be processed offline. Double-click on the desire module to open it. You can then adjust the settings for the DSP module to 
your project’s requirements.

In this example, the phantom power has been activated and the gain values adjusted in the first two channels of the input settings.  In addition, we 
have renamed the first four channels in the audio input modules and processed input channel 1.

7. Now double-click on the main matrix mixer module to route the input signals to the corresponding outputs.  
These can also be processed with an output processing module.
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8. If you have changed the settings offline, save your project in the desired location by clicking on File > Save As. If you have changed an existing 
project file, save this using File > Save. You get the same effect by clicking on the “Save” symbol in the top right of the work area. 

It is a good idea to save backups of project files externally.
The file extension (naming extension) for saved project files is .pjxml.

ONLINE MODE
If you select online mode, the design file is loaded on the connected device(s) and you can make changes in real time.
In this case, all devices must be connected and online (green “ON” indicator in network view).

To switch to online mode, the device module must be assigned to the physical hardware.

1. Select the device module you want to assign from the project view.
2. Right-click on the device module and select Map to Physical Device.
3. The recognised devices are now listed with their Mac addresses. If several identical devices are connected to the network, they can be identidied 

by their Mac addresses. Network view shows the Mac addresses for the individual devices.

It is very important that the name of the device block in the design file precisely matches the unit in the network view, otherwise the design 
cannot be loaded on the corresponding hardware.
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If everything is mapped, the color of the module changes to solid green and the Mac address of the device is shown under device module.

4. Now click Load Design to Device(s), at the top of the work area.
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5. A window appears in which you can check the devices onto which you want to load your design. 
Confirm with Ok.

Switching to online mode may take a few minutes. Do not interrupt the process! The process progress is shown in percent in a status bar at the 
top of the window.
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As soon as the work area appears in a solid green, you are in online mode and the design menu is no longer available.

6. If you want to change the settings in real time, you can either double-click on the DSP module in project view or on the device block in project 
view and you will then see the schematic representation of the corresponding device.
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7. Double-click on the desired DSP module or a I/O block to change settings in real time.

You can return to design mode at any time via the button Go Back to Design Mode at the top of the work area.
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You will be asked if you want to copy the changes made online into the project design.

Confirm with Yes to save the online settings to the project.
Click No to return to the previous design file.

After transferring online settings to a project, the option File > Save overwrites the original project file.  
Select File > Save As to create and save a new project file.

It is a good idea to save backup copies of project files externally.
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GPI/O - CONNECTION EXAMPLES
8 LOGIC INPUTS (BINARY INPUTS, GPI)

Activation via ground connection (G)

8 LOGIC OUTPUTS (BINARY OUTPUTS, GPO)

2 outout modes available:
•	 LED (3 mA)
•	 Sink to Ground (300 mA) 

Connection example: 

•	 Each GPI offers two switching states (via software) 
•	 This means two different presets can be driven  
 Open and close the contacts
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TECHNICAL DATA
Item number LDZONEX1208 / D

Product type DSP audio matrix for fixed installation

General data

Audio inputs 12 balanced mic/line inputs + 1 remote bus audio input

Audio outputs 8 balanced line outputs

Logic inputs 8 GPI - activation via ground connection.

Logic outputs 8 GPO – modes: LED (3 mA) or sink (300 mA), per output selectable

Remote bus Yes

Connectors Inputs/outputs: 3-pole terminal block, pitch 3.81 mm;  
micro USB B service connector, remote IN RJ45, Ethernet RJ45
ZoneX1208D: Dante Primary and Secondary RJ45

LEDs Front: “POWER”, “NETWORK”, “REMOTE“, inputs 1 – 12 and outputs 1 – 8: White signal LED, red clip LED

Front panel controls No

Rear panel controls Mains ON/OFF, “IP RESET”

Expansion slots for Ethernet (ZONEX1208) or Ethernet + Dante (ZONEX1208D) cards

Cooling Passive convection cooling

Power supply Wide-range switch mode power supply

Power supply connector 3-pole power supply socket (IEC)

Operating voltage 90 – 240 V AC; 50/60 Hz

Mains fuse T2.5 A L / 250 V 

Mains OFF-ON inrush current 21 A  

Power consumption,  
idle mode

23 W

Max. Power consumption 60 W

Operating temperature 0 °C ... +40 °C (max. 60 percent relative humidity)

Width 19" rack (483 mm)

Height 1 HE (44.5 mm)

Depth 315 mm (with terminal blocks)

Weight 3.8 kg

Rack distance to the next 
device (height)

1 HE

Rack depth (required) 350 mm

Performance specifications

Nominal input sensitivity -22 dBu (sine wave, 1 kHz, max. gain)

Nominal input clipping +20 dBu (Sine wave, 1 kHz)

Harmonic distortion (THD+N) <0.003 percent (Line IN – OUT, +13 dBu signal, 20 Hz – 20 kHz, gain 0 dB)

Intermodulation distortion 
(IMD), SMPTE:

<0.01 percent (-10 dB under clip), analyzer bandwidth 90 kHz

Frequency response 15 Hz – 22 kHz (+/-0.15 dB)

Input impedance Line: 4 kOhm (balanced)
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Item number LDZONEX1208 / D

Signal-to-noise ratio >117 dB @ +20 dBu, gain 0 dB, 20 kHz bandwidth, A-weighted 

Dynamic range (AES17) 112 dB

Channel crosstalk 120 dB @ 100 Hz, 120 dB @ 1 kHz, 105 dB @ 10 kHz

Common mode rejection, 
CMRR IEC

>60 dB (1 kHz)

Max. Gain 42 dB

Digital specifications

DSP 40-bit floating point processing, Analog Devices dual core SHARC+ processor

System latency 4.3 ms

Resolution AD/DA converter 32 Bit 

Sampling rate AD/DA converter 48 kHz

Remote bus specifications, measured between REM In and REM Out

Nominal input sensitivity 20 dBu

Nominal input clipping 20 dBu

Harmonic distortion (THD+N) <0.006% (+18 dBu, 20 Hz – 20 kHz)

Frequency response 20 Hz – 20 kHz (0.1 dB)

Input impedance  50 kOhm (balanced)

Signal-to-noise ratio >105 dB (+20 dBu, 20 kHz bandwidth, A-weighted) 

Common mode rejection, 
CMRR IEC

>65 dB @ 1 kHz

Gain 0 dB

Phantom power +48 V DC / 500 mA

Protection Resettable fuse (internal)
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MANUFACTURER´S DECLARATIONS
MANUFACTURER‘S WARRANTY & LIMITATIONS OF LIABILITY  
You can find our current warranty conditions and limitations of liability at: https://cdn-shop.adamhall.com/media/pdf/MANUFACTURERS-DECLARATIONS_
LD_SYSTEMS.pdf To request warranty service for a product, please contact Adam Hall GmbH, Adam-Hall-Str. 1, 
61267 Neu Anspach / Email: Info@adamhall.com / +49 (0)6081 / 9419-0.

CORRECT DISPOSAL OF THIS PRODUCT
(valid in the European Union and other European countries with a differentiated waste collection system) 
This symbol on the product, or on its documents indicates that the device may not be treated as household waste. This is to avoid environ-

mental damage or personal injury due to uncontrolled waste disposal. Please dispose of this product separately from other waste and have it 
recycled to promote sustainable economic activity. Household users should contact either the retailer where they purchased this product, or their 
local government office, for details on where and how they can recycle this item in an environmentally friendly manner. Business users should 
contact their supplier and check the terms and conditions of the purchase contract. This product should not be mixed with other commercial waste 
for disposal.

FCC STATEMENT
1.	 This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
	 (1) This device may not cause harmful interference, and
	 (2) This device must accept any interference received, including interference that may cause undesired operation
2.	 any Changes or modifications not expressly approved by the party responsible for compliance could void the user‘s authority to operate the equipment.

NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules.  
These limits are designed to provide reasonable protection against harmful interference in a residential installation. 
This equipment generates uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may 
cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. 
If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, 
the user is encouraged to try to correct the interference by one or more of the following measures:
Reorient or relocate the receiving antenna.
Increase the separation between the equipment and receiver.
Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
Consult the dealer or an experienced radio/TV technician for help.

FCC RADIATION EXPOSURE STATEMENT
This equipment complies with FCC radiation exposure limits set forth for an uncontrolled environment. This equipment should be installed and 
operated with minimum distance 20cm between the radiator & your body

CE COMPLIANCE
Adam Hall GmbH states that this product meets the following guidelines (where applicable):
R&TTE (1999/5/EC) or RED (2014/53/EU) from June 2017
Low voltage directive (2014/35/EU)
EMV directive (2014/30/EU)
RoHS (2011/65/EU)
The complete declaration of conformity can be found at www.adamhall.com. 
Furthermore, you may also direct your enquiry to info@adamhall.com.

EU DECLARATION OF CONFORMITY
Hereby, Adam Hall GmbH declares that this radio equipment type is in compliance with Directive 2014/53/EU. 
The full text of the EU declaration of conformity is available at the following 
internet address: www.adamhall.com/compliance/ 
 
Printing errors and mistakes, as well as technical or other changes are reserved!
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DEUTSCH

SIE HABEN DIE RICHTIGE WAHL GETROFFEN!
Dieses Gerät wurde unter hohen Qualitätsanforderungen entwickelt und gefertigt, um viele Jahre einen reibungslosen Betrieb zu gewährleisten. 
Dafür steht LD Systems mit seinem Namen und der langjährigen Erfahrung als Hersteller hochwertiger Audioprodukte. Bitte lesen Sie diese Bedie-
nungsanleitung sorgfältig, damit Sie Ihr neues Produkt von LD Systems schnell optimal einsetzen können.
Mehr Informationen zu LD SYSTEMS finden Sie auf unserer Internetseite WWW.LD-SYSTEMS.COM

SICHERHEITSHINWEISE 
1.	 Lesen Sie diese Anleitung bitte sorgfältig durch. 
2.	 Bewahren Sie alle Informationen und Anleitungen an einem sicheren Ort auf. 
3.	 Befolgen Sie die Anweisungen. 
4.	 Beachten Sie alle Warnhinweise. Entfernen Sie keine Sicherheitshinweise oder andere Informationen vom Gerät. 
5.	 Verwenden Sie das Gerät nur in der vorgesehenen Art und Weise. 
6.	 Verwenden Sie ausschließlich stabile und passende Stative bzw. Befestigungen (bei Festinstallationen). Stellen Sie sicher, dass Wandhalterungen 

ordnungsgemäß installiert und gesichert sind. Stellen Sie sicher, dass das Gerät sicher installiert ist und nicht herunterfallen kann. 
7.	 Beachten Sie bei der Installation die für Ihr Land geltenden Sicherheitsvorschriften. 
8.	 Installieren und betreiben Sie das Gerät nicht in der Nähe von Heizkörpern, Wärmespeichern, Öfen oder sonstigen Wärmequellen.  

Sorgen Sie dafür, dass das Gerät immer so installiert ist, dass es ausreichend gekühlt wird und nicht überhitzen kann.
9.	 Platzieren Sie keine Zündquellen wie z.B. brennende Kerzen auf dem Gerät. 
10.	 Lüftungsschlitze dürfen nicht blockiert werden.
11.	 Betreiben Sie das Gerät nicht in unmittelbarer Nähe von Wasser. Bringen Sie das Gerät nicht mit brennbaren Materialien, Flüssigkeiten oder 

Gasen in Berührung. Direkte Sonneneinstrahlung vermeiden! 
12.	 Sorgen Sie dafür, dass kein Tropf- oder Spritzwasser in das Gerät eindringen kann. Stellen Sie keine mit Flüssigkeit gefüllten Behältnisse wie 

Vasen oder Trinkgefäße auf das Gerät. 
13.	 Sorgen Sie dafür, dass keine Gegenstände in das Gerät fallen können. 
14.	 Betreiben Sie das Gerät nur mit dem vom Hersteller empfohlenen und vorgesehenen Zubehör. 
15.	 Öffnen Sie das Gerät nicht und verändern Sie es nicht. 
16.	 Überprüfen Sie nach dem Anschluss des Geräts alle Kabelwege, um Schäden oder Unfälle, z. B. durch Stolperfallen zu vermeiden. 
17.	 Achten Sie beim Transport darauf, dass das Gerät nicht herunterfallen und dabei möglicherweise Sach- und Personenschäden verursachen kann.
18.	 Wenn Ihr Gerät nicht mehr ordnungsgemäß funktioniert, Flüssigkeiten oder Gegenstände in das Geräteinnere gelangt sind, oder das Gerät 

anderweitig beschädigt wurde, schalten Sie es sofort aus und trennen es von der Netzsteckdose (sofern es sich um ein aktives Gerät handelt). 
Dieses Gerät darf nur von autorisiertem Fachpersonal repariert werden. 

19.	 Verwenden Sie zur Reinigung des Geräts ein trockenes Tuch. 
20.	Beachten Sie alle in Ihrem Land geltenden Entsorgungsgesetze. Trennen Sie bei der Entsorgung der Verpackung bitte Kunststoff und Papier bzw. 

Kartonagen voneinander. 
21.	 Kunststoffbeutel müssen außer Reichweite von Kindern aufbewahrt werden.
22.	Sämtliche vom Benutzer vorgenommenen Änderungen und Modifikationen, denen die für die Einhaltung der Richtlinien verantwortliche Partei 

nicht ausdrücklich zugestimmt hat, können zum Entzug der Betriebserlaubnis für das Gerät führen.

BEI GERÄTEN MIT NETZANSCHLUSS
23.	ACHTUNG: Wenn das Netzkabel des Geräts mit einem Schutzkontakt ausgestattet ist, muss es an einer Steckdose mit Schutzleiter angeschlossen 

werden. Deaktivieren Sie niemals den Schutzleiter eines Netzkabels. 
24. Schalten Sie das Gerät nicht sofort ein, wenn es starken Temperaturschwankungen ausgesetzt war (beispielsweise nach dem Transport).  

Feuchtigkeit und Kondensat könnten das Gerät beschädigen. Schalten Sie das Gerät erst ein, wenn es Zimmertemperatur erreicht hat. 
25. Bevor Sie das Gerät an die Steckdose anschließen, prüfen Sie zuerst, ob die Spannung und die Frequenz des Stromnetzes mit den auf dem Gerät 

angegebenen Werten übereinstimmen. Verfügt das Gerät über einen Spannungswahlschalter, schließen Sie das Gerät nur an die Steckdose an, 
wenn die Gerätewerte mit den Werten des Stromnetzes übereinstimmen. Wenn das mitgelieferte Netzkabel bzw. der mitgelieferte Netzadapter 
nicht in Ihre Netzsteckdose passt, wenden Sie sich an Ihren Elektriker. 

26. Treten Sie nicht auf das Netzkabel. Sorgen Sie dafür, dass spannungsführende Kabel speziell an der Netzbuchse bzw. am Netzadapter und der 
Gerätebuchse nicht geknickt werden. 

27. Achten Sie bei der Verkabelung des Geräts immer darauf, dass das Netzkabel bzw. der Netzadapter stets frei zugänglich ist. Trennen Sie das Gerät 
stets von der Stromzuführung, wenn das Gerät nicht benutzt wird, oder Sie das Gerät reinigen möchten. Ziehen Sie Netzkabel und Netzadapter 
immer am Stecker bzw. am Adapter und nicht am Kabel aus der Steckdose. Berühren Sie Netzkabel und Netzadapter niemals mit nassen Händen. 

28.	Schalten Sie das Gerät möglichst nicht schnell hintereinander ein und aus, da sonst die Lebensdauer des Geräts beeinträchtigt werden könnte.
29.	WICHTIGER HINWEIS: Ersetzen Sie Sicherungen ausschließlich durch Sicherungen des gleichen Typs und Wertes. Sollte eine Sicherung wiederholt 

auslösen, wenden Sie sich bitte an ein autorisiertes Servicezentrum. 
30.	Um das Gerät vollständig vom Stromnetz zu trennen, entfernen Sie das Netzkabel bzw. den Netzadapter aus der Steckdose. 
31.	 Wenn Ihr Gerät mit einem verriegelbaren Netzanschluss bestückt ist, muss der passende Gerätestecker entsperrt werden, bevor er entfernt 

werden kann. Das bedeutet aber auch, dass das Gerät durch ein Ziehen am Netzkabel verrutschen und herunterfallen kann, wodurch Personen 
verletzt werden und/oder andere Schäden auftreten können. Verlegen Sie Ihre Kabel daher immer sorgfältig. 

32.	Entfernen Sie Netzkabel und Netzadapter aus der Steckdose bei Gefahr eines Blitzschlags oder wenn Sie das Gerät länger nicht verwenden.
33.	Das Gerät darf nicht von Personen (einschließlich Kindern) mit eingeschränkten körperlichen, sensorischen oder geistigen Fähigkeiten oder 

mangelnder Erfahrung und Kenntnis benutzt werden.
34.	Kinder müssen angewiesen werden, nicht mit dem Gerät zu spielen.
35.	Wenn das Netzkabel des Geräts beschädigt ist, darf das Gerät nicht verwendet werden. Das Netzkabel muss durch ein adäquates Kabel oder eine 

spezielle Baugruppe von einem autorisierten Service-Center ersetzt werden.
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ACHTUNG
Entfernen Sie niemals die Abdeckung, da sonst das Risiko eines elektrischen Schlages besteht. Im In-
neren des Geräts befinden sich keine Teile, die vom Bediener repariert oder gewartet werden können. 
Lassen Sie Wartung und Reparaturen ausschließlich von qualifiziertem Servicepersonal durchführen.

Das gleichseitige Dreieck mit Blitzsymbol warnt vor nichtisolierten, gefährlichen Spannungen im Geräteinneren, die einen elektri-
schen Schlag verursachen können.

Das gleichseitige Dreieck mit Ausrufungszeichen kennzeichnet wichtige Bedienungs- und Wartungshinweise.

1Warnung! Dieses Symbol kennzeichnet heiße Oberflächen. Während des Betriebs können bestimmte Teile des Gehäuses heiß 
werden. Berühren oder transportieren Sie das Gerät nach einem Einsatz erst nach einer Abkühlzeit von mindestens 10 Minuten.

Warnung! Dieses Gerät ist für eine Nutzung bis zu einer Höhe von maximal 2000 Metern über dem Meeresspiegel bestimmt.

Warnung! Dieses Gerät ist nicht für den Einsatz in tropischen Klimazonen bestimmt.

ACHTUNG HOHE LAUTSTÄRKEN BEI AUDIOPRODUKTEN!
Dieses Gerät ist für den professionellen Einsatz vorgesehen. Der kommerzielle Betrieb dieses Geräts unterliegt den jeweils gültigen nationalen Vor-
schriften und Richtlinien zur Unfallverhütung. Als Hersteller ist Adam Hall gesetzlich verpflichtet, Sie ausdrücklich auf mögliche Gesundheitsrisiken 
hinzuweisen. Gehörschäden durch hohe Lautstärken und Dauerbelastung: Bei der Verwendung dieses Produkts können hohe Schalldruckpegel (SPL) 
erzeugt werden, die bei Künstlern, Mitarbeitern und Zuschauern zu irreparablen Gehörschäden führen können. Vermeiden Sie länger anhaltende 
Belastung durch hohe Lautstärken über 90 dB.
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EIGENSCHAFTEN
•	 Hybrid-DSP-Prozessor 
•	 DSP-Templates für unterschiedliche Installationen
•	 40-Bit-Floating-Point-DSP-Engine mit Analog Devices Dual-Core SHARC+- und ARM Cortex A5-Prozessor
•	 Aktuelles Linux-Betriebssystem
•	 Premium-Mikrofon-Preamps und leistungsstarke 32-Bit-AD/DA-Wandler
•	 12 symmetrische Mic/Line-Eingänge mit separat zuschaltbarer 48-V-Phantomspeisung pro Eingang
•	 8 symmetrische Ausgänge
•	 8 GPI- und 8 GPO-Logik-Ports (Binäreingänge/-ausgänge)
•	 6-Pol-Klemmblock-Anschlüsse (Abstand 3,81 mm) für alle Audio- und Controller-Eingänge/Ausgänge
•	 REMOTE-Bus zur Integration von Wall Panels und Paging-Mikrofone von LD Systems
•	 Klare, intuitive Gerätefront
•	 Ethernet-Schnittstelle zur Fernsteuerung über die universelle Control-Software Xilica Designer
•	 Fernsteuerung über iOS- und Android-Apps, mit individuellen User-Layouts
•	 Integrierter Event Scheduler (Planer)
•	 Optional: 64x64 Dante-Erweiterung (Audio over IP)
•	 19“-Rack-Gerät, 1 HE

LIEFERUMFANG
•	 LD ZoneX Hardware
•	 Netzkabel
•	 Bedienungsanleitung

ANSCHLÜSSE, BEDIEN- UND ANZEIGEELEMENTE
VORDERSEITE 

1  GLOBALE STATUS LEDS
POWER = Gerät ist eingeschaltet
NETWORK = Netzwerkverbindung aktiv
REMOTE = LD Systems-Remote-Geräte angeschlossen  
		  (Paging-Mikrofone, Steuerungseinheiten etc.)

2  INPUT & OUTPUT LEDS
Weiß = Signalpräsenz
Rot = Signal übersteuert 

2 1 2
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RÜCKSEITE

3  NETZBUCHSE UND SICHERUNGSHALTER
IEC Netzbuchse mit integriertem Sicherungshalter. Ein geeignetes Netzkabel befindet sich im Lieferumfang.
WICHTIGER HINWEIS: Ersetzen Sie die Sicherung ausschließlich durch eine Sicherung des gleichen Typs und mit gleichen Werten. Achten Sie auf den 
Aufdruck auf dem Gehäuse. Sollte die Sicherung wiederholt auslösen, wenden Sie sich bitte an ein autorisiertes Servicezentrum. 

4  EIN- / AUSSCHALTER
Wippschalter zum Ein- und Ausschalten des Geräts.

5  ETHERNET - USB - RESET
Kommunikations-Erweiterungskarte mit Ethernet-Anschluss oder Ethernet + Dante (64 x 64 I/O) bei Modell „D“ – zur Kommunikation zwischen dem 
ZoneX-Prozessor und dem Host-Rechner. Micro-USB-Recovery-Port zur Firmware-Wiederherstellung und IP-Reset-Taste.

6  REMOTE
LD Systems Remote-Bus zur Integration zukünftiger Steuerungseinheiten und Paging-Mikrofone von LD Systems. Bitte beachten Sie, dass dieser 
Anschluss nur Remote Bus-kompatible Geräte und keine Ethernet-Switch-Ports unterstützt!

7  GPO
8 GPO-Ausgänge (Logik-Ports) mit zwei wählbaren Modi pro Ausgang: LED (3 mA) oder Sink (300 mA). 3-Pol-Klemmblöcke (Abstand 3,81 mm). Bitte 
beachten Sie auch die Anschlussbeispiele in dieser Bedienungsanleitung (siehe GPI/O – ANSCHLUSSBEISPIELE).

8  GPI
8 GPI-Eingänge (Logik-Ports), Aktivierung über Masseschluss. 3-Pol-Klemmblöcke (Abstand 3,81 mm). Bitte beachten Sie auch die Anschlussbeispiele 
in dieser Bedienungsanleitung (siehe GPI/O – ANSCHLUSSBEISPIELE)

9   OUTPUTS
8 symmetrische Audio-Ausgänge. 3-Pol-Klemmblöcke (Abstand 3,81 mm).

10   INPUTS
12 symmetrische Audio-Mic/Line-Eingänge mit separat zuschaltbarer 48-V-Phantomspeisung pro Kanal. 3-Pol-Klemmblöcke (Abstand 3,81 mm).

GERÄTE VERBINDEN
Der ZoneX-DSP-Prozessor und andere Steuerungseinheiten nutzen eine netzwerkbasierte Infrastruktur und werden mittels eines Computers und der 
Xilica Designer-Software eingerichtet und gesteuert.

VORAUSSETZUNGEN FÜR DEN BETRIEB
•	 Computer
•	 Netzwerk-Interface (Router, PoE-Switch) 

Für die IP-Zuweisung und schnelle, einfache Verbindung mit Ihrem Computer und angeschlossenen Steuerungseinheiten ist ein Router erforderlich.
Ein PoE-Switch wird für Steuerungseinheiten ohne lokale Stromversorgung benötigt.

•	 Ethernet-Kabel. Alle kabelgebundenen Verbindungen erfolgen über Standard-RJ45-Ethernet-Kabel (Cat 5e oder besser).

4

6

3

7 8 9 10

5

Don‘t connect to any 
ethernet switch port!

This port is only for LD 
Systems remote bus 
compatible devices.
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•	 Aktuelles Linux-Betriebssystem
•	 Premium-Mikrofon-Preamps und leistungsstarke 32-Bit-AD/DA-Wandler
•	 12 symmetrische Mic/Line-Eingänge mit separat zuschaltbarer 48-V-Phantomspeisung pro Eingang
•	 8 symmetrische Ausgänge
•	 8 GPI- und 8 GPO-Logik-Ports (Binäreingänge/-ausgänge)
•	 6-Pol-Klemmblock-Anschlüsse (Abstand 3,81 mm) für alle Audio- und Controller-Eingänge/Ausgänge
•	 REMOTE-Bus zur Integration von Wall Panels und Paging-Mikrofone von LD Systems
•	 Klare, intuitive Gerätefront
•	 Ethernet-Schnittstelle zur Fernsteuerung über die universelle Control-Software Xilica Designer
•	 Fernsteuerung über iOS- und Android-Apps, mit individuellen User-Layouts
•	 Integrierter Event Scheduler (Planer)
•	 Optional: 64x64 Dante-Erweiterung (Audio over IP)
•	 19“-Rack-Gerät, 1 HE

LIEFERUMFANG
•	 LD ZoneX Hardware
•	 Netzkabel
•	 Bedienungsanleitung

ANSCHLÜSSE, BEDIEN- UND ANZEIGEELEMENTE
VORDERSEITE 

1  GLOBALE STATUS LEDS
POWER = Gerät ist eingeschaltet
NETWORK = Netzwerkverbindung aktiv
REMOTE = LD Systems-Remote-Geräte angeschlossen  
		  (Paging-Mikrofone, Steuerungseinheiten etc.)

2  INPUT & OUTPUT LEDS
Weiß = Signalpräsenz
Rot = Signal übersteuert 

2 1 2
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EINE NETZWERKVERBINDUNG ZWISCHEN HOST-COMPUTER UND ZONEX-PROZESSOR KANN AUF FOLGENDE WEISE HERGESTELLT WERDEN:

A. ROUTER MIT AKTIVIERTEM DHCP-SERVER (EMPFOHLEN)
Bei Einsatz eines Routers mit aktiviertem DHCP-Server bezieht der ZoneX-Prozessor die IP-Adresse automatisch beim Hochfahren, sobald eine Verbin-
dung besteht. Sollten weitere Steuerungseinheiten/Controller anderer Hersteller in das Netzwerk eingebunden sein, empfiehlt sich die Verwendung 
eines Routers und PoE-Switchs. Diese Kombination stellt einen DHCP-Server bereit und ermöglicht auch die Stromversorgung der angeschlossenen 
Geräte. Wir empfehlen den Einsatz von Linksys-Routern und Netgear-Switches.

Hinweis: Router/Switches mit aktiviertem DHCP-Server sollten grundsätzlich zuerst eingeschaltet werden, und alle Ethernet-Kabel sollten mit der 
Hardware verbunden sein, bevor die angeschlossene Hardware eingeschaltet wird. So können die IP-Adressen immer korrekt zugewiesen werden.

•	 Schalten Sie zuerst den Router/Switch ein.
•	 Verbinden Sie dann den Host-Computer über ein Ethernet-Kabel mit dem Router (DHCP aktiviert).
•	 Verbinden Sie den Router über ein Ethernet-Kabel mit dem ZoneX-Prozessor.
•	 Schließen Sie den ZoneX-Prozessor am Stromnetz an und schalten ihn ein.

B. NICHT DHCP-BASIERTE DIREKTVERBINDUNG ODER INDIREKTE VERBINDUNG VIA ETHERNET-SWITCH
Wenn der Prozessor direkt an einen Computer oder indirekt über einen Switch angeschlossen ist und kein DHCP-Server zur Verfügung steht, kann die 
Verbindung nicht automatisch hergestellt werden.
Nicht DHCP-basierte Verbindungen müssen daher manuell konfiguriert werden. Weitere Informationen finden Sie in der Xilica Designer-Hilfedatei 
oder im LD Systems ZoneX FAQ.
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XILICA DESIGNER-SOFTWARE
Die Xilica Designer-Software ermöglicht nicht nur eine detaillierte Konfiguration des ZoneX-Prozessors, sondern bietet auch Zugriff auf program-
mierbare Fernsteuerungseinheiten (Remote-Controller) und ermöglicht die Einrichtung und Verwaltung beliebiger Dante-Netzwerkgeräte sowie die 
Integration universeller Controller anderer Hersteller.

INSTALLATION UNTER MAC OS X
Systemvoraussetzungen:
•	 Mac OS X 10.8 oder höher
•	 Prozessor ab 1 GHz
•	 500 MB freier Festplattenspeicher
•	 1 GB Grafikkarte
•	 4 GB RAM

1. Laden Sie die neueste Version der Xilica Designer-Software von der LD Systems-Website (www.ld-systems.com) auf Ihren Rechner.
2. Öffnen Sie die heruntergeladene .zip-Datei.
3. Öffnen Sie anschließend die Datei XilicaDesigner.mpkg.
4. Nun erscheint ein Installationsfenster. Folgen Sie den einzeln beschriebenen Schritten.

5. Wenn der Installationsvorgang erfolgreich abgeschlossen ist, erscheint im Installationsfenster die Meldung: „The installation was successful.“.

7. Die Xilica Designer-Software ist nun installiert.
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INSTALLATION UNTER WINDOWS
Systemvoraussetzungen:
•	 Windows 7 oder höher
•	 Prozessor ab 1 GHz
•	 500 MB freier Festplattenspeicher
•	 1 GB Grafikkarte
•	 4 GB RAM

1. Laden Sie die neueste Version der Xilica Designer-Software von der LD Systems-Website (www.ld-systems.com) auf Ihren Rechner.
2. Öffnen Sie die heruntergeladene .zip-Datei.
3. Öffnen Sie anschließend die Datei XilicaDesigner.exe.
4. Nun erscheint ein Installationsfenster. Klicken Sie auf „Install“, um fortzufahren.

5. Warten Sie, bis der Installationsprozess beendet ist. Dies kann einige Minuten in Anspruch nehmen.
6. Wenn der Installationsvorgang erfolgreich abgeschlossen ist, fragt Windows Sie um die Erlaubnis, auf die Firewall zuzugreifen. Wir empfehlen, das 

System so einzustellen, dass die Kommunikation in privaten Netzwerken wie Heim- oder Firmennetzwerken für Xilica Designer zugelassen ist. 
Öffentliche Netze können je nach Anforderung einbezogen werden. 

Wählen Sie die gewünschten Optionen über die Kontrollfelder aus, und klicken Sie dann auf „Allow Access“ (Zugriff zulassen), um die Konfiguration 
abzuschließen.

7. Die Xilica Designer-Software ist nun installiert.
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SOFTWARE STARTEN
Lokalisieren Sie die Xilica Designer-Software auf Ihrem Desktop oder im Anwendungsordner. Starten Sie die Software mit einem Doppelklick.
Nun können Sie ein neues Design-Projekt erstellen oder ein Design-Projekt öffnen sowie die Netzwerk-Ansicht und die Dante-Ansicht aufrufen.

NETWORK VIEW
In der Netzwerk-Ansicht werden alle Prozessoren und Steuerungseinheiten im Netzwerk dargestellt. Hier finden Sie Geräteinformationen wie 
Verbindungsstatus, Computer-IP-Adresse, Geräte-IP-Adresse, MAC-Adresse, Gerätename, Hersteller und Firmware-Version.

In der Netzwerk-Ansicht sollte/n der/die angeschlossene/n Prozessor/en zu sehen sein. In der linken oberen Ecke des Device-Blocks für das jeweili-
ge Gerät befindet sich eine Anzeige für den Verbindungsstatus.

Grün: Das Gerät ist angeschlossen und betriebsbereit.

Gelb: Das Gerät ist angeschlossen und online, aber nicht betriebsbereit. Fahren Sie mit dem Mauszeiger über die Netzwerk-Anzeige, und es öffnet 
sich ein Fenster mit den identifizierten Problemen. (In der Regel dürfte die Meldung lauten, dass kein Geräte-Design geladen ist.)

Rot:  Das Gerät ist nicht angeschlossen und offline. Zwischen der Xilica Designer-Software und dem Gerät findet keine Kommunikation statt. Bitte 
überprüfen Sie alle Kabel und Verbindungen, und vergewissern Sie sich, dass das Gerät eingeschaltet ist. Sollte der Prozessor gerade ein Firmwa-
re-Upgrade durchführen oder neu starten, kann es sich um eine temporäre Unterbrechung handeln. 

Von Zeit zu Zeit ist es möglich, dass Sie ein Ausrufezeichen (!) sehen. Dies zeigt an, dass ein Firmware-Upgrade zur Verfügung steht. Normalerweise 
erfordert dies kein sofortiges Eingreifen, sofern die Projektdatei keine aktualisierten Modelle beinhaltet, die die frühere Firmware nicht unterstützt. 
Weitere Informationen finden Sie in der Xilica Designer-Hilfedatei oder im LD Systems ZoneX FAQ.
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FIRMWARE-UPGRADE
Bitte beachten Sie, dass der Einsatz einer älteren Software-Version mit einer neueren Firmware oder der Einsatz einer neueren Software mit einer 
älteren Firmware zwar grundsätzlich funktioniert, es kann jedoch sein, dass der Funktionsumfang eingeschränkt oder die Funktionalität nicht in 
allen Fällen optimal gewährleistet ist. 

Wir empfehlen, Software und Firmware immer auf die jeweils neueste Version zu aktualisieren.

Bevor Sie beginnen, überprüfen Sie bitte die Software- und Firmware-Versionen.

Um die aktuelle Geräte-Firmware-Version zu prüfen, vergewissern Sie sich zunächst, dass Ihr Gerät eingeschaltet und online ist. In der Netzwerk-An-
sicht werden Geräte, für die ein Firmware-Upgrade zur Verfügung steht, mit einem gelben Dreieck mit Ausrufezeichen gekennzeichnet. Außerdem 
ist die Geräte-Firmware-Version auch im Device-Block für das jeweilige Gerät aufgelistet.

Die aktuelle Software-Version wird angezeigt, wenn Sie About im Menü am oberen Fensterrand der Software anklicken.

FIRMWARE-UPGRADE DURCHFÜHREN
Speichern Sie alle Design-Dateien des Geräts in Ihrem Computer, da sämtliche Daten und Programmierungen im Gerät während des Upgrades 
gelöscht werden. Ist das Firmware-Upgrade beendet, kann die Design-Datei erneut in das Gerät geladen werden.

•	 Bei einem Firmware-Upgrade muss das Gerät online und betriebsbereit sein.

•	 Die neueste Firmware-Version für das entsprechende Zone X Modell steht auf der LD Systems-Website (www.ld-systems.com) zum Download bereit.
•	 Klicken Sie in der Netzwerk-Ansicht mit einem Rechtsklick auf den Device-Block, und wählen Sie „Firmware Upgrade“.
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Daraufhin erscheint eine Warnung, dass während des Firmware-Upgrades sämtliche Daten von Ihrem Gerät gelöscht werden. Bestätigen Sie mit 
„OK“, um fortzufahren.

Nun erscheint ein Dropdown-Menü, über das Sie die gewünschte Firmware-Datei aus einem Dateisystem oder eine zuvor über den „Device Firmware 
Manager“ (im „Device Management“-Menü) heruntergeladene Firmware-Version direkt auswählen können. Bestätigen Sie mit „Ok“, und navigieren 
Sie zu dem Ordner, in dem Sie die neue Firmware-Datei gespeichert haben. Wählen Sie die Datei aus und klicken Sie auf „Open“.
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Eine Statusleiste im Device-Fenster zeigt den Fortschritt des Firmware-Upgrades an.

SCHALTEN SIE DAS GERÄT NICHT AUS UND TRENNEN ES NICHT VOM RECHNER. Wird das Gerät während eines Firmware-Upgrades ausgeschaltet oder 
vom Rechner getrennt, kann es dazu führen, dass der Prozessor nicht mehr funktioniert. In diesem Fall ist eine Wiederherstellung der Firmware 
(„USB Firmware Recovery“) erforderlich.

Sobald die Firmware-Datei erfolgreich in das Gerät geladen wurde, startet dieses automatisch neu, und die internen Daten werden aktualisiert. Dies 
kann einige Minuten in Anspruch nehmen. In dieser Zeit wechselt die Netzwerkanzeige auf ROT, und das Gerät befindet sich im Offline-Modus.

Wenn das Firmware-Upgrade vollständig durchgeführt wurde, ist wieder das grüne „ON“ zu sehen. 

HINWEIS: Das gelbe Feld mit der Meldung „No Data“ bedeutet, dass noch kein Design in das Gerät geladen wurde.
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PROJECT VIEW
Ein neues Projekt kann auf zwei verschiedene Arten angelegt werden:

AUTO-KONFIGURATION
Wenn Ihr Gerät in der Netzwerk-Ansicht aufgeführt ist, wählen Sie es aus und klicken oben rechts auf Create New Project from Selected Device(s). 
So gelangen Sie automatisch in die Projekt-Ansicht und können eine Design-Vorlage auswählen.

LEERES PROJEKT

Die zweite Möglichkeit ist, über File > New Project ein neues Projekt zu erstellen.
Wenn Sie mit einem leeren Projekt beginnen, fragt Xilica Designer zunächst, welche DSP-Serie Sie nutzen. Da der ZoneX auf der Solaro-DSP-Serie 
basiert, wählen Sie Solaro Series.

1. „COMPONENT LIBRARY“-MENÜ
In diesem Menü finden Sie eine Liste von Geräten und Design-Modulen zur Verwendung in Ihrem Projekt. Lokalisieren Sie den ZoneX-Prozessor unter 
LD Systems > Processors.

2. ARBEITSBEREICH
Der Arbeitsbereich bietet Raum für das Anlegen und Konfigurieren von Geräten.

3. „OBJECT PROPERTY“-MENÜ
 In diesem Menü können Sie die Objekteigenschaften für das jeweilige Design anpassen.

1

2
3
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DESIGN
Zur Demonstration wird in diesem Fall nur ein DSP-Hardware-Block benötigt, ein Design kann jedoch auch mehrere DSP-Hardware-Objekte umfassen.
Projekt-Designs lassen sich offline (ohne angeschlossene Hardware) erstellen und können später in Ihre Geräte geladen werden.

1. Ziehen Sie das gewünschte DSP-Modul, in diesem Fall ZoneX1208, aus der „Component Library“ per Drag-and-Drop in den Arbeitsbereich.

2. Ein Auswahlfenster für die Design-Vorlage (Select Design Template) erscheint. Selektieren Sie eine der angebotenen Vorlagen, und Sie erhalten 
eine Kurzbeschreibung sowie eine Übersicht über die wichtigsten Features dieses Design-Templates. Wählen Sie eine geeignete Vorlage für Ihr 
Projekt aus, und bestätigen Sie mit Ok. 

Detaillierte Beschreibungen der verschiedenen Vorlagen finden Sie im FAQ zum LD Systems ZoneX.

3. Der ZoneX-Prozessor wird entsprechend konfiguriert.
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4. Selektieren Sie das ZoneX-Modul, um es zu markieren. Nun können im „Object Property“-Menü rechts die Geräteeigenschaften angepasst werden.
 Hinweis: Die Objekteigenschaften sind geräteabhängig und variieren je nach selektiertem Objekt. 

5. Öffnen Sie mit einem Doppelklick auf das ZoneX-Modul die schematische Design-Übersicht. In diesem Beispiel ist das „Global Dante“-Template 
ausgewählt. Die Fenstergröße können Sie ändern, indem Sie an den Ecken des Fensters ziehen.
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6. Alle DSP-Module können offline bearbeitet werden. Mit einem Doppelklick öffnen Sie das gewünschte Modul. Anschließend können Sie die 
Einstellungen für das DSP-Modul an die Anforderungen Ihres Projekts anpassen.

In diesem Beispiel wurden bei den Eingangseinstellungen die Phantomspeisung aktiviert sowie die Gain-Einstellungen für die ersten beiden Kanäle 
angepasst. Außerdem haben wir die ersten vier Kanäle im Audio Input-Modul umbenannt und zum Schluss Eingangskanal 1 bearbeitet.

7. Routen Sie nun mit einem Doppelklick auf das Main Matrix Mixer-Modul die Eingangssignale auf die entsprechenden Ausgänge.  
Auch diese können noch einmal mit einem Output Processing-Modul bearbeitet werden.

DEUTSCH
ENGLISH

FRANÇAIS
ESPAÑOL

POLSKI
ITALIANO



43

8. Wenn Sie Einstellungen offline verändert haben, speichern Sie zuletzt Ihr Projekt durch einen Klick auf File > Save As am gewünschten Ort. Haben 
Sie eine bestehende Projektdatei verändert, speichern Sie diese mit File > Save. Das Gleiche bewirkt ein Klick auf das Symbol für „Speichern“ 
rechts oben im Arbeitsbereich. 

Es ist empfehlenswert, Backups der Projektdateien extern zu speichern.
Die Dateiendung (Namenserweiterung) für gespeicherte Projektdateien lautet .pjxml.

ONLINE-BETRIEB
Wenn Sie in den Online-Betrieb wechseln, wird die Design-Datei in das/die angeschlossene/n Gerät/e geladen und Sie können Anpassungen in 
Echtzeit vornehmen.
In diesem Fall müssen alle Geräte angeschlossen und online sein (grüne „ON“-Anzeige in der Netzwerk-Ansicht).

Um in den Online-Modus zu wechseln, muss das Geräte-Modul der physischen Hardware zugeordnet werden.

1. Selektieren Sie in der Projekt-Ansicht das Geräte-Modul, das Sie zuordnen möchten.
2. Klicken Sie das Geräte-Modul mit einem Rechtsklick an, und wählen Sie Map to Physical Device.
3. Nun werden die erkannten Geräte mit ihrer Mac-Adresse aufgelistet. Sollten im Netzwerk mehrere identische Geräte eingebunden sein, können 

sie anhand ihrer Mac-Adressen identifiziert werden. Die Mac-Adressen für die einzelnen Geräte finden Sie in der Netzwerk-Ansicht.

Es ist sehr wichtig, dass der Name des Device-Blocks in der Design-Datei exakt der Einheit in der Netzwerk-Ansicht entspricht, sonst kann das 
Design nicht in die entsprechende Hardware geladen werden.

DE
UT

SC
H

EN
GL

ISH
FR

AN
ÇA

IS
ES

PA
ÑO

L
PO

LS
KI

ITA
LIA

NO



44

Ist alles zugeordnet, wechselt die Farbe des Moduls zu einem durchgehenden Grau, und die Mac-Adresse des Geräts wird unten im Geräte-Modul 
angezeigt.

4. Klicken Sie nun auf Load Design to Device(s), oben im Arbeitsbereich.
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5. Es erscheint ein Fenster, in dem Sie die Geräte, in die Sie Ihr Design laden möchten, mit einem Haken versehen können. 
Bestätigen Sie mit Ok.

Der Wechsel in den Online-Betrieb kann einige Minuten in Anspruch nehmen. Bitte unterbrechen Sie den Vorgang nicht! Der Prozessfortschritt wird 
anhand eines Balkens oben im Fenster in Prozent angezeigt.
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Sobald der Arbeitsbereich in einem durchgehenden Grau erscheint, befinden Sie sich im Online-Betrieb, und die Design-Menüs sind nicht mehr 
verfügbar.

6. Wenn Sie Einstellungen in Echtzeit verändern möchten, können Sie entweder das DSP-Modul in der Projekt-Ansicht oder den Device-Block in der 
Netzwerk-Ansicht mit einem Doppelklick anklicken und sehen dann die schematische Darstellung für das jeweilige Gerät.

DEUTSCH
ENGLISH

FRANÇAIS
ESPAÑOL

POLSKI
ITALIANO



47

7. Klicken Sie das gewünschte DSP-Modul oder einen I/O-Block mit einem Doppelklick an, um Einstellungen in Echtzeit zu verändern.

Über die Schaltfläche Go Back to Design Mode oben im Arbeitsbereich können Sie jederzeit wieder in den Design-Modus wechseln.
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Sie werden gefragt, ob Sie die online vorgenommenen Änderungen in das Projekt-Design übertragen möchten.

Bestätigen Sie mit Yes, um die Online-Einstellungen in das Projekt zu übertragen.
Mit einem Klick auf No kehren Sie zur vorherigen Design-Datei zurück.

Nach der Übertragung von Online-Einstellungen in ein Projekt wird mit dem Befehl File > Save die ursprüngliche Projektdatei überschrieben.  
Wählen Sie File > Save As, wird eine neue Projektdatei erzeugt und gespeichert.

Es ist empfehlenswert, ein Backup der Projektdatei(en) extern zu speichern.
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GPI/O – ANSCHLUSSBEISPIELE
8 LOGIK-EINGÄNGE (BINÄREINGÄNGE, GPI)

Aktivierung über Masseschluss (G)

8 LOGIK-AUSGÄNGE (BINÄRAUSGÄNGE, GPO)

2 Ausgangsmodi stehen zur Verfügung:
•	 LED (3 mA)
•	 Sink to Ground (300 mA) 

Anschlussbeispiel: 

•	 Jeder GPI bietet zwei Schaltzustände (via Software) 
•	 So können zwei verschiedene Presets angesteuert werden  
 Öffnen und Schließen der Kontakte
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TECHNISCHE DATEN
Artikelnummer LDZONEX1208 / D

Produkttyp DSP-Audio-Matrix für die Festinstallation

Allgemeine Daten

Audio-Eingänge 12 symmetrische Mic/Line-Eingänge + 1 Remote-Bus-Audio-Eingang

Audio-Ausgänge 8 symmetrische Line-Ausgänge

Logik-Eingänge 8 GPI – Aktivierung über Masseschluss

Logik-Ausgänge 8 GPO – Modi: LED (3 mA) oder Sink (300 mA), pro Ausgang wählbar

Remote-Bus Ja

Anschlüsse Eingänge/Ausgänge: 3-Pol-Klemmblock, Abstand 3,81 mm;  
Service-Anschluss Micro USB Typ-B, Remote IN RJ45, Ethernet RJ45 
ZoneX1208D: Dante Primary und Secondary RJ45

Anzeigeelemente Vorderseite: „POWER“, „NETWORK“, „REMOTE“, Eingänge 1 – 12 und Ausgänge 1 – 8: Signal-LED Weiß, Clip-LED Rot

Bedienelemente Vorderseite Nein

Bedienelemente Rückseite Netz AN/AUS, „IP RESET“

Erweiterungssteckplatz für Ethernet- (ZONEX1208) oder Ethernet + Dante- (ZONEX1208D) Karten

Kühlung Passiv, Konvektionskühlung

Stromversorgung Weitbereichs-Schaltnetzteil

Netzanschluss 3-Pol-Kaltgerätebuchse (IEC)

Betriebsspannung 90 – 240 V AC; 50/60 Hz

Eingangssicherung (Netz) T2,5 A L / 250 V 

Einschaltstrom Netz AUS-AN 21 A  

Leistungsaufnahme,  
Ruhezustand

23 W

Max. Leistungsaufnahme 60 W

Betriebstemperatur 0 °C ... +40 °C (max. 60% relative Luftfeuchte)

Breite 19“-Rack (483 mm)

Höhe 1 HE (44,5 mm)

Tiefe 315 mm (mit Klemmblöcken)

Gewicht 3,8 kg

Rack-Abstand zum nächsten 
Gerät (Höhe)

1 HE

Rack-Tiefe (erforderlich) 350 mm

Performance-Spezifikationen

Eingangsempfindlichkeit, 
nominal

-22 dBu (Sinussignal, 1 kHz, Gain Max.)

Eingangsübersteuerung, 
nominal

+20 dBu (Sinussignal, 1 kHz)

Klirrfaktor (THD+N) <0,003% (Line IN – OUT, +13 dBu Signal, 20 Hz – 20 kHz, Gain 0 dB)

Intermodulationsverzerrungen 
(IMD), SMPTE

<0,01% (-10 dB unter Clip), Analyzer-Bandbreite 90 kHz

Frequenzgang 15 Hz – 22 kHz (+/-0,15 dB)

Eingangsimpedanz Line: 4 kOhm (symmetrisch)
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Artikelnummer LDZONEX1208 / D

Geräuschspannungsabstand >117 dB @ +20 dBu, Gain 0 dB, 20 kHz Bandbreite, A-bewertet 

Dynamikumfang (AES17) 112 dB

Kanalübersprechen 120 dB @ 100 Hz, 120 dB @ 1 kHz, 105 dB @ 10 kHz

Gleichtaktunterdrückung, 
CMRR IEC

>60 dB (1 kHz)

Max. Gain 42 dB

Digitale Spezifikationen

DSP 40-Bit-Gleitkommaverarbeitung, Analog Devices Dual-Core SHARC+-Prozessor

Systemlatenz 4,3 ms

Auflösung AD/DA-Wandler 32 Bit 

Abtastrate AD/DA-Wandler 48 kHz

Remote-Bus-Spezifikationen, gemessen zwischen REM In und REM Out

Eingangsempfindlichkeit, 
nominal

20 dBu

Eingangsübersteuerung, 
nominal

20 dBu

Klirrfaktor (THD+N) <0,006% (+18 dBu, 20 Hz – 20 kHz)

Frequenzgang 20 Hz – 20 kHz (0,1 dB)

Eingangsimpedanz  50 kOhm (symmetrisch)

Geräuschspannungsabstand >105 dB (+20 dBu, 20 kHz Bandbreite, A-bewertet) 

Gleichtaktunterdrückung, 
CMRR IEC

>65 dB @ 1 kHz

Gain 0 dB

Phantomspeisung +48 V DC / 500 mA

Sicherung Rückstellbare Sicherung (intern)
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HERSTELLERERKLÄRUNGEN
HERSTELLERGARANTIE & HAFTUNGSBESCHRÄNKUNG 
Unsere aktuellen Garantiebedingungen und Haftungsbeschränkung finden Sie unter: https://cdn-shop.adamhall.com/media/pdf/MANUFACTURERS- 
DECLARATIONS_LD_SYSTEMS.pdf. Im Service Fall wenden Sie sich bitte an Adam Hall GmbH, Adam-Hall-Str. 1, 
61267 Neu Anspach / E-Mail Info@adamhall.com / +49 (0)6081 / 9419-0.

KORREKTE ENTSORGUNG DIESES PRODUKTS
(Gültig in der Europäischen Union und anderen europäischen Ländern mit Mülltrennung) Dieses Symbol auf dem Produkt oder dazugehörigen  
Dokumenten weist darauf hin, dass das Gerät am Ende der Produktlebenszeit nicht zusammen mit dem normalen Hausmüll entsorgt werden 

darf, um Umwelt- oder Personenschäden durch unkontrollierte Abfallentsorgung zu vermeiden. Bitte entsorgen Sie dieses Produkt getrennt von 
anderen Abfällen und führen es zur Förderung nachhaltiger Wirtschaftskreisläufe dem Recycling zu. Als Privatkunde erhalten Sie Informationen zu 
umweltfreundlichen Entsorgungsmöglichkeiten über den Händler, bei dem das Produkt erworben wurde, oder über die entsprechenden regionalen 
Behörden. Als gewerblicher Nutzer kontaktieren Sie bitte Ihren Lieferanten und prüfen die ggf. vertraglich vereinbarten Konditionen zur Entsorgung 
der Geräte. Dieses Produkt darf nicht zusammen mit anderen gewerblichen Abfällen entsorgt werden.

CE-KONFORMITÄT
Hiermit erklärt die Adam Hall GmbH, dass dieses Produkt folgenden Richtlinien entspricht (soweit zutreffend):
R&TTE (1999/5/EG) bzw. RED (2014/53/EU) ab Juni 2017
Niederspannungsrichtlinie (2014/35/EU)
EMV-Richtlinie (2014/30/EU)
RoHS (2011/65/EU)
Die vollständige Konformitätserklärung finden Sie unter www.adamhall.com. 
Des Weiteren können Sie diese auch unter info@adamhall.com anfragen.

EG-KONFORMITÄTSERKLÄRUNG
Hiermit erklärt die Adam Hall GmbH, dass dieser Funkanlagentyp der Richtlinie 2014/53/EU entspricht. 
Der vollständige Text der EU-Konformitätserklärung ist unter der folgenden 
Internetadresse verfügbar: www.adamhall.com/compliance/

Druckfehler und Irrtümer, sowie technische oder sonstige Änderungen sind vorbehalten!
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FRANÇAIS

VOUS AVEZ FAIT LE BON CHOIX !
LD Systems a conçu ce produit de sorte qu’il reste fiable au fil des années. Fabricant de renom et fort d’une longue expérience dans la conception 
de produits audio de qualité, LD Systems vise la robustesse. Lisez attentivement le présent manuel afin de tirer rapidement le meilleur parti de 
votre produit LD Systems.
Pour plus d’informations concernant LD SYSTEMS, rendez-vous sur WWW.LD-SYSTEMS.COM.

INFORMATIONS DE SÉCURITÉ
1.	 Lisez attentivement ces instructions. 
2.	 Conservez toutes ces informations et instructions dans un endroit sûr. 
3.	 Suivez ces instructions. 
4.	 Observez tous les avertissements de sécurité. Ne retirez ni les avertissements ni toute autre information figurant sur l’équipement. 
5.	 N’utilisez l’équipement que de la manière et qu’aux fins pour lesquelles il a été conçu. 
6.	 Dans le cas d’installations fixes, utilisez uniquement des supports ou fixations suffisamment stables et compatibles. Veillez à ce que les fixations 

murales soient correctement installées et fixées. Assurez-vous que l’équipement est bien fixé et qu’il ne peut pas tomber. 
7.	 Pendant l’installation, respectez les règlementations en matière de sécurité en vigueur dans votre pays. 
8.	 N’installez ni n’utilisez l’équipement près de radiateurs, de grilles de chauffage, de fours ou de toute autre source de chaleur. Assurez-vous 

d’installer l’équipement de sorte qu’il soit suffisamment refroidi et qu’il ne puisse pas surchauffer. 
9.	 Ne placez jamais d’objets enflammés, tels que des bougies, sur l’équipement. 
10.	 Les fentes d’aération ne doivent pas être bloquées.
11.	 N’utilisez pas cet équipement à proximité de sources d’eau (sauf si l’équipement est spécialement conçu pour une utilisation en extérieur, 

auquel cas, suivez les instructions spéciales ci-dessous). N’exposez pas cet équipement à des matériaux, fluides ou gaz inflammables. Évitez 
également de l’exposer directement à la lumière du soleil.

12.	 Assurez-vous qu’aucune goutte d’eau ou éclaboussure ne peut s’infiltrer dans l’équipement. Ne placez aucun contenant rempli de liquide, tel 
que des vases ou des verres, sur l’équipement. 

13.	 Assurez-vous que rien ne peut tomber sur l’équipement. 
14.	 N’utilisez cet équipement qu’avec les accessoires recommandés et prévus par le fabricant. 
15.	 N’ouvrez ni ne modifiez l’équipement. 
16.	 Après avoir connecté l’équipement, vérifiez tous les câbles afin d’éviter tout accident ou dégât pouvant, par exemple, découler d’un 

trébuchement. 
17.	 Durant le transport de l’équipement, assurez-vous qu’il ne peut pas tomber de sorte qu’il n’entraîne aucun dommage matériel ni aucune 

blessure corporelle.
18.	 Si l’équipement ne fonctionne plus correctement, que des fluides ou tout autre objet s’y sont infiltrés ou qu’il est endommagé de quelque autre 

façon que ce soit, arrêtez-le immédiatement et débranchez-le de la prise secteur (s’il s’agit d’un appareil électrique). Seul un professionnel 
agréé et qualifié est autorisé à réparer l’équipement. 

19.	 Nettoyez l’équipement à l’aide d’un tissu sec. 
20.	Respectez toute loi relative à l’élimination des déchets en vigueur dans votre pays. Veillez à trier le contenu de l’emballage en séparant le 

plastique du papier et du carton. 
21.	 Les sacs plastiques doivent être tenus hors de portée des enfants.
22.	Veuillez noter que toute modification apportée à l’équipement non autorisée par la partie responsable de la conformité peut entraîner 

l’annulation du droit d’utilisation de l’équipement dont jouit l’utilisateur.

INSTRUCTIONS RELATIVES AUX ÉQUIPEMENTS RACCORDÉS AU SECTEUR
23.	ATTENTION : si la fiche d’alimentation de l’appareil est dotée d’un contact de terre, elle doit être raccordée à une prise mise à la terre. N’enlevez 

pas le dispositif de mise à la terre de la fiche. 
24.	Si l’équipement a subi de fortes variations de température (par exemple, après son transport), ne l’allumez pas immédiatement. L’humidité et la 

condensation peuvent endommager l’équipement. N’allumez pas l’équipement tant qu’il n’est pas à température ambiante. 
25.	Avant de raccorder l’équipement à la prise de courant, vérifiez d’abord que la tension et la fréquence du secteur correspondent aux valeurs 

indiquées sur celui-ci. Si l’équipement est doté d’un sélecteur de tension, raccordez-le à la prise de courant uniquement si les valeurs qui y sont 
indiquées correspondent aux valeurs d’alimentation du secteur. Si la fiche ou l’adaptateur d’alimentation n’est pas adapté à la prise, contactez 
un électricien. 

26.	Ne marchez pas sur le câble d’alimentation. Assurez-vous que le câble d’alimentation ne s’entortille pas, notamment au niveau de la prise de 
courant ou de l’adaptateur d’alimentation et du connecteur de l’équipement. 

27.	 Lors du raccordement de l’équipement, veillez à ce qu’il soit toujours possible d’accéder au câble ou à l’adaptateur d’alimentation. Mettez 
toujours l’équipement hors tension si vous ne l’utilisez pas ou que vous voulez le nettoyer. Débranchez le câble d’alimentation de la prise 
secteur en le saisissant par la fiche ou l’adaptateur. Ne tirez jamais sur le câble lui-même. Ne touchez jamais le câble ou l’adaptateur 
d’alimentation si vous avez les mains mouillées. 

28.	Lorsque cela est possible, évitez d’éteindre et de rallumer l’équipement plusieurs fois à la suite, car cela peut réduire sa durée de vie.
29.	IMPORTANT : remplacez les fusibles uniquement par d’autres de même type et présentant les mêmes caractéristiques. Si les fusibles sautent 

constamment, contactez un centre de réparation agréé. 
30.	Pour mettre l’équipement complètement hors tension, débranchez le câble ou l’adaptateur d’alimentation de la prise. 
31.	 Si l’équipement est doté d’un connecteur Volex, celui-ci doit être déverrouillé avant d’être retiré. Toutefois, cela signifie également que 

l’équipement peut glisser et tomber si le câble d’alimentation est tiré, entraînant ainsi des blessures corporelles ou tout autre dégât. Faites 
donc attention lorsque vous posez les câbles. 

32.	Débranchez le câble ou l’adaptateur d’alimentation de la prise en cas de risque d’orage ou si vous prévoyez de ne pas utiliser l’équipement sur 
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CARACTÉRISTIQUES
•	 Processeur DSP à architecture hybride 
•	 Modèles DSP disponibles pour différentes installations
•	 Moteur DSP à virgule flottante de 40 bits doté d’un processeur SHARC+ à deux cœurs Analog Devices et d’un processeur ARM Cortex A5
•	 Système d’exploitation Linux de nouvelle génération
•	 Préamplificateur de microphone dernier cri et convertisseurs AN/NA performants de 32 bits
•	 12 entrées de microphone/ligne symétriques, chacune dotée d’un sélecteur d’alimentation fantôme de 48 V
•	 8 sorties symétriques
•	 8 ports logiques GPI et 8 ports logiques GPO
•	 Connecteurs de bornier à six pôles (écartement de 3,81 mm) pour toutes les entrées et sorties audio et de commande
•	 Bus de commande à distance (REMOTE) pour l’intégration aux panneaux de commande muraux et aux pupitres LD Systems
•	 Face avant épurée et intuitive
•	 Interface Ethernet de commande à distance fonctionnant à l’aide du logiciel de commande universel Xilica Designer
•	 Applications de commande à distance disponibles sur iOS et Android pour des interfaces utilisateurs personnalisées
•	 Planificateur d’évènements intégré
•	 Extension Dante 64 x 64 en option (audio sur IP)
•	 Appareil pouvant être rangé dans une baie de 19” (1 RU)

CONTENU DE L’EMBALLAGE
•	 Matériel LD ZoneX
•	 Câble d’alimentation
•	 Manuel d’utilisation

CONNEXIONS, DISPOSITIFS DE COMMANDE ET D’AFFICHAGE
FACE AVANT 

1  LED D’ÉTAT GÉNÉRAL
POWER = l’appareil est allumé
NETWORK = connexion au réseau établie
REMOTE = appareils LD Systems connectés à distance  
		  (pupitres, panneaux de commande, etc.)

2  LED D’ENTRÉE ET DE SORTIE
Blanc = signal détecté
Rouge = signal fort

2 1 2

une longue période.
33.	 L’équipement n’est pas destiné à être utilisé par toute personne (y compris des enfants) présentant des capacités physiques, sensorielles  

ou mentales réduites, ou manquant de l’expérience et des connaissances nécessaires à son utilisation.
34.	Veillez à ce qu’aucun enfant ne joue avec l’équipement.
35.	N’utilisez pas l’équipement si son câble d’alimentation est endommagé. Le câble d’alimentation doit être remplacé par un câble ou un 

assemblage adapté et l’opération doit être effectuée par un centre de réparation agréé.

ATTENTION :
Afin de réduire le risque d’électrocution, ne retirez pas le boîtier (ou la partie arrière) de l’équipement. 
Vous ne devez réparer aucune pièce de ce dernier. Toute opération d’entretien et de réparation doit 
être exclusivement effectuée par un professionnel qualifié.

Le triangle d’avertissement comprenant un symbole d’éclair indique la présence de composants alimentés et non isolés dangereux 
à l’intérieur de l’unité pouvant causer une électrocution.

Le triangle d’avertissement comprenant un point d’exclamation indique des instructions d’utilisation et d’entretien importantes.

Avertissement : ce symbole indique la présence d’une surface chaude. Certaines parties du boîtier de l’équipement peuvent devenir 
chaudes durant l’utilisation de ce dernier. Après avoir utilisé l’équipement, laissez-le se refroidir pendant au moins 10 minutes avant 
de le manipuler ou de le transporter.

Avertissement : cet appareil est conçu pour fonctionner à une altitude inférieure à 2 000 mètres.

Avertissement : ce produit n’est pas conçu pour être utilisé dans des climats tropicaux.

ATTENTION : VOLUME SONORE ÉLEVÉ
Cet appareil est conçu pour un usage professionnel. Par conséquent, son utilisation commerciale est soumise aux règlementations nationales en 
vigueur relatives à la prévention des accidents. En tant que fabricant, la société Adam Hall est tenue de vous informer officiellement de l’existence 
d’éventuels risques sanitaires. Lésions auditives découlant d’une exposition prolongée à un volume sonore élevé : lors de son utilisation, ce produit 
peut produire un niveau de pression acoustique élevé pouvant entraîner des lésions auditives irréversibles chez les artistes, employés et le public 
qui y sont soumis. Évitez donc toute exposition prolongée à un volume sonore supérieur à 90 dB.

REMARQUE : cet équipement a fait l’objet de tests à la suite desquels il a été déclaré conforme aux limites s’appliquant aux appareils numériques 
de Classe B, conformément à la partie 15 des règlementations de la Commission fédérale des communications (FCC). Ces limites visent à 
protéger les utilisateurs de toute interférence dangereuse dans une installation résidentielle. Cet équipement génère, utilise et peut émettre de 
l’énergie sous forme de radiofréquence. De plus, s’il n’est pas installé et utilisé conformément aux instructions, cet équipement peut provoquer 
des interférences affectant les communications radio. Cependant, il n’est pas garanti qu’aucune interférence ne puisse se produire dans une 
installation donnée. Si l’équipement produit des interférences avec des signaux radio ou de télévision, ce qui peut être déterminé en l’éteignant 
puis en l’allumant, il est recommandé de les corriger en suivant au moins l’une des instructions suivantes :
– réorienter ou déplacer l’antenne de réception,
– séparer davantage l’équipement et le récepteur,
– raccorder l’équipement à une prise ne faisant pas partie du circuit auquel le récepteur est raccordé,
– faire appel au distributeur ou à un technicien spécialisé en radiodiffusion.
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CARACTÉRISTIQUES
•	 Processeur DSP à architecture hybride 
•	 Modèles DSP disponibles pour différentes installations
•	 Moteur DSP à virgule flottante de 40 bits doté d’un processeur SHARC+ à deux cœurs Analog Devices et d’un processeur ARM Cortex A5
•	 Système d’exploitation Linux de nouvelle génération
•	 Préamplificateur de microphone dernier cri et convertisseurs AN/NA performants de 32 bits
•	 12 entrées de microphone/ligne symétriques, chacune dotée d’un sélecteur d’alimentation fantôme de 48 V
•	 8 sorties symétriques
•	 8 ports logiques GPI et 8 ports logiques GPO
•	 Connecteurs de bornier à six pôles (écartement de 3,81 mm) pour toutes les entrées et sorties audio et de commande
•	 Bus de commande à distance (REMOTE) pour l’intégration aux panneaux de commande muraux et aux pupitres LD Systems
•	 Face avant épurée et intuitive
•	 Interface Ethernet de commande à distance fonctionnant à l’aide du logiciel de commande universel Xilica Designer
•	 Applications de commande à distance disponibles sur iOS et Android pour des interfaces utilisateurs personnalisées
•	 Planificateur d’évènements intégré
•	 Extension Dante 64 x 64 en option (audio sur IP)
•	 Appareil pouvant être rangé dans une baie de 19” (1 RU)

CONTENU DE L’EMBALLAGE
•	 Matériel LD ZoneX
•	 Câble d’alimentation
•	 Manuel d’utilisation

CONNEXIONS, DISPOSITIFS DE COMMANDE ET D’AFFICHAGE
FACE AVANT 

1  LED D’ÉTAT GÉNÉRAL
POWER = l’appareil est allumé
NETWORK = connexion au réseau établie
REMOTE = appareils LD Systems connectés à distance  
		  (pupitres, panneaux de commande, etc.)

2  LED D’ENTRÉE ET DE SORTIE
Blanc = signal détecté
Rouge = signal fort

2 1 2
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FACE ARRIÈRE

3  CONNECTEUR D’ALIMENTATION ET COMPARTIMENT DU FUSIBLE
Connecteur d’alimentation CEI et doté d’un compartiment de fusible. L’emballage contient également un câble d’alimentation adapté.
ATTENTION : remplacez le fusible uniquement par un autre de même type et présentant les mêmes caractéristiques. Reportez-vous aux informations 
inscrites sur le boîtier. Si le fusible saute constamment, contactez un centre de réparation agréé. 

4  BOUTON MARCHE/ARRÊT
Interrupteur à bascule permettant d’allumer et d’éteindre l’appareil.

5  ETHERNET - USB - RESET
Extension de communication entre le processeur ZoneX et l’ordinateur hôte dotée d’un connecteur Ethernet (ou d’un module Ethernet + Dante 
64 x 64 I/O disponible sur le modèle « D »), d’un port Micro-USB de récupération du micrologiciel, ainsi que d’un bouton de réinitialisation de 
l’adresse IP.

6  PORT DE COMMANDE À DISTANCE
Bus de commande à distance LD Systems (REMOTE) pour l’intégration de panneaux de commande muraux et de pupitres LD Systems. Veuillez noter 
que ce connecteur ne prend en charge que les appareils compatibles avec le bus de commande à distance LD Systems. Il ne prend pas en charge les 
ports de commutateur Ethernet.

7  GPO
8 sorties GPO (ports logiques) chacune dotée de deux modes : LED (3 mA) ou puits (300 mA). Borniers à trois pôles (écartement de 3,81 mm). Veuillez 
également prendre connaissance des exemples de connexion décrits dans le présent manuel (voir EXEMPLES DE CONNEXION DES PORTS GPIO)

8  GPI
8 entrées GPI (ports logiques) chacune dotée d’un système de mise directe à la terre. Borniers à trois pôles (écartement de 3,81 mm). Veuillez 
également prendre connaissance des exemples de connexion décrits dans le présent manuel (voir EXEMPLES DE CONNEXION DES PORTS GPIO)

9  SORTIES
8 sorties audio symétriques. Borniers à trois pôles (écartement de 3,81 mm).

10  ENTRÉES
12 entrées audio de microphone/ligne symétriques, chacune dotée d’un sélecteur d’alimentation fantôme de 48 V. Borniers à trois pôles 
(écartement de 3,81 mm).

CONNEXION DES APPAREILS
Le processeur DSP ZoneX LD Systems et les autres unités de commande fonctionnent dans une infrastructure en réseau et sont configurés à l’aide 
d’un ordinateur exécutant le logiciel Xilica Designer.

PRÉREQUIS POUR L’UTILISATION DE L’ÉQUIPEMENT
•	 Un ordinateur.
•	 Une interface réseau (routeur ou commutateur PoE). 

Un routeur est nécessaire pour l’attribution de l’adresse IP et pour connecter l’équipement rapidement et facilement à l’ordinateur et aux unités 
de commande. Un commutateur PoE est requis pour alimenter les unités de commande sans source d’alimentation locale.

•	 Un câble Ethernet. Toutes les connexions câblées se font à l’aide d’un câble Ethernet RJ45 standard (Cat 5e ou catégorie supérieure).

4

6

3

7 8 9 10

5

Don‘t connect to any 
ethernet switch port!

This port is only for LD 
Systems remote bus 
compatible devices.
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IL EST POSSIBLE DE CONNECTER PAR RÉSEAU L’ORDINATEUR HÔTE AU PROCESSEUR ZONEX COMME SUIT :

A. ROUTEUR DOTÉ D’UN SERVEUR DHCP (RECOMMANDÉ)
Si vous utilisez un routeur doté d’un serveur DHCP, le processeur ZoneX récupère automatiquement une adresse IP lors du démarrage et dès que 
la connexion est établie. Il est recommandé d’utiliser un routeur et un commutateur PoE si des unités de commande d’autres fabricants sont 
connectées au réseau. Cette configuration permet d’utiliser un serveur DHCP et d’alimenter également les appareils connectés. Il est recommandé 
d’utiliser des routeurs Linksys et des commutateurs Netgear.

Remarque : les routeurs/commutateurs dotés d’un serveur DHCP doivent normalement être allumés en premier. De plus, tous les câbles Ethernet 
doivent être raccordés au matériel avant d’allumer ce dernier. Cela permet d’attribuer correctement l’adresse IP.

•	 Tout d’abord, allumez le router/commutateur.
•	 Connectez ensuite l’ordinateur hôte au routeur doté d’un serveur DHCP à l’aide d’un câble Ethernet.
•	 Connectez le routeur au processeur ZoneX à l’aide d’un câble Ethernet.
•	 Raccordez le processeur ZoneX au secteur et allumez-le.

B. CONNEXION DIRECTE SANS SERVEUR DHCP OU CONNEXION INDIRECTE À L’AIDE D’UN COMMUTATEUR ETHERNET
Si le processeur est connecté directement à un ordinateur ou indirectement à l’aide d’un commutateur sans passer par un serveur DHCP, la 
connexion ne peut pas être établie automatiquement.
Dans ce genre d’installations, toute connexion doit donc être configurée manuellement. Pour plus d’informations, consultez le fichier d’aide du 
logiciel Xilica Designer ou la FAQ concernant le processeur ZoneX LD Systems.
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LOGICIEL XILICA DESIGNER
Le logiciel Xilica Designer permet non seulement de configurer avec précision le processeur ZoneX, mais aussi de configurer les unités de 
commande tierces, de gérer en toute facilité les appareils réseau Dante en option et constitue un outil d’intégration universel des commandes 
d’appareils tiers.

INSTALLATION SUR MAC OS X
Configuration requise :
•	 MAC OS X 10.8 ou version ultérieure
•	 Processeur de 1 GHz ou plus
•	 500 Mo d’espace de stockage libre
•	 Carte graphique de 1 Go
•	 4 Go de RAM

1. Téléchargez la dernière version du logiciel Xilica Designer sur votre ordinateur depuis le site Internet de LD Systems (www.ld-systems.com).
2. Ouvrez le fichier .zip téléchargé.
3. Ouvrez ensuite le fichier XilicaDesigner.mpkg.
4. Une fenêtre d’installation s’affiche. Suivez les instructions.

5. Si l’installation a réussi, la fenêtre affiche le message suivant : « The installation was successful ».

7. Le logiciel Xilica Designer est maintenant installé.
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INSTALLATION SUR WINDOWS
Configuration requise :
•	 Windows 7 ou version ultérieure
•	 Processeur de 1 GHz ou plus
•	 500 Mo d’espace de stockage libre
•	 Carte graphique de 1 Go
•	 4 Go de RAM

1. Téléchargez la dernière version du logiciel Xilica Designer sur votre ordinateur depuis le site Internet de LD Systems (www.ld-systems.com).
2. Ouvrez le fichier .zip téléchargé.
3. Ouvrez ensuite le fichier XilicaDesigner.exe.
4. Une fenêtre d’installation s’affiche. Cliquez sur Install (Installer) pour continuer.

5. Veuillez attendre la fin du processus d’installation. Cette opération peut prendre quelques minutes.
6. Si l’installation a réussi, Windows vous demande la permission de donner accès au pare-feu. Il est recommandé de configurer le système de sorte 

que les communications soient autorisées pour Xilica Designer sur les réseaux privés, tels que les réseaux domestiques ou professionnels. Les 
réseaux publics peuvent être inclus si nécessaire. 

Sélectionnez les options désirées à l’aide du Panneau de configuration, puis cliquez sur Allow Access (Autoriser l’accès) pour terminer la 
configuration.

7. Le logiciel Xilica Designer est maintenant installé.
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DÉMARRAGE DU LOGICIEL
Vous pourrez trouver le logiciel Xilica Designer sur votre bureau ou dans le dossier de l’application. Double-cliquez dessus pour le démarrer.
Vous pouvez ainsi créer ou ouvrir un projet de conception ou bien démarrer la vue réseau ou Dante.

VUE RÉSEAU
La vue réseau affiche tous les processeurs et toutes les unités de commande disponibles sur le réseau. Vous pouvez y trouver les informations des 
appareils, telles que l’état de connexion, l’adresse IP de l’ordinateur et des appareils, l’adresse MAC ainsi que le nom, le fabricant et la version de 
micrologiciel des appareils.

Les processeurs connectés sont normalement visibles sur la vue réseau. Un indicateur de l’état de connexion se trouve dans le coin supérieur 
gauche de chaque bloc d’appareil.

Vert : l’appareil est connecté et prêt à l’emploi.

Jaune : l’appareil est connecté et en ligne, mais n’est pas prêt à l’emploi. Placez le curseur sur l’indicateur d’état de connexion afin d’afficher la 
fenêtre contextuelle contenant les informations concernant le message détecté (le message indique généralement qu’aucune conception n’est 
chargée pour l’appareil).

Rouge :  l’appareil n’est pas connecté et est hors ligne. Le logiciel Xilica Designer et l’appareil ne communiquent pas. Vérifiez tous les câbles et 
toutes les connexions et assurez-vous que l’appareil est allumé. Si le processeur met à niveau son micrologiciel ou qu’il redémarre, il est possible 
que la connexion soit temporairement interrompue. 

Un point d’exclamation (!) peut parfois s’afficher, signifiant qu’une mise à niveau du micrologiciel est disponible. Cela ne requiert normalement 
pas d’intervention immédiate, mais le fichier de projet ne contiendra aucun modèle mis à jour étant donné que le dernier micrologiciel 
installé ne sera pas pris en charge. Pour plus d’informations, consultez le fichier d’aide du logiciel Xilica Designer ou la FAQ concernant le 
processeur ZoneX LD Systems.
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MISE À NIVEAU DU MICROLOGICIEL
Veuillez noter que l’utilisation d’une ancienne version du logiciel avec le dernier micrologiciel, ou de la dernière version du logiciel avec une 
ancienne version du micrologiciel est en théorie possible. Toutefois, la gamme de fonctionnalités peut être limitée ou celles-ci peuvent ne pas être 
optimales dans tous les cas. 

Il est recommandé de toujours utiliser les dernières versions du logiciel et du micrologiciel.

Avant de commencer, vérifiez la version du logiciel et du micrologiciel.

Pour vérifier la version du micrologiciel de l’appareil, assurez-vous qu’il est allumé et en ligne. Dans la vue réseau, un triangle jaune contenant un 
point d’exclamation indique les appareils pour lesquels une mise à niveau du micrologiciel est disponible. De plus, la version du micrologiciel de 
l’appareil s’affiche dans le bloc correspondant.

Il est possible de connaître la version actuelle du logiciel en cliquant sur About (À propos) situé dans la barre supérieure de menu.

PROCÉDURE DE MISE À NIVEAU DU MICROLOGICIEL
Enregistrez le fichier de conception de l’appareil sur votre ordinateur, car toutes les données programmées seront supprimées de l’appareil 
durant la mise à niveau. Une fois la mise à niveau terminée, le fichier de conception peut être rechargé sur l’appareil.

•	 Pour effectuer la mise à niveau du micrologiciel, l’appareil doit être en ligne et prêt à l’emploi.

•	 La dernière version du micrologiciel correspondant au modèle du processeur ZoneX peut être téléchargée depuis le site Internet de LD Systems 
(www.ld-systems.com).

•	 Dans la vue réseau, cliquez à l’aide du bouton droit de la souris sur le bloc d’un appareil, puis sélectionnez Firmware Upgrade (Mise à niveau du 
micrologiciel).
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Un avertissement s’affiche ensuite, indiquant que toutes les données de l’appareil seront supprimées. Cliquez sur OK pour continuer.

Un menu déroulant s’affiche. Vous pouvez y sélectionner le fichier de micrologiciel désiré depuis un système de fichiers ou bien une version 
téléchargée à l’aide du gestionnaire du micrologiciel de l’appareil (Device Firmware Manager) situé dans le menu Device Management (Gestion de 
l’appareil). Cliquez sur OK pour confirmer, puis naviguez jusqu’au dossier où vous avez enregistré le nouveau fichier de micrologiciel. Sélectionnez le 
fichier, puis cliquez sur Open (Ouvrir).
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Une barre d’état indiquant la progression de la mise à niveau s’affiche dans la fenêtre de l’appareil.

N’ÉTEIGNEZ PAS L’APPAREIL ET NE LE DÉCONNECTEZ PAS DE L’ORDINATEUR. En effet, si vous éteignez l’appareil ou que vous le déconnectez de 
l’ordinateur pendant la mise à niveau du micrologiciel, cela peut entraîner la corruption de l’intégralité du processeur. Auquel cas, vous devrez 
effectuer une récupération du micrologiciel par USB (USB Firmware Recovery).

Dès que le fichier du micrologiciel est chargé sur l’appareil, celui-ci redémarre automatiquement et ses données internes sont mises à jour. Cette 
opération peut prendre quelques minutes. Durant ce temps, l’indicateur d’état de connexion est rouge et l’appareil est hors ligne.

Une fois la mise à niveau terminée, l’indicateur ON vert s’affiche de nouveau.

REMARQUE : l’encadré jaune contenant le message « No Data » (Aucune donnée) indique qu’aucune conception n’a été chargée sur l’appareil.
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VUE PROJET
Il existe deux manières de créer un projet.

CONFIGURATION AUTOMATIQUE
Si votre appareil est répertorié dans la vue réseau, sélectionnez-le, puis cliquez sur le bouton Create New Project from Selected Device(s) (Créer un 
projet avec les appareils sélectionnés) situé en haut à droite de l’écran. Ce faisant, vous accéderez automatiquement à la vue projet et pourrez 
sélectionner un modèle de conception.

PROJET VIDE

Autrement, vous pouvez créer un projet à l’aide de l’option File (Fichier) > New project (Nouveau projet).
Si vous créez un projet vide, Xilica Designer vous demande quelle série de processeurs DSP vous souhaitez utiliser. Étant donné que le 
processeur ZoneX se base sur la série de processeurs DSP Solaro, sélectionnez Solaro Series.

1. MENU COMPONENT LIBRARY
Le menu Component Library (Bibliothèque de composants) répertorie la liste d’appareils et de modules de conception pouvant être utilisés dans 
votre projet. Accédez au processeur ZoneX en sélectionnant LD Systems > Processors.

2. ESPACE DE CONCEPTION
L’espace de conception permet de créer et de configurer des appareils.

3. MENU OBJECT PROPERTY
 Le menu Object Property (Propriétés de l’objet) vous permet de configurer les différentes caractéristiques de l’appareil pour la conception 
correspondante.

1

2
3
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CONCEPTION
À titre d’exemple, seul un processeur DSP sera utilisé ici. Toutefois, une conception peut comprendre plusieurs objets DSP.
La conception d’un projet peut être créée hors ligne, c’est-à-dire lorsque l’appareil est déconnecté, puis chargée sur ce dernier ultérieurement.

1. Faites glisser le module DSP désiré, à savoir le ZoneX1208, de la bibliothèque de composants et déposez-le dans l’espace de conception.

2. La fenêtre de sélection Select Design Template (Sélection du modèle de conception) s’affiche. Celle-ci contient tous les modèles de conception. 
Sélectionnez l’un des modèles proposés afin d’en afficher une brève description et l’aperçu de ses caractéristiques principales. Choisissez le 
modèle convenant à votre projet, puis cliquez sur OK pour confirmer. 

Pour obtenir des informations détaillées concernant les différents modèles, rendez-vous sur la FAQ de la page Internet consacrée aux 
processeurs ZoneX de LD Systems.

3. Le processeur ZoneX est configuré en conséquence.
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4. Sélectionnez le module ZoneX pour le mettre en évidence. Vous pouvez maintenant configurer les caractéristiques de l’appareil dans le 
menu Object Property (Propriétés de l’objet) situé à gauche de l’écran.

 Remarque : les caractéristiques de l’objet dépendent de l’appareil et varient selon l’objet sélectionné.

5. Double-cliquez sur le module ZoneX pour ouvrir l’aperçu de conception schématique. Le modèle « Global Dante » est sélectionné dans cet 
exemple. La taille de la fenêtre peut être changée en tirant sur l’un des coins de celles-ci.
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6. Tous les modules DSP peuvent être traités hors ligne. Double-cliquez sur le module désiré pour l’ouvrir, puis réglez les paramètres du module DSP 
en fonction des exigences de votre projet.

Dans cet exemple, l’alimentation fantôme a été activée et les valeurs de gain des deux premiers canaux des paramètres d’entrée ont été réglées.  
De plus, les quatre premiers canaux des modules d’entrée audio ont été renommés et le canal d’entrée 1 a été traité.

7. Double-cliquez ensuite sur le module de mixeur/matrice principal pour acheminer les signaux d’entrée vers les sorties correspondantes.  
Ces signaux peuvent également être traités à l’aide d’un module de traitement de sortie.

DE
UT

SC
H

EN
GL

ISH
FR

AN
ÇA

IS
ES

PA
ÑO

L
PO

LS
KI

ITA
LIA

NO



68

8. Si vous avez modifié les paramètres hors ligne, enregistrez votre projet à l’emplacement désiré en cliquant sur File (Fichier) > Save as 
(Enregistrer sous). Si vous avez modifié un projet existant, enregistrez-la à l’aide de l’option File (Fichier) > Save (Enregistrer). Vous pouvez 
également le faire en cliquant sur l’icône de disquette située en haut à droite de l’espace de conception.

Il est recommandé de sauvegarder les fichiers du projet sur un support externe.
L’extension des fichiers de projet est .pjxml.

MODE EN LIGNE
Si vous sélectionnez le mode en ligne, le fichier de conception est chargé sur les appareils connectés et vous pouvez effectuer des modifications en temps réel.
Dans ce cas, tous les appareils doivent être connectés et en ligne (c’est-à-dire que l’indicateur ON figurant dans la vue réseau doit être vert).

Pour passer en mode en ligne, le module de l’appareil doit être associé à l’équipment physique.

1. Sélectionnez le module d’appareil que vous souhaitez attribuer dans la vue projet.
2. Cliquez à l’aide du bouton droit de la souris sur le module de l’appareil, puis sélectionnez l’option Map to Physical Device (Associer à l’équipement physique).
3. Les appareils reconnus sont désormais répertoriés avec leur adresse MAC. Si plusieurs appareils identiques sont connectés au réseau, vous pouvez les 

différencier grâce à leur adresse MAC. La vue réseau affiche l’adresse MAC de chaque appareil.

Il est primordial que le nom du bloc des appareils figurant dans le fichier de conception corresponde exactement aux unités affichées dans la 
vue réseau, sinon la conception ne pourra pas être chargée sur les équipements correspondants.
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Si tous les appareils sont associés, le module devient vert et l’adresse MAC de l’appareil s’affiche dans le module correspondant.

4. Cliquez sur le bouton Load Design to Device(s) (Charger la conception vers les appareils) situé dans la partie supérieure de l’espace de conception.
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5. Une fenêtre s’affiche alors. Vous pouvez y sélectionner les appareils sur lesquels vous souhaitez charger votre conception. 
Cliquez sur OK pour confirmer.

L’activation du mode en ligne peut prendre quelques minutes. N’interrompez pas ce processus. Une barre de progression indiquant l’avancement 
de l’opération s’affiche dans la partie supérieure de la fenêtre.
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Dès que l’espace de conception devient vert, le mode en ligne est activé et les menus de conception ne sont plus disponibles.

6. Si vous souhaitez modifier des paramètres en temps réel, double-cliquez sur le module DSP ou sur le bloc de module dans la vue projet. Vous 
accéderez ainsi à la représentation schématique de l’appareil correspondant.
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7. Double-cliquez sur le module DSP désiré ou sur un bloc d’entrée et de sortie afin de modifier les paramètres en temps réel.

Vous pouvez à tout moment retourner au mode de conception en cliquant sur le bouton Go Back to Design Mode (Retourner au mode de 
conception) situé sur la partie supérieure de l’espace de conception.
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Un message vous demandera si vous souhaitez copier les modifications effectuées dans la conception du projet.

Cliquez sur Yes (Oui) pour enregistrer les paramètres en ligne dans le projet.
Autrement, cliquez sur No (Non) pour retourner au fichier de conception précédent.

Après avoir transféré les paramètres en ligne vers le projet, vous pouvez sélectionner l’option File (Fichier) > Save (Enregistrer) pour écraser les 
données du fichier de projet d’origine.  
Sinon, sélectionnez l’option File (Fichier) > Save As (Enregistrer sous) pour créer et enregistrer un nouveau fichier de projet.

Il est recommandé de sauvegarder les fichiers du projet sur un support externe.
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EXEMPLES DE CONNEXION DES PORTS GPIO
8 ENTRÉES LOGIQUES (ENTRÉES BINAIRES, GPI)

Activation par mise à la terre (G)

8 SORTIES LOGIQUES (SORTIES BINAIRES, GPO)

2 modes de sortie disponibles :
•	 LED (3 mA)
•	 Puits de terre (300 mA)

Exemple de connexion :

•	 Chaque port GPI présente deux états d’allumage 
(configurables à l’aide du logiciel). 

•	 Cela signifie que deux préréglages différents peuvent être commandés : 
 Ouverture et fermeture des contacts
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CARACTÉRISTIQUES TECHNIQUES
Numéro d’article LDZONEX1208 / D

Type de produit Matrice audio DSP pour installations fixes

Données générales

Entrées audio 12 entrées symétriques micro/ligne et 1 entrée audio dotée d’un bus de commande à distance

Sorties audio 8 sorties de ligne symétriques

Entrées logiques 8 ports GPI (activation par mise à la terre)

Sorties logiques 8 ports GPO dotés des modes suivants : LED (3 mA) ou puits (300 mA) par sortie sélectionnable

Bus de commande à distance Oui

Connecteurs Entrées/sorties : bornier à trois pôles (écartement de 3,81 mm) 
Connecteur de service micro-USB B, entrée RJ45 de commande à distance et port Ethernet RJ45
ZoneX1208D : module Dante primaire et port secondaire RJ45

LED Face avant : POWER (alimentation), NETWORK (réseau), REMOTE (commande à distance), entrées 1 à 12 et 
sorties 1 à 8 (LED blanche et LED rouge)

Commandes sur la face avant Non

Commandes sur la face arrière Bouton marche/arrêt et bouton de réinitialisation de l’adresse IP

Emplacements d’extension Cartes pour un port Ethernet (ZONEX1208) ou pour un port Ethernet et un module Dante (ZONEX1208D)

Refroidissement Refroidissement par convection passive

Alimentation Alimentation commandée par un commutateur doté de nombreux modes

Connecteur d’alimentation Fiche d’alimentation à trois pôles (CEI)

Tension nominale De 90 à 240 VCA à 50/60 Hz

Fusible T2,5 AL/250 V 

Courant d’appel d’allumage et 
d’extinction

21 A  

Consommation énergétique 
(en veille)

23 W

Consommation énergétique 
maximale

60 W

Température de fonctionnement Entre 0 °C et +40 °C (taux d’humidité relative de 60 % maximum)

Largeur Baie de 19” (483 mm)

Hauteur 1 HE (44,5 mm)

Profondeur 315 mm (borniers compris)

Poids 3,8 kg

Distance par rapport à un 
autre appareil dans une baie 
(hauteur)

1 HE

Profondeur de baie (requise) 350 mm

Caractéristiques de performances

Sensibilité d’entrée nominale -22 dBu (onde sinusoïdale, 1 kHz, gain maximal)

Coupure d’entrée nominale +20 dBu (onde sinusoïdale, 1 kHz)

Distorsion harmonique (THD+N) < 0,003 % (entrée et sortie de ligne, signal de +13 dBu, 20 Hz à 20 kHz, gain de 0 dB)

Distorsion d’intermodulation 
(norme SMPTE)

< 0,01 % (-10 dB par rapport à la coupure), bande passante de l’analyseur de 90 kHz

Réponse en fréquence De 15 Hz à 22 kHz (+/-0,15 dB)
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Numéro d’article LDZONEX1208 / D

Impédance d’entrée Ligne : 4 kΩ (symétrique)

Rapport signal/bruit > 117 dB à +20 dBu, gain de 0 dB, bande passante de 20 kHz, pondération A 

Gamme dynamique (AES17) 112 dB

Séparation des canaux 120 dB à 100 Hz, 120 dB à 1 kHz, 105 dB à 10 kHz

Réjection du mode commun (CEI) > 60 dB (1 kHz)

Consommation max. 42 dB

Caractéristiques numériques

DSP Traitement à virgule flottante de 40 bits et processeur SHARC+ à deux cœurs Analog Devices

Latence du système 4,3 ms

Résolution du convertisseur  
AN/NA

32 bits 

Fréquence d’échantillonnage 
du convertisseur AN/NA

48 kHz

Caractéristiques du bus de commande à distance (valeurs mesurées entre l’entrée et la sortie)

Sensibilité d’entrée nominale 20 dBu

Coupure d’entrée nominale 20 dBu

Distorsion harmonique (THD+N) < 0,006 % (+18 dBu, de 20 Hz à 20 kHz)

Réponse en fréquence De 20 Hz à 20 kHz (0,1 dB)

Impédance d’entrée  50 kΩ (symétrique)

Rapport signal/bruit > 105 dB (+20 dBu, bande passante de 20 kHz, pondération A) 

Réjection du mode commun (CEI) > 65 dB à 1 kHz

max. 0 dB

Alimentation fantôme +48 VCC/500 mA

Protection Fusible réarmable (interne)
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DÉCLARATIONS DU FABRICANT
GARANTIE FABRICANT & LIMITATION DE RESPONSABILITÉ 
Nos conditions actuelles de garantie et de limitation de responsabilité sont disponibles à l‘adresse suivante: https://cdn-shop.adamhall.com/
media/pdf/MANUFACTURERS-DECLARATIONS_LD_SYSTEMS.pdf. Pour les réparations, veuillez contacter Adam Hall GmbH, Adam-Hall-Str. 1, 61267 Neu 
Anspach / E-Mail Info@adamhall.com / +49 (0)6081 / 9419-0.

TRI ET MISE AUX DÉCHETS CORRECTE DE CE PRODUIT
(Valid in the European Union and other European countries with waste separation) 
(Applicable dans l‘Union Européenne et les autres pays européens pratiquant le tri des déchets) La présence de ce symbole sur le produit 

ou sur la documentation correspondante indique qu‘en fin de vie, le produit ne doit pas être jeté avec les déchets normaux, afin d‘éviter tout 
dommage à l‘environnement ou aux personnes consécutive à une élimination non contrôlée des déchets. Séparez-le des autres types de déchets et 
recyclez-le, afin de promouvoir la réutilisation durable des ressources naturelles. Nous conseillons aux utilisateurs non professionnels de contacter 
le revendeur chez qui ils ont acheté le produit, ou un représentant gouvernemental local, pour plus de détails sur le lieu de collecte et la façon de 
recycler cet appareil dans le meilleur respect de l‘environnement possible.. Nous invitons les utilisateurs professionnels à contacter leur fournisseur 
et à vérifier les termes et conditions de leur contrat d‘achat. Ce produit ne doit pas être mélangé à d‘autres déchets commerciaux lors de la collecte.

CONFORMITÉ CE
La société Adam Hall GmbH déclare par la présente que ce produit est compatible avec les régulations suivantes (le cas échéant) :
R&TTE (1999/5/EG) et RED (2014/53/EU) à partir de juin 2017
Directive basse tension (2014/35/EU)
Directive CEM (2014/30/EU)
RoHS (2011/65/EU)
La Déclaration de Conformité complète est disponible sur le site Web www.adamhall.com. 
Pour toute information complémentaire, contactez-nous : info@adamhall.com.

DÉCLARATION DE CONFORMITÉ CE
Adam Hall GmbH déclare par la présente que ce type d‘équipement radio est conforme à la directive 2014/53/EU.
Le texte intégral de la déclaration de conformité CE est disponible à l‘adresse suivante
Adresse Internet disponible : www.adamhall.com/compliance/

Sous réserve de fautes d’impression et d’erreurs, ainsi que de modifications techniques ou autres !
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ESPAÑOL

¡HA ELEGIDO BIEN!
Hemos diseñado este producto para que funcione de manera fiable durante muchos años. LD Systems vela por esto con su nombre y sus muchos 
años de experiencia como fabricante de productos de audio de alta calidad. Le rogamos que lea atentamente este manual de usuario para que en 
poco tiempo pueda empezar a usar su producto de LD Systems de manera óptima.
Encontrará más información sobre LD-SYSTEMS en nuestro sitio web: WWW.LD-SYSTEMS.COM.

INFORMACIÓN DE SEGURIDAD
1.	 Lea estas instrucciones atentamente. 
2.	 Guarde toda la información e instrucciones en un lugar seguro. 
3.	 Siga las instrucciones. 
4.	 Respete todas las advertencias de seguridad. Nunca retire las advertencias de seguridad ni ninguna otra información del equipo. 
5.	 Utilice el equipo únicamente de la manera adecuada y para el uso previsto. 
6.	 Use únicamente soportes y/o fijaciones con la estabilidad suficiente (en caso de instalaciones fijas). Asegúrese de que las fijaciones de pared 

están bien instaladas y aseguradas. Compruebe que el equipo está instalado de manera segura y no puede caerse. 
7.	 Durante la instalación, tenga en cuenta las normas de seguridad aplicables en su país. 
8.	 Nunca instale ni utilice el equipo cerca de radiadores, calefactores, hornos u otras fuentes de calor. Asegúrese de que el equipo está siempre 

instalado de modo que cuente con una refrigeración suficiente y no pueda sobrecalentarse. 
9.	 No coloque nunca fuentes de ignición (por ejemplo, velas encendidas) sobre el equipo. 
10.	 Las ranuras de ventilación no deben bloquearse.
11.	 No use este equipo muy cerca del agua (no se aplica si se trata de un equipo especial para exteriores, en cuyo caso, deben tenerse en cuenta las 

instrucciones indicadas abajo). No exponga este equipo a gases, líquidos o materiales inflamables. Evite la luz directa del sol.
12.	 Asegúrese de que en el equipo no puedan entrar gotas ni salpicaduras de agua. No coloque recipientes llenos de líquidos, como jarrones o 

vasos, sobre el equipo. 
13.	 Asegúrese de que no puedan caer objetos en el dispositivo. 
14.	 Use este equipo solo con los accesorios recomendados y previstos por el fabricante. 
15.	 No abra ni modifique el equipo. 
16.	 Después de conectar el equipo, compruebe todos los cables para evitar daños o accidentes, como peligros de tropiezos. 
17.	 Durante el transporte, asegúrese de que el equipo no pueda caerse y causar daños materiales o personales.
18.	 Si su equipo ya no funciona de forma correcta, si han entrado líquidos u objetos en el equipo o si este ha resultado dañado de otra manera, 

apáguelo inmediatamente y desenchúfelo de la toma de corriente (si se trata de un dispositivo con alimentación). Este equipo solo puede 
repararlo personal cualificado autorizado. 

19.	 Limpie el equipo con un paño seco. 
20.	Cumpla todas las leyes de eliminación de residuos aplicables en su país. Durante la eliminación de embalajes, separe el plástico y el papel/

cartón. 
21.	 Las bolsas de plástico deben mantenerse fuera del alcance de los niños.
22.	Tenga en cuenta que los cambios o modificaciones que no cuenten con la aprobación expresa de la parte responsable del cumplimiento podrían 

invalidar la autoridad del usuario para utilizar el equipo.

EN CUANTO AL EQUIPO QUE SE CONECTA A LA RED ELÉCTRICA
23.	PRECAUCIÓN: Si el cable de alimentación del dispositivo está equipado con un contacto de conexión a tierra, este debe conectarse a un enchufe 

con toma de tierra. No desactive nunca la toma de tierra de un cable de alimentación. 
24.	Si el equipo ha estado expuesto a cambios bruscos de temperatura (por ejemplo, después del transporte), no lo encienda de inmediato. La 

humedad y la condensación podrían provocar daños en el equipo. No encienda el equipo hasta que haya alcanzado la temperatura ambiente. 
25.	Antes de conectar el equipo a la toma de corriente, verifique primero que la frecuencia y tensión de red coincidan con los valores especificados 

en el equipo. Si el equipo cuenta con un interruptor de selección de tensión, conecte el equipo a la toma de corriente solo si los valores del 
equipo y los valores de la red eléctrica coinciden. Si el cable de alimentación o el adaptador de red incluidos no sirven para su toma de pared, 
póngase en contacto con un electricista. 

26.	No pise el cable de alimentación. Asegúrese de que el cable de alimentación no se retuerza, en particular, en la toma de corriente y/o adaptador 
de red y el conector del equipo. 

27.	 Al conectar el equipo, asegúrese de que siempre sea posible acceder libremente al cable de alimentación o al adaptador de red. Desconecte 
siempre el equipo de la fuente de alimentación cuando no se encuentre en uso o si desea limpiarlo. Desenchufe siempre el cable de 
alimentación y el adaptador de red de la toma de corriente desde el enchufe o el adaptador, nunca tirando del cable. No toque nunca el cable de 
alimentación ni el adaptador de red con las manos mojadas. 

28.	Siempre que sea posible, evite encender y apagar el equipo rápidamente porque, de lo contrario, se reducirá la vida útil del equipo.
29.	INFORMACIÓN IMPORTANTE: Sustituya los fusibles únicamente por fusibles del mismo tipo y clasificación. Si un fusible se funde repetidamente, 

póngase en contacto con un centro de asistencia técnica autorizado. 
30.	Para desconectar el equipo de la red eléctrica por completo, desenchufe el cable de alimentación o el adaptador de red de la toma de corriente. 
31.	 Si su dispositivo está equipado con un conector de alimentación Volex, el conector del equipo Volex correspondiente debe desbloquearse antes 

de que pueda extraerse. Sin embargo, esto también significa que el equipo puede deslizarse y caerse si se tira del cable de alimentación, lo que 
puede provocar lesiones personales y/u otros daños. Por ese motivo, tenga siempre cuidado cuando tienda los cables. 

32.	Desenchufe el cable de alimentación y el adaptador de red de la toma de alimentación si existe riesgo de relámpagos o si va a estar un tiempo 
prolongado fuera de uso.

33.	 El aparato no debe ser usado por personas (niños incluidos) con capacidad física, sensorial o mental reducida o sin experiencia ni conocimientos.
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34.	Se debe prohibir a los niños que jueguen con el dispositivo.
35.	No utilice el dispositivo si su cable de alimentación está dañado. El cable de alimentación debe ser sustituido por un cable o conjunto adecuado 

de un centro de asistencia técnica autorizado.

PRECAUCIÓN:
Para reducir el riesgo de descarga eléctrica, no retire la cubierta (o la parte posterior). En el interior 
no hay piezas que puedan ser reparadas por el usuario. Los trabajos de mantenimiento y reparación 
únicamente debería realizarlos personal de asistencia técnica cualificado.

El triángulo de advertencia con el símbolo de rayo indica que existe una tensión peligrosa sin aislar dentro de la unidad, lo que 
puede provocar una descarga eléctrica.

El triángulo de advertencia con un signo de exclamación indica instrucciones de funcionamiento o mantenimiento importantes.

¡Advertencia! Este símbolo indica una superficie caliente. Determinadas partes de la carcasa pueden calentarse durante el 
funcionamiento. Después del uso, espere un tiempo de enfriamiento de al menos 10 minutos antes de manipular o transportar el 
dispositivo.

¡Advertencia! Este dispositivo está diseñado para usarse por debajo de 2000 metros de altitud.

¡Advertencia! Este producto no está concebido para su uso en climas tropicales.

¡PRECAUCIÓN! ¡VOLÚMENES ALTOS EN PRODUCTOS DE SONIDO!
Este dispositivo está diseñado para un uso profesional. Por lo tanto, el uso comercial de este equipo está sujeto a las regulaciones y normas de 
prevención de accidentes nacionales aplicables en cada caso. Como fabricante, Adam Hall está obligado a notificarle formalmente de la existencia 
de riesgos potenciales para la salud. Daños auditivos por volúmenes altos y exposición prolongada: este producto, mientras está en uso, puede 
producir elevados niveles de presión sonora (NPS) que pueden causar daños auditivos permanentes en intérpretes, empleados o personas 
presentes. Por este motivo, evite la exposición prolongada a volúmenes que superen los 90 dB.

NOTA: Este equipo se ha sometido a pruebas y se ha determinado que cumple con los límites de un dispositivo digital de clase B, de conformidad 
con el apartado 15 de la normativa de la FCC. Estos límites están diseñados para ofrecer una protección aceptable contra interferencias dañinas 
en una instalación residencial. Este equipo genera, emplea y puede emitir energía de radiofrecuencia y, en caso de no instalarse ni usarse según 
estas instrucciones, puede provocar interferencias perjudiciales en las comunicaciones de radio. Sin embargo, no puede garantizarse que esto no 
pueda darse en una instalación concreta. Si este equipo causa interferencias perjudiciales para la recepción de radio o televisión, lo que puede 
determinarse apagando y encendiendo el equipo, se recomienda al usuario que intente corregir la interferencias tomando una o varias de las 
siguientes medidas:
– Reoriente o recoloque la antena receptora.
– Aumente la separación entre el equipo y el receptor.
– Conecte el equipo en una toma de un circuito diferente del que está conectado el receptor.
– Pida asistencia al distribuidor o a un técnico de radio y televisión experimentado.
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CARACTERISTICAS
•	 Procesador DSP de arquitectura híbrida 
•	 Plantillas DSP disponibles para distintos requisitos de instalación
•	 Motor DSP de coma flotante de 40 bits con procesador Analog Devices SHARC+ de doble nucleo y procesador ARM Cortex A5
•	 Sistema operativo Linux de nueva generación
•	 Preamplificadores de micrófono de máxima calidad y convertidores AD/DA de 32 bits de alto rendimiento
•	 12 entradas de micrófono/línea balanceadas con selección de alimentación fantasma de 48 V por entrada.
•	 8 salidas balanceadas
•	 8 puertos lógicos GPI y 8 GPO
•	 Conectores de bloques de terminales de 6 polos (paso de 3,81 mm) para todas las entradas/salidas de audio y control
•	 Bus REMOTE para la integración con paneles murales y micrófonos de avisos de LD Systems.
•	 Diseño del panel frontal claro e intuitivo
•	 Interfaz Ethernet para control remoto a través del software de control universal Xilica Designer
•	 Aplicaciones de control remoto disponibles tanto para iOS como para Android, para paneles de usuario personalizados
•	 Planificador de eventos integrado
•	 Expansión Dante 64x64 opcional (conectividad "Audio sobre IP")
•	 Dispositivo en rack de 19”, 1 RU

CONTENIDO DEL PAQUETE
•	 Hardware LD ZoneX
•	 Cable de alimentación
•	 Manual de usuario

CONEXIONES, CONTROLES Y ELEMENTOS DE VISUALIZACIÓN
PARTE FRONTAL 

1  LED DE ESTADO GENERAL
POWER = el dispositivo está encendido
NETWORK = conexión de red establecida
REMOTE = dispositivos remotos de LD Systems conectados  
		  (micrófonos de conferencia, paneles de control, etc.)

2  LED DE ENTRADA Y SALIDA
Blanco = señal presente
Rojo = señal sobreexcitada
 

2 1 2

PARTE TRASERA

3  CONECTOR DE ALIMENTACIÓN Y PORTAFUSIBLES
Conector de alimentación IEC con portafusibles. El contenido del paquete incluye un cable de alimentación adecuado.
PRECAUCIÓN: El fusible únicamente puede sustituirse por otro del mismo tipo y con las mismas clasificaciones. Consulte la información en la 
carcasa. Si el fusible se funde repetidamente, póngase en contacto con un centro de asistencia técnica autorizado. 

4  INTERRUPTOR DE ENCENDIDO/APAGADO
Interruptor basculante para encender y apagar el dispositivo.

5  ETHERNET - USB - RESET
Tarjeta de expansión de comunicaciones con conector Ethernet, o Ethernet + Dante (E/S 64 x 64) en el modelo "D", para la comunicación entre el 
procesador ZoneX y el ordenador host, puerto de recuperación micro USB para recuperación del firmware y botón de restablecimiento de IP.

6  REMOTE
Bus remoto LD Systems para la integración con futuros paneles de control y micrófonos de conferencia de LD Systems. Tenga en cuenta que este 
conector solo puede usarse con dispositivos compatibles con el bus remoto de LD Systems y no con puertos de conmutación Ethernet.

7  GPO
8 salidas GPO (puertos lógicos) con dos modos seleccionables por salida: LED (3 mA) o sumidero (300 mA). Bloques de terminales tripolares (paso de 
3,81 mm). Tenga en cuenta también los ejemplos de conexión que aparecen en este manual de usuario (consulte EJEMPLOS DE CONEXIÓN DE GPI/O)

8  GPI
8 entradas GPI (puertos lógicos), con activación mediante cortocircuito a masa. Bloques de terminales tripolares (paso de 3,81 mm). Tenga en 
cuenta también los ejemplos de conexión que aparecen en este manual de usuario (consulte EJEMPLOS DE CONEXIÓN DE GPI/O)

9   SALIDAS
8 salidas de audio balanceadas. Bloques de terminales tripolares (paso de 3,81 mm).

10   ENTRADAS
12 entradas de micrófono/línea de audio balanceadas con alimentación fantasma de 48 V conmutable por canal. Bloques de terminales tripolares 
(paso de 3,81 mm).

DISPOSITIVOS DE CONEXIÓN
El procesador DSP ZoneX de LD Systems y otras unidades de control funcionan en una infraestructura basada en red y se configuran y controlan a 
través de un ordenador con el software Xilica Designer.

PRERREQUISITOS PARA EL FUNCIONAMIENTO
•	 Ordenador
•	 Interfaz de red (enrutador, conmutador PoE) 

Es necesario un enrutador para la asignación de dirección IP y una conexión rápida y sencilla con su ordenador y las unidades de control 
conectadas. Es necesario un conmutador PoE para las unidades de control sin fuente de alimentación local.

•	 Cable Ethernet. Todas las conexiones con cables emplean un cable Ethernet RJ45 estándar (Cat 5e o superior).

4

6

3

7 8 9 10

5

Don‘t connect to any 
ethernet switch port!

This port is only for LD 
Systems remote bus 
compatible devices.
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CARACTERISTICAS
•	 Procesador DSP de arquitectura híbrida 
•	 Plantillas DSP disponibles para distintos requisitos de instalación
•	 Motor DSP de coma flotante de 40 bits con procesador Analog Devices SHARC+ de doble nucleo y procesador ARM Cortex A5
•	 Sistema operativo Linux de nueva generación
•	 Preamplificadores de micrófono de máxima calidad y convertidores AD/DA de 32 bits de alto rendimiento
•	 12 entradas de micrófono/línea balanceadas con selección de alimentación fantasma de 48 V por entrada.
•	 8 salidas balanceadas
•	 8 puertos lógicos GPI y 8 GPO
•	 Conectores de bloques de terminales de 6 polos (paso de 3,81 mm) para todas las entradas/salidas de audio y control
•	 Bus REMOTE para la integración con paneles murales y micrófonos de avisos de LD Systems.
•	 Diseño del panel frontal claro e intuitivo
•	 Interfaz Ethernet para control remoto a través del software de control universal Xilica Designer
•	 Aplicaciones de control remoto disponibles tanto para iOS como para Android, para paneles de usuario personalizados
•	 Planificador de eventos integrado
•	 Expansión Dante 64x64 opcional (conectividad "Audio sobre IP")
•	 Dispositivo en rack de 19”, 1 RU

CONTENIDO DEL PAQUETE
•	 Hardware LD ZoneX
•	 Cable de alimentación
•	 Manual de usuario

CONEXIONES, CONTROLES Y ELEMENTOS DE VISUALIZACIÓN
PARTE FRONTAL 

1  LED DE ESTADO GENERAL
POWER = el dispositivo está encendido
NETWORK = conexión de red establecida
REMOTE = dispositivos remotos de LD Systems conectados  
		  (micrófonos de conferencia, paneles de control, etc.)

2  LED DE ENTRADA Y SALIDA
Blanco = señal presente
Rojo = señal sobreexcitada
 

2 1 2

PARTE TRASERA

3  CONECTOR DE ALIMENTACIÓN Y PORTAFUSIBLES
Conector de alimentación IEC con portafusibles. El contenido del paquete incluye un cable de alimentación adecuado.
PRECAUCIÓN: El fusible únicamente puede sustituirse por otro del mismo tipo y con las mismas clasificaciones. Consulte la información en la 
carcasa. Si el fusible se funde repetidamente, póngase en contacto con un centro de asistencia técnica autorizado. 

4  INTERRUPTOR DE ENCENDIDO/APAGADO
Interruptor basculante para encender y apagar el dispositivo.

5  ETHERNET - USB - RESET
Tarjeta de expansión de comunicaciones con conector Ethernet, o Ethernet + Dante (E/S 64 x 64) en el modelo "D", para la comunicación entre el 
procesador ZoneX y el ordenador host, puerto de recuperación micro USB para recuperación del firmware y botón de restablecimiento de IP.

6  REMOTE
Bus remoto LD Systems para la integración con futuros paneles de control y micrófonos de conferencia de LD Systems. Tenga en cuenta que este 
conector solo puede usarse con dispositivos compatibles con el bus remoto de LD Systems y no con puertos de conmutación Ethernet.

7  GPO
8 salidas GPO (puertos lógicos) con dos modos seleccionables por salida: LED (3 mA) o sumidero (300 mA). Bloques de terminales tripolares (paso de 
3,81 mm). Tenga en cuenta también los ejemplos de conexión que aparecen en este manual de usuario (consulte EJEMPLOS DE CONEXIÓN DE GPI/O)

8  GPI
8 entradas GPI (puertos lógicos), con activación mediante cortocircuito a masa. Bloques de terminales tripolares (paso de 3,81 mm). Tenga en 
cuenta también los ejemplos de conexión que aparecen en este manual de usuario (consulte EJEMPLOS DE CONEXIÓN DE GPI/O)

9   SALIDAS
8 salidas de audio balanceadas. Bloques de terminales tripolares (paso de 3,81 mm).

10   ENTRADAS
12 entradas de micrófono/línea de audio balanceadas con alimentación fantasma de 48 V conmutable por canal. Bloques de terminales tripolares 
(paso de 3,81 mm).

DISPOSITIVOS DE CONEXIÓN
El procesador DSP ZoneX de LD Systems y otras unidades de control funcionan en una infraestructura basada en red y se configuran y controlan a 
través de un ordenador con el software Xilica Designer.

PRERREQUISITOS PARA EL FUNCIONAMIENTO
•	 Ordenador
•	 Interfaz de red (enrutador, conmutador PoE) 

Es necesario un enrutador para la asignación de dirección IP y una conexión rápida y sencilla con su ordenador y las unidades de control 
conectadas. Es necesario un conmutador PoE para las unidades de control sin fuente de alimentación local.

•	 Cable Ethernet. Todas las conexiones con cables emplean un cable Ethernet RJ45 estándar (Cat 5e o superior).
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ES POSIBLE CREAR UNA CONEXIÓN DE RED ENTRE EL ORDENADOR HOST Y EL PROCESADOR ZONEX DE LA SIGUIENTE MANERA:

A. ENRUTADOR CON SERVIDOR DHCP ACTIVADO (RECOMENDADO)
Al usar un enrutador con un servidor DHCP habilitado, el procesador ZoneX adquiere automáticamente la dirección IP durante el arranque, en 
cuanto se da la conexión. Se recomienda usar un enrutador y un conmutador PoE si se conectan a la red más unidades de control/controladores 
de otros fabricantes. Esta combinación proporciona un servidor DHCP y también facilita la fuente de alimentación para los dispositivos conectados. 
Recomendamos emplear enrutadores Linksys y conmutadores Netgear.

Nota: Por lo general, los enrutadores/conmutadores con servidor DHCP activado deberían encenderse primero. Y todos los cables Ethernet deberían 
conectarse al hardware antes de que se enciendan los dispositivos. Esto permitirá una asignación correcta de la dirección IP.

•	 Primero, encienda el enrutador/conmutador.
•	 Después, conecte el ordenador host al enrutador habilitado para DHCP con un cable Ethernet.
•	 Conecte el enrutador al procesador ZoneX con un cable Ethernet.
•	 Conecte el procesador ZoneX a la red eléctrica y enciéndalo.

B. CONEXIÓN DIRECTA NO BASADA EN DHCP O CONEXIÓN INDIRECTA MEDIANTE CONMUTADOR ETHERNET
Si el procesador está directamente conectado a un ordenador o indirectamente a través de un conmutador y el servidor no DHCP está disponible,  
la conexión no puede establecerse de manera automática.
Por lo tanto, las conexiones no basadas en DHCP deben configurarse manualmente. Encontrará más detalles en el archivo de ayuda de Xilica 
Designer o en las preguntas frecuentes del procesador ZoneX de LD Systems.
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SOFTWARE XILICA DESIGNER
El software Xilica Designer no solo permite una configuración detallada del procesador ZoneX, sino que también ofrece acceso a la configuración de 
unidades de control remoto de otras compañías, facilita la gestión de dispositivos de red Dante opcionales y proporciona integración universal de 
control de dispositivos de terceros.

INSTALACIÓN EN MAC OS X
Requisitos del sistema:
•	 Mac OS X 10.8 o superior
•	 Procesador de 1 GHz o superior
•	 500 MB de espacio libre en el disco duro
•	 Tarjeta gráfica de 1 GB
•	 4 GB de RAM

1. Descargue la versión más reciente del software Xilica Designer en su ordenador desde el sitio web de LD Systems (www.ld-systems.com).
2. Abra el archivo .zip descargable.
3. A continuación, abra el archivo XilicaDesigner.mpkg.
4. Aparecerá una ventana de instalación. Siga cada uno de los pasos.

5. Si el proceso de instalación se realiza correctamente, en la ventana de instalación aparecerá el mensaje: "The installation was successful".

7. El software Xilica Designer ya está instalado.
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INSTALACIÓN EN WINDOWS
Requisitos del sistema:
•	 Windows 7 o superior
•	 Procesador de 1 GHz o superior
•	 500 MB de espacio libre en el disco duro
•	 Tarjeta gráfica de 1 GB
•	 4 GB de RAM

1. Descargue la versión más reciente del software Xilica Designer en su ordenador desde el sitio web de LD Systems (www.ld-systems.com).
2. Abra el archivo .zip descargable.
3. A continuación, abra el archivo XilicaDesigner.exe.
4. Aparecerá una ventana de instalación. Haga clic en "Install" para continuar.

5. Espere hasta que el proceso de instalación haya finalizado. Esto puede tardar varios minutos.
6. Si el proceso de instalación ha sido correcto, Windows solicitará su autorización para permitir el acceso a través del cortafuegos. Recomendamos 

configurar el sistema de modo que se autorice la comunicación para Xilica Designer en redes privadas, como una doméstica o empresarial.  
Es posible incluir redes públicas en caso necesario. 

Seleccione las opciones deseadas a través del panel de control y, a continuación, haga clic en "Allow Access" para completar la configuración.

7. El software Xilica Designer ya está instalado.
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INICIO DEL SOFTWARE
Busque el software Xilica Designer en su escritorio o en la carpeta de la aplicación. Haga doble clic en el software para iniciarlo.
Ahora puede crear un proyecto de diseño nuevo o abrir un proyecto de diseño, iniciar la vista de red o iniciar la vista Dante.

VISTA DE RED
La vista de red muestra todos los procesadores y unidades de control en la red. Aquí encontrará información del dispositivo como el estado de 
conexión, la dirección IP del ordenador, la dirección IP del dispositivo, la dirección Mac, el nombre del dispositivo, el fabricante y la versión del 
firmware.

Los procesadores conectados deberían estar visibles en la vista de red. Hay un indicador de estado de conexión en la esquina superior izquierda de 
cada bloque del dispositivo.

Verde: el dispositivo está conectado y listo para el funcionamiento.

Amarillo: el dispositivo está conectado y en línea, pero no está listo para el funcionamiento. Pase el cursor sobre el indicador de red y una ventana 
emergente mostrará un mensaje con información sobre el problema detectado. (Normalmente el mensaje indica que no se ha cargado ningún 
diseño de dispositivo.)

Rojo:  el dispositivo no está conectado y no está en línea. No hay comunicación entre el software Xilica Designer y el dispositivo. Compruebe todos 
los cables y conexiones y asegúrese de que el dispositivo está encendido. Si el procesador está ejecutando una actualización del firmware o se está 
reiniciando, puede darse una interrupción momentánea. 

De vez en cuando, puede que aparezca un signo de exclamación (!). Esto significa que hay disponible una actualización del firmware. Por lo general, 
esto no requiere una intervención inmediata, pero el archivo de proyecto no contiene modelos actualizados, puesto que el firmware anterior no es 
compatible. Encontrará más detalles en el archivo de ayuda de Xilica Designer o en las preguntas frecuentes del procesador ZoneX de LD Systems.
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ACTUALIZACIÓN DEL FIRMWARE
Tenga en cuenta que, en un principio, es posible usar una versión antigua del software con el firmware nuevo o usar el software nuevo con una 
versión antigua del firmware, pero puede que la variedad de funciones se vea limitada o que la funcionalidad no sea óptima en todos los casos. 

Recomendamos siempre utilizar las versiones más recientes del software y firmware.

Antes de empezar, compruebe las versiones del software y firmware.

Para verificar la versión del firmware del dispositivo, asegúrese de que su dispositivo está encendido y en línea. La vista de red señala los 
dispositivos disponibles para una actualización del firmware con un triángulo amarillo y un signo de exclamación. Además, la versión del firmware 
del dispositivo también aparece en el bloque del dispositivo correspondiente.

La versión actual del software se muestra al hacer clic en "About" del menú de la barra superior.

PROCEDIMIENTO DE ACTUALIZACIÓN DEL FIRMWARE
Guarde el archivo de diseño del dispositivo en su ordenador, puesto que todos los datos programados se eliminarán durante la actualización. 
Una vez finalizada la actualización del firmware, el archivo de diseño puede cargarse de nuevo en el dispositivo.

•	 Para poder llevar a cabo la actualización del firmware, el dispositivo debe estar en línea y listo para el funcionamiento.

•	 La versión más reciente del firmware para el modelo Zone X correspondiente puede descargarse desde el sitio web de LD Systems  
(www.ld-systems.com).

•	 Haga clic con el botón derecho en la vista de red sobre un bloque de dispositivo y seleccione "Firmware Upgrade".
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Aparecerá una advertencia que indicará que la actualización del firmware eliminará todos los datos de su dispositivo. Confirme con "OK" para 
continuar.

Aparecerá un menú desplegable desde el que puede seleccionar el archivo de firmware que desee desde un sistema de archivos o una versión de 
firmware anteriormente descargada a través del "Device Firmware Manager" (en el menú "Device Management"). Confirme con "Ok" y busque la 
carpeta en la que ha guardado el nuevo archivo de firmware. Seleccione el archivo y haga clic en "Open".
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Una barra de estado en la ventana del dispositivo muestra el progreso de la actualización del firmware.

NO APAGUE EL DISPOSITIVO NI LO DESCONECTE DEL ORDENADOR. Si el dispositivo se apaga o se desconecta del ordenador durante la actualización del 
firmware, puede producirse una corrupción completa del procesador. En este caso, debe realizarse una recuperación del firmware mediante USB.

En cuanto el archivo de firmware se haya descargado correctamente en el dispositivo, se reiniciará automáticamente y los datos internos se 
actualizarán. Esto puede tardar varios minutos. Durante este tiempo, el indicador de red será ROJO y el dispositivo estará sin conexión.

Una vez finalizada la actualización del firmware, volverá a aparecer el indicador "ON" verde. 

NOTA: El área amarilla con el mensaje "No Data" significa que no se ha cargado ningún diseño en el dispositivo.
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VISTA DE PROYECTO
Un proyecto nuevo puede crearse de dos maneras:

CONFIGURACIÓN AUTOMÁTICA
Si su dispositivo aparece en una vista de red, selecciónelo y haga clic en la parte superior derecha sobre Create New Project from Selected 
Device(s). Esto le lleva automáticamente a la vista de proyecto y le permite seleccionar una plantilla de diseño.

PROYECTO VACIO

La segunda opción es crear un proyecto nuevo a través de File > New Project.
Si empieza con un proyecto vacío, Xilica Designer le preguntará qué serie DSP desea emplear. ZoneX se basa en la serie DSP Solaro, por lo tanto, 
seleccione Solaro Series.

1. MENÚ "COMPONENT LIBRARY"
Este menú ofrece una lista de dispositivos y módulos de diseño para usar en su proyecto. Busque el procesador ZoneX en LD Systems > Processors.

2. ÁREA DE TRABAJO
El área de trabajo se emplea para crear y configurar dispositivos.

3. MENÚ "OBJECT PROPERTY"
 Este menú le permite configurar las características del objeto para el diseño correspondiente.

1

2
3
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DISEÑO
Para fines demostrativos, en este caso solo se usará un bloque de hardware DSP; sin embargo, un diseño también puede incluir varios objetos de 
hardware DSP. Es posible crear un diseño de proyecto sin estar en línea (sin hardware conectado) y cargarlo en su dispositivo más adelante.

1. Arrastre y suelte el módulo DSP que desee (en este caso, ZoneX1208) desde "Component Library" hasta el área de trabajo.

2. Aparecerá una ventana de selección con todas las plantillas de diseño (Select Design Template). Seleccione una de las plantillas que se ofrecen 
y verá una breve descripción y una vista general de sus características fundamentales. Seleccione una plantilla adecuada para su proyecto y 
confirme con Ok. 

En las preguntas frecuentes del procesador ZoneX de LD Systems, encontrará descripciones detalladas de las diferentes plantillas.

3. El procesador ZoneX se configura de manera correspondiente.
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4. Seleccione el módulo ZoneX para resaltarlo. Ahora puede ajustar las características del dispositivo en el menú "Object Property" situado a la derecha.
 Nota: Las características del objeto dependen del dispositivo y pueden variar en función del objeto seleccionado. 

5. Haga doble clic en el módulo ZoneX para abrir la vista general de diseño esquemática. En este ejemplo se selecciona la plantilla "Global Dante".  
El tamaño de la ventana puede cambiarse arrastrando la esquina de esta.
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6. Todos los módulos DSP pueden procesarse sin conexión. Haga doble clic en el módulo que desee abrir. Después puede ajustar la configuración 
para el módulo DSP conforme a los requisitos de su proyecto.

En este ejemplo, se ha activado la alimentación fantasma y se han ajustado los valores de ganancia en los dos primeros canales de los ajustes de 
entrada.  Además, hemos cambiado el nombre de los primeros cuatro canales en los módulos de entrada de audio y procesado el canal de entrada 1.

7. Ahora, haga doble clic en el módulo de matriz mezcladora principal para enviar las señales de entrada a las salidas correspondientes.  
Estas también pueden procesarse con un módulo de procesamiento de salidas.
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8. Si ha cambiado los ajustes sin conexión, guarde su proyecto en la ubicación deseada haciendo clic en File > Save As. Si ha cambiado un archivo de 
proyecto existente, guárdelo con File > Save. Puede hacer lo mismo haciendo clic en el símbolo de guardar que se encuentra en la parte 
superior derecha del área de trabajo. 

Es aconsejable guardar copias de seguridad de los archivos de proyecto externamente.
La extensión del archivo (extensión de nombre) para los archivos de proyecto guardados es .pjxml.

MODO ONLINE
Si selecciona el modo online, el archivo de diseño se cargará en los dispositivos conectados y puede hacer cambios en tiempo real.
En este caso, todos los dispositivos deben estar conectados y en línea (indicador "ON" verde en la vista de red).

Para cambiar al modo online, el módulo del dispositivo debe asignarse al hardware físico.

1. Seleccione el módulo del dispositivo que desea asignar desde la vista de proyecto.
2. Haga clic con el botón derecho sobre el módulo del dispositivo y seleccione Map to Physical Device.
3. Los dispositivos reconocidos se muestran ahora con sus direcciones Mac. Si hay varios dispositivos idénticos conectados a la red, pueden 

identificarse mediante sus direcciones Mac. La vista de red muestra las direcciones Mac para cada uno de los dispositivos.

Es muy importante que el nombre del bloque del dispositivo en el archivo de diseño coincida exactamente con la unidad en la vista de red, de lo 
contrario, el diseño no puede cargarse en el hardware correspondiente.
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Si todo está asignado, el color del módulo cambia a verde continuo y la dirección Mac del dispositivo se muestra debajo del módulo del dispositivo.

4. Ahora, haga clic en Load Design to Device(s), en la parte superior del área de trabajo.
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5. Aparecerá una ventana en la que puede marcar los dispositivos en los que desea cargar su diseño. 
Confirme con Ok.

El cambio al modo online puede tardar varios minutos. ¡No interrumpa el proceso! El progreso del proceso se muestra en porcentaje en la barra de 
estado que se encuentra en la parte superior de la ventana.
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En cuando aparece el área de trabajo en verde continuo, ya se encuentra en modo online y el menú de diseño ya no está disponible.

6. Si desea cambiar los ajustes en tiempo real, puede hacer doble clic en el módulo DSP de la vista de proyecto o en el bloque del dispositivo de la 
vista de proyecto y podrá ver entonces la representación esquemática del dispositivo correspondiente.
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7. Haga doble clic en el módulo DSP que desee o en un bloque de E/S para cambiar los ajustes en tiempo real.

Puede volver al modo de diseño en cualquier momento a través del botón Go Back to Design Mode situado en la parte superior del área de trabajo.
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Se le preguntará si desea copiar los cambios hechos online en el diseño del proyecto.

Confirme con Yes para guardar los ajustes online para el proyecto.
Haga clic en No para volver al archivo de diseño anterior.

Después de transferir los ajustes online a un proyecto, la opción File > Save sobrescribirá el archivo de proyecto original.  
Seleccione File > Save As para crear y guardar un archivo de proyecto nuevo.

Es recomendable guardar copias de seguridad de los archivos de proyecto externamente.
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EJEMPLOS DE CONEXIÓN DE GPI/O
8 ENTRADAS LÓGICAS (ENTRADAS BINARIAS, GPI)

Activación mediante conexión a masa (G)

8 SALIDAS LÓGICAS (SALIDAS BINARIAS, GPO)

2 modos de salida disponibles:
•	 LED (3 mA)
•	 sumidero a masa (300 mA) 

Ejemplo de conexión: 

•	 Cada GPI ofrece dos estados de conmutación (a través de software) 
•	 Esto significa que pueden accionarse dos preajustes diferentes  
 Apertura y cierre de contactos
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DATOS TÉCNICOS
Número de artículo LDZONEX1208 / D

Tipo de producto Matriz de audio DSP para instalación fija

Datos generales

Entradas de audio 12 entradas de micrófono/línea balanceadas + 1 entrada de audio de bus remoto

Salidas de audio 8 salidas de línea balanceadas

Entradas lógicas 8 GPI: activación a través de conexión de masa.

Salidas lógicas 8 GPO; modos: LED (3 mA) o sumidero (300 mA), seleccionable por salida

Bus remoto Sí

Conectores Entradas/salidas: Bloque de terminales tripolares, paso de 3,81 mm;  
conector de servicio micro USB B, IN RJ45 remoto, Ethernet RJ45
ZoneX1208D: RJ45 Dante primario y secundario

LED Parte frontal: "POWER", "NETWORK", "REMOTE", entradas 1 – 12 y salidas 1 – 8: LED de señal blanco, LED de clip rojo

Controles del panel frontal No

Controles del panel trasero ON/OFF de la red eléctrica, "IP RESET"

Ranuras de expansión para Ethernet (ZONEX1208) o tarjetas Ethernet + Dante (ZONEX1208D)

Refrigeración Refrigeración por convección pasiva

Fuente de alimentación Fuente de alimentación conmutada de amplio rango

Conector de fuente de 
alimentación

Toma de fuente de alimentación tripolar (IEC)

Tensión de funcionamiento 90 – 240 V CA; 50/60 Hz

Fusible de red T2.5 A L / 250 V 

Corriente de irrupción  
OFF-ON de red

21 A  

Consumo de energía,  
modo de reposo

23 W

Máx. consumo de energía 60 W

Temperatura de funcionamiento 0 °C a +40 °C (humedad relativa máx. del 60 %)

Anchura Rack de 19" (483 mm)

Altura 1 RU (44,5 mm)

Profundidad 315 mm (con bloques de terminales)

Peso 3,8 kg

Distancia de rack al siguiente 
dispositivo (altura)

1 RU

Profundidad de rack (requerida) 350 mm

Especificaciones de rendimiento

Sensibilidad de entrada nominal -22 dBu (onda sinusoidal, 1 kHz, máx. ganancia)

Limitación de entrada nominal +20 dBu (onda sinusoidal, 1 kHz)

Distorsión armónica (THD+N) <0,003 % (línea IN – OUT, señal de +13 dBu, 20 Hz – 20 kHz, ganancia de 0 dB)

Distorsión de intermodulación 
(IMD), SMPTE:

<0,01 % (-10 dB bajo clip), ancho de banda del analizador de 90 kHz

Respuesta de frecuencia 15 Hz – 22 kHz (+/-0,15 dB)

Impedancia de entrada Línea: 4 kOhmios (balanceada)
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Número de artículo LDZONEX1208 / D

Relación señal-ruido >117 dB a +20 dBu, ganancia de 0 dB, ancho de banda de 20 kHz, ponderación A 

Rango dinámico (AES17) 112 dB

Diafonía de canales 120 dB a 100 Hz, 120 dB a 1 kHz, 105 dB a 10 kHz

Relación de rechazo en  
modo común, CEI CMRR

>60 dB (1 kHz)

Máx. ganancia 42 dB

Especificaciones digitales

DSP Procesamiento de coma flotante de 40 bits, procesador SHARC+ de doble núcleo (Analog Devices)

Latencia del sistema 4,3 ms

Convertidor AD/DA de 
resolución

32 bits 

Convertidor AD/DA de  
tasa de muestreo

48 kHz

Especificaciones del bus remoto, medido entre la entrada REM y la salida REM

Sensibilidad de entrada nominal 20 dBu

Limitación de entrada nominal 20 dBu

Distorsión armónica (THD+N) <0,006 % (+18 dBu, 20 Hz – 20 kHz)

Respuesta de frecuencia 20 Hz – 20 kHz (0,1 dB)

Impedancia de entrada  50 kOhmios (balanceada)

Relación señal-ruido >105 dB (+20 dBu, ancho de banda de 20 kHz, ponderación A) 

Relación de rechazo en  
modo común, IEC CMRR

>65 dB a 1 kHz

Ganancia 0 dB

Alimentación fantasma +48 V CC / 500 mA

Protección Fusible rearmable (interno)
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DECLARACIONES DEL FABRICANTE
GARANTIA DEL FABRICANTE Y LIMITACIÓN DE RESPONSABILIDAD 
Consulte nuestras condiciones de garantía y limitaciones de responsabilidad en: https://cdn-shop.adamhall.com/media/pdf/MANUFACTURERS- 
DECLARATIONS_LD_SYSTEMS.pdf. En caso de necesitar servicio técnico, póngase en contacto con Adam Hall GmbH, Adam-Hall-Str. 1, 61267 Neu Anspach 
(Alemania); correo electrónico Info@adamhall.com; +49 (0)6081 / 9419-0. 

ELIMINACIÓN CORRECTA DE ESTE PRODUCTO
(Aplicable en la Unión Europea y en los países europeos que dispongan de un sistema de recogida selectiva) El símbolo que aparece sobre 
el producto o en la documentación adjunta indica que al final de la vida útil del equipo, no deberá desecharlo con los demás residuos domé-

sticos, con el fin de evitar posibles efectos negativos en el medio ambiente y en la salud humana debidos al vertido incontrolado de desechos. La 
recogida selectiva ayuda a su posterior reciclaje y fomenta la reutilización sostenible de los componentes de este equipo. Si es un particular, pónga-
se en contacto con el distribuidor donde adquirió este producto, o con el ayuntamiento, para informarse sobre el reciclaje adecuado de este equipo. 
Si es una empresa, póngase en contacto con su proveedor para informarse sobre los términos y condiciones de su contrato de compra-venta. Este 
producto no debe mezclarse con otros residuos industriales.

CONFORMIDAD CE
Adam Hall GmbH declara por la presente que este producto es conforme con las siguientes directivas (según sea aplicable):
R&TTE (1999/5/CE) o RED (2014/53/UE) a partir de junio de 2017
Directiva de baja tensión (2014/35/UE)
Directiva EMC (2014/30/UE)
RoHS (2011/65/UE)
Puede consultar la declaración de conformidad completa en www.adamhall.com. 
También puede solicitarla a info@adamhall.com.

DECLARACIÓN CE DE CONFORMIDAD
Adam Hall GmbH declara por la presente que este tipo de equipo de radio cumple con la Directiva 2014/53/UE.
El texto completo de la declaración de conformidad de la UE está disponible en la siguiente dirección
Dirección de Internet disponible: www.adamhall.com/compliance/

¡Los errores de imprenta y los errores, así como los cambios técnicos o de otro tipo están reservados! 
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POLSKI

GRATULUJEMY DOSKONAŁEGO WYBORU!
Nasz produkt został zaprojektowany z myślą o wieloletnim funkcjonowaniu. Marka LD Systems ręczy za to swoim dobrym imieniem i wieloletnim 
doświadczeniem jako producent sprzętu audio najwyższej jakości. Zapoznaj się z niniejszą instrukcją obsługi, aby jak najszybciej zacząć korzystać ze 
swojego sprzętu LD Systems.
Więcej informacji na temat LD-SYSTEMS znajdziesz na naszej stronie internetowej WWW.LD-SYSTEMS.COM

INFORMACJE DOTYCZĄCE BEZPIECZEŃSTWA
1.	 Uważnie przeczytaj instrukcję obsługi. 
2.	 Przechowuj informacje i instrukcje w bezpiecznym miejscu. 
3.	 Postępuj zgodnie z instrukcją. 
4.	 Przestrzegaj wszystkich ostrzeżeń dotyczących bezpieczeństwa. Nigdy nie usuwaj ostrzeżeń dotyczących bezpieczeństwa czy innych informacji 

umieszczonych na urządzeniu. 
5.	 Używaj sprzętu we właściwy sposób zgodnie z jego przeznaczeniem. 
6.	 Używaj wyłącznie stabilnych i odpowiednio dobranych stojaków i/lub uchwytów (w przypadku instalacji sprzętu na stałe). Upewnij się, że 

uchwyty ścienne zostały poprawnie zamontowane i zabezpieczone. Upewnij się, że urządzenie zostało zainstalowane w sposób bezpieczny i nie 
może spaść. 

7.	 W trakcie instalacji stosuj się do krajowych zasad bezpieczeństwa. 
8.	 Nigdy nie ustawiaj sprzętu w pobliżu kaloryferów, grzałek, piekarników lub innych źródeł ciepła. Upewnij się, że urządzenie zostało ustawione 

w sposób zapewniający możliwość chłodzenia i nie może się przegrzać. 
9.	 Nigdy nie ustawiaj na urządzeniu żadnych źródeł ognia, takich jak płonące świeczki. 
10.	 Nie zakrywaj otworów wentylacyjnych.
11.	 Nie używaj sprzętu w bezpośredniej bliskości wody. (Ta uwaga nie dotyczy sprzętu do używania na zewnątrz – w tym przypadku zapoznaj 

się ze specjalną instrukcją zamieszczoną poniżej). Nie wystawiaj sprzętu na działanie łatwopalnych materiałów, cieczy lub gazów. Unikaj 
bezpośredniego oddziaływania promieni słonecznych.

12.	 Upewnij się, że do sprzętu nie może przedostać się kapiąca lub rozpryskana woda. Nie stawiaj na urządzeniu pojemników z płynami, takich jak 
wazony czy szklanki. 

13.	 Upewnij się, że na urządzenie nie spadnie żaden przedmiot. 
14.	 Używaj sprzętu wyłącznie z akcesoriami przewidzianymi i zalecanymi przez producenta. 
15.	 Nie otwieraj ani nie modyfikuj urządzenia. 
16.	 Po podłączeniu sprzętu sprawdź, czy kable są uporządkowane tak, aby uniknąć szkód lub wypadków spowodowanych np. potknięciem. 
17.	 Podczas przenoszenia sprzętu upewnij się, że urządzenie nie może upaść powodując straty materialne lub obrażenia osób.
18.	 Jeśli urządzenie nie działa poprawnie, dostał się do niego jakiś płyn lub przedmiot czy też zostało uszkodzone w inny sposób, natychmiast 

je zatrzymaj i wyjmij wtyczkę z gniazdka sieciowego (jeśli jest to urządzenie zasilane). Naprawy może się podjąć jedynie osoba uprawniona 
i wykwalifikowana. 

19.	 Urządzenie należy czyścić suchą ściereczką. 
20.	Przestrzegaj krajowych przepisów dotyczących gospodarowania odpadami. Przed wyrzuceniem opakowania po urządzeniu posegreguj jego 

elementy na plastik i papier/karton. 
21.	 Plastikowe torby należy przechowywać poza zasięgiem dzieci.
22.	Należy pamiętać, że zmiany lub modyfikacje wprowadzone w urządzeniu bez wyraźnej zgody podmiotu odpowiedzialnego za zgodność, mogą 

spowodować utratę przez użytkownika prawa do eksploatacji urządzenia.

DOTYCZY URZĄDZEŃ Z ZASILANIEM SIECIOWYM
23.	UWAGA! Jeśli kabel zasilający urządzenia ma wtyczkę z uziemieniem, należy ją podłączyć do gniazdka z bolcem uziemiającym. Nie usuwaj 

uziemienia z kabla. 
24.	 Jeśli urządzenie było narażone na znaczne zmiany temperatury (np. w transporcie), nie włączaj go od razu. Wilgoć lub skroplona para mogą 

spowodować uszkodzenia. Zanim włączysz urządzenie poczekaj, aż osiągnie temperaturę pokojową. 
25.	Przed podłączeniem urządzenia do gniazda elektrycznego sprawdź, czy napięcie i częstotliwość sieciowe odpowiadają danym technicznym 

urządzenia. Jeśli urządzenie jest wyposażone w przełącznik wyboru napięcia, podłącz je do gniazda zasilania tylko wtedy, gdy wartości 
parametrów urządzenia i zasilania sieciowego są zgodne. Jeśli kabel zasilający lub adapter nie pasują do gniazda, skontaktuj się z elektrykiem. 

26.	Nie depcz kabla zasilającego. Upewnij się, że kabel nie został załamany, zwłaszcza przy złączu między zasilaniem sieciowym czy adapterem, 
a urządzeniem. 

27.	 Przy podłączaniu urządzenia trzeba zadbać o to, aby kabel zasilający lub adapter były łatwo dostępne. Jeśli nie korzystasz z urządzenia lub gdy 
chcesz je wyczyścić, odłącz je od zasilania. Przy wyjmowaniu kabla i adaptera z gniazdka elektrycznego, złap i pociągnij za wtyczkę, a nie za kabel. 
Nie dotykaj kabla ani adaptera mokrymi rękami. 

28.	W miarę możliwości unikaj szybkiego włączania i wyłączania urządzenia, ponieważ może to skrócić żywotność urządzenia.
29.	WAŻNE INFORMACJE: W razie konieczności wymiany bezpieczników użyj bezpieczników tego samego typu o identycznej wartości znamionowej. 

Jeśli wyłączanie bezpiecznika się powtarza, skontaktuj się z autoryzowanym centrum serwisowym. 
30.	Aby całkowicie odłączyć urządzenie od zasilania sieciowego, wyciągnij kabel zasilający lub adapter z gniazdka elektrycznego. 
31.	 Jeśli urządzenie jest wyposażone w kabel zasilający Volex, to przed jego wyjęciem należy odblokować odpowiednie złącze urządzenia Volex. 

Oznacza to, że podczas wyciągania kabla urządzenie może się ześlizgnąć i upaść, powodując obrażenia i/lub inne szkody. Dlatego przy 
podłączaniu kabli należy zachować ostrożność. 

32.	 Jeśli istnieje ryzyko uderzenia pioruna lub w razie planowanej długiej przerwy w użytkowaniu urządzenia, należy odłączyć kabel zasilający 
i adapter od gniazda elektrycznego.
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WŁAŚCIWOŚCI
•	 Procesor DSP o architekturze hybrydowej 
•	 Szablony DSP dostępne dla różnych wymogów instalacyjnych
•	 40-bitowy procesor DSP z obsługą liczb zmiennopozycyjnych z dwurdzeniowym Analog Devices SHARC+ i procesorem ARM Cortex A5
•	 System operacyjny Linux nowej generacji
•	 Wysokiej klasy przedwzmacniacze mikrofonowe i wysokowydajne 32-bitowe przetworniki AD/DA
•	 12 zbalansowanych wejść mikrofon/linia z wyborem zasilania pochodnego 48 V na wejście
•	 8 zbalansowanych wyjść
•	 Porty logiczne 8 GPI i 8 GPO
•	 6-stykowe złącza łączówki (R=3,81 mm) do wszystkich wejść/wyjść audio i kontrolnych
•	 Zdalna magistrala do integracji z panelami ściennymi i mikrofonami przywołującymi LD Systems
•	 Przejrzysty i intuicyjny design panelu przedniego
•	 Interfejs Ethernet do zdalnego sterowania za pomocą uniwersalnego oprogramowania sterującego Xilica Designer
•	 Aplikacje do zdalnego sterowania dostępne zarówno w systemie iOS, jak i Android, dla niestandardowych paneli użytkownika
•	 Zintegrowany harmonogram wydarzeń
•	 Opcjonalne rozszerzenie Dante 64×64 (łączność audio przez IP)
•	 Stojak 19-calowy, 1RU

ZAWARTOŚĆ ZESTAWU
•	 Urządzenie LD ZoneX
•	 Kabel zasilający
•	 Instrukcja obsługi

PODŁĄCZENIE, KONTROLKI I WYŚWIETLANE ELEMENTY
PRZÓD 

1  DIODY STATUSU OGÓLNEGO
POWER = urządzenie jest podłączone
NETWORK = nawiązano połączenie sieciowe
REMOTE = podłączono urządzenia zdalne LD Systems  
		  (mikrofony przywołujące, panele sterowania itd.)

2  DIODY WEJŚĆ/WYJŚĆ
Biała = sygnał obecny
Czerwona = sygnał przekierowany

2 1 2

33.	Z urządzenia nie powinny korzystać osoby (w tym dzieci) o ograniczonej sprawności fizycznej, sensorycznej lub umysłowej ani osoby bez 
doświadczenia i wiedzy.

34.	Dzieci nie mogą się bawić urządzeniem.
35.	Jeśli kabel zasilający uległ uszkodzeniu, nie korzystaj z urządzenia. Uszkodzony kabel zasilający należy zastąpić nowym dopasowanym kablem lub 

instalacją pochodzącą z autoryzowanego centrum serwisowego.

UWAGA:
Aby zmniejszyć ryzyko porażenia prądem, nie zdejmuj pokrywy ani tylnej obudowy urządzenia. W środku 
urządzenia nie ma żadnych elementów przydatnych dla użytkownika. Konserwacja urządzenia oraz 
naprawy powinny być przeprowadzane przez wykwalifikowany personel serwisujący.

Znak ostrzegawczy w postaci trójkąta z błyskawicą oznacza niezaizolowane napięcie elektryczne znajdujące się w danej części.  
Dotykanie tych części może doprowadzić do porażenia prądem.

Znak ostrzegawczy w postaci trójkąta z wykrzyknikiem oznacza ważne instrukcje dotyczące użytkowania lub konserwacji.

Uwaga! Ten symbol oznacza gorącą powierzchnię. Niektóre części obudowy mogą się nagrzewać w trakcie użytkowania.  
Po zakończeniu użytkowania, odczekaj 10 min zanim dotkniesz urządzenia lub zaczniesz je przenosić.

Uwaga! Urządzenie jest przeznaczone do użytkowania poniżej 2000 m n.p.m.

Uwaga! Produkt nie nadaje się do użytku w klimacie tropikalnym.

UWAGA! WYSOKIE NATĘŻENIE DŹWIĘKU W URZĄDZENIACH AUDIO!
Urządzenie zostało zaprojektowane do użytku profesjonalnego. W związku z tym komercyjne wykorzystanie urządzenia podlega odpowiednim 
krajowym przepisom i regulacjom dotyczącym zapobiegania wypadkom. Firma Adam Hall jako producent jest zobowiązana do poinformowania 
o istniejącym potencjalnym zagrożeniu dla zdrowia. Niebezpieczeństwo uszkodzenia słuchu z powodu długotrwałego wystawienia na wysokie 
natężenie dźwięku: Urządzenie w trakcie działania może wytwarzać wysokie ciśnienie akustyczne (SPL), które może powodować nieodwracalne 
uszkodzenia słuchu u artystów, pracowników lub słuchaczy. Dlatego też należy unikać przedłużonej ekspozycji na dźwięki przekraczające 90 dB.

UWAGA! Sprzęt ten został przetestowany i uznany za zgodny z wartościami granicznymi dla urządzeń cyfrowych klasy B, zgodnie z częścią 15 
przepisów FCC. Ograniczenia te mają na celu zapewnienie odpowiedniej ochrony przed szkodliwym wpływem w użytku domowym. Urządzenie to 
wytwarza, wykorzystuje i może emitować energię częstotliwości radiowych. Jeśli nie zostało poprawnie zainstalowane lub nie jest użytkowane 
zgodnie z instrukcjami, może powodować szkodliwe zakłócenia sygnałów radiowych. Nie można jednak zagwarantować, że w przypadku konkretnej 
instalacji zakłócenia nie wystąpią. Jeśli urządzenie powoduje zakłócenia w odbiorze sygnału radiowego lub telewizyjnego, co można sprawdzić 
włączając i wyłączając urządzenie, użytkownik powinien spróbować usunąć zakłócenia w jeden z poniższych sposobów:
– Odwrócić lub przesunąć antenę odbierającą sygnał.
– Zwiększyć odległość pomiędzy urządzeniem a odbiornikiem.
– Podłączyć urządzenie do gniazda podpiętego pod inny obwód elektryczny niż ten, do którego podłączono odbiornik.
– Skonsultować się ze sprzedawcą lub doświadczonym technikiem zajmującym się sprzętem RTV.
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WŁAŚCIWOŚCI
•	 Procesor DSP o architekturze hybrydowej 
•	 Szablony DSP dostępne dla różnych wymogów instalacyjnych
•	 40-bitowy procesor DSP z obsługą liczb zmiennopozycyjnych z dwurdzeniowym Analog Devices SHARC+ i procesorem ARM Cortex A5
•	 System operacyjny Linux nowej generacji
•	 Wysokiej klasy przedwzmacniacze mikrofonowe i wysokowydajne 32-bitowe przetworniki AD/DA
•	 12 zbalansowanych wejść mikrofon/linia z wyborem zasilania pochodnego 48 V na wejście
•	 8 zbalansowanych wyjść
•	 Porty logiczne 8 GPI i 8 GPO
•	 6-stykowe złącza łączówki (R=3,81 mm) do wszystkich wejść/wyjść audio i kontrolnych
•	 Zdalna magistrala do integracji z panelami ściennymi i mikrofonami przywołującymi LD Systems
•	 Przejrzysty i intuicyjny design panelu przedniego
•	 Interfejs Ethernet do zdalnego sterowania za pomocą uniwersalnego oprogramowania sterującego Xilica Designer
•	 Aplikacje do zdalnego sterowania dostępne zarówno w systemie iOS, jak i Android, dla niestandardowych paneli użytkownika
•	 Zintegrowany harmonogram wydarzeń
•	 Opcjonalne rozszerzenie Dante 64×64 (łączność audio przez IP)
•	 Stojak 19-calowy, 1RU

ZAWARTOŚĆ ZESTAWU
•	 Urządzenie LD ZoneX
•	 Kabel zasilający
•	 Instrukcja obsługi

PODŁĄCZENIE, KONTROLKI I WYŚWIETLANE ELEMENTY
PRZÓD 

1  DIODY STATUSU OGÓLNEGO
POWER = urządzenie jest podłączone
NETWORK = nawiązano połączenie sieciowe
REMOTE = podłączono urządzenia zdalne LD Systems  
		  (mikrofony przywołujące, panele sterowania itd.)

2  DIODY WEJŚĆ/WYJŚĆ
Biała = sygnał obecny
Czerwona = sygnał przekierowany

2 1 2
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TYŁ

3  ZŁĄCZE ZASILANIA I UCHWYT NA BEZPIECZNIK
Złącze zasilania IEC i uchwyt bezpiecznika. Zestaw zawiera odpowiedni kabel zasilania.
UWAGA: Wymieniając bezpieczniki, użyj bezpieczników tego samego typu o identycznej wartości znamionowej. Zapoznaj się z informacją na 
obudowie. Jeśli bezpieczniki wyłączają się wielokrotnie, skontaktuj się z autoryzowanym centrum serwisowym. 

4  GŁÓWNY WŁĄCZNIK
Przełącznik dwupozycyjny służący do włączania i wyłączania urządzenia.

5  ETHERNET – USB – RESET
Karta rozszerzenia komunikacyjnego ze złączem Ethernet lub Ethernet + Dante (64 × 64 I/O) na modelu „D”, do komunikacji między procesorem 
ZoneX i komputerem hostem, port odzyskiwania Micro USB do odzyskania danych oprogramowania wewnętrznego i przycisk resetujący IP.

6  STEROWANIE ZDALNE
Magistrala zdalna LD System do integracji z przyszłymi panelami sterowania i mikrofonami przywołującymi LD Systems. Uwaga! To złącze służy 
wyłącznie do podłączenia urządzeń kompatybilnych ze zdalną magistralą LD Systems, a nie portów Ethernet!

7  GPO
8 wyjść GPO (porty logiczne) z dwoma trybami do wyboru dla każdego wyjścia: tryb LED (3 mA) lub połączenie do masy (300 mA). 3-stykowe złącza 
łączówki (R=3,81 mm). Zapoznaj się również z przykładowymi podłączeniami w instrukcji obsługi (patrz: GPI/O – WEJŚCIA/WYJŚCIA OGÓLNEGO 
PRZEZNACZENIA – PRZYKŁADOWE PODŁĄCZENIA)

8  GPI
8 wejść GPI (porty logiczne) ze sterowaniem masą. 3-stykowe złącza łączówki (R=3,81 mm). Zapoznaj się również z przykładowymi podłączeniami 
w instrukcji obsługi (patrz: GPI/O – WEJŚCIA/WYJŚCIA OGÓLNEGO PRZEZNACZENIA – PRZYKŁADOWE PODŁĄCZENIA)

9  WYJŚCIA
8 zbalansowanych wyjść audio. 3-stykowe złącza łączówki (R=3,81 mm).

10  WEJŚCIA
12 zbalansowanych wejść audio mikrofon/linia z wyborem zasilania pochodnego 48 V na kanał. 3-stykowe złącza łączówki (R=3,81 mm).

PODŁĄCZANIE URZĄDZEŃ
Procesor DSP ZoneX LD Systems i inne jednostki sterujące działają w oparciu o infrastrukturę sieciową i są konfigurowane i sterowane za pomocą 
komputera z oprogramowaniem Xilica Designer.

WARUNKI WSTĘPNE FUNKCJONOWANIA
•	 Komputer
•	 Interfejs sieciowy (router, przełącznik PoE) 

Router jest wymagany do przypisania adresu IP oraz szybkiego i łatwego połączenia z komputerem i podłączonymi urządzeniami sterującymi. 
Przełącznik PoE jest potrzebny w przypadku urządzeń sterujących niewyposażonych w lokalny zasilacz.

•	 Kabel Ethernet. We wszystkich połączeniach przewodowych należy używać standardowego kabla Ethernet RJ45 (Cat 5e lub lepszego).

4

6

3

7 8 9 10

5

Don‘t connect to any 
ethernet switch port!

This port is only for LD 
Systems remote bus 
compatible devices.
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POŁĄCZENIE SIECIOWE MIĘDZY KOMPUTEREM HOSTEM A PROCESOREM ZONEX MOŻNA NAWIĄZAĆ W NASTĘPUJĄCY SPOSÓB:

A. ROUTER Z AKTYWOWANYM SERWEREM DHCP (ZALECANE)
W przypadku korzystania z routera z włączonym serwerem DHCP procesor ZoneX automatycznie pobiera adres IP w czasie uruchamiania, gdy tylko 
zostanie nawiązane połączenie. Zaleca się korzystanie z routera i przełącznika PoE, jeśli do sieci podłączone są kolejne urządzenia sterujące/
kontrolery innych producentów. Taka kombinacja daje serwer DHCP oraz ułatwia zasilanie prądem podłączonych urządzeń. Zalecamy korzystanie 
z routerów Linksys oraz z przełączników Netgear.

Uwaga! Routery/przełączniki z aktywnym serwerem DHCP powinny być włączane w pierwszej kolejności. Wszystkie kable Ethernet powinny zostać 
podłączone do sprzętu zanim urządzenia zostaną włączone. Pozwoli to prawidłowo przypisać adres IP.

•	 Najpierw włącz router/przełącznik.
•	 Następnie podłącz komputer host do routera wyposażonego w DHCP przy użyciu kabla Ethernet.
•	 Podłącz router do procesora ZoneX za pomocą kabla Ethernet.
•	 Podłącz procesor ZoneX do zasilania sieciowego i włącz.

B. POŁĄCZENIE BEZPOŚREDNIE NIEOPARTE NA DHCP LUB POŚREDNIE POŁĄCZENIE PRZY UŻYCIU PRZEŁĄCZNIKA ETHERNET.
Jeśli procesor jest podłączony bezpośrednio do komputera lub pośrednio przy użyciu przełącznika a serwer DHCP jest niedostępny, połączenie nie 
zostanie nawiązane automatycznie.
Dlatego połączenia nieoparte na DHCP muszą zostać skonfigurowane ręcznie. Dodatkowe informacje na ten temat można znaleźć w pliku pomocy 
Xilica Designer lub w najczęściej zadawanych pytaniach LD Systems ZoneX.
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OPROGRAMOWANIE XILICA DESIGNER
Oprogramowanie Xilica Designer nie tylko umożliwia szczegółową konfigurację procesora ZoneX, lecz także pomaga skonfigurować zdalne 
urządzenia sterujące innych producentów, ułatwia zarządzanie opcjonalnymi urządzeniami sieciowymi Dante oraz zapewnia uniwersalny system 
integrowania urządzeń sterujących innych producentów.

INSTALACJA MAC OS X
Wymagania systemowe:
•	 Mac OS X 10.8 lub nowszy
•	 procesor 1 GHz lub lepszy
•	 500 MB wolnej przestrzeni dyskowej
•	 karta graficzna 1 GB
•	 4 GB RAM

1. Pobierz najnowszą wersję oprogramowania Xilica Designer ze strony internetowej LD Systems (www.ld-systems.com).
2. Otwórz pobrany plik .zip.
3. Następnie otwórz plik XilicaDesigner.mpkg.
4. Otworzy się okno instalacyjne. Przejdź kolejne kroki instalacji.

5. Jeśli proces instalacji przebiegnie pomyślnie, okno instalacyjne wyświetli następujący komunikat: „The installation was successful”.

7. Oprogramowanie Xilica Designer zostało zainstalowane.
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INSTALACJA WINDOWS
Wymagania systemowe:
•	 Windows 7 lub nowszy
•	 procesor 1 GHz lub lepszy
•	 500 MB wolnej przestrzeni dyskowej
•	 karta graficzna 1 GB
•	 4 GB RAM

1. Pobierz najnowszą wersję oprogramowania Xilica Designer ze strony internetowej LD Systems (www.ld-systems.com).
2. Otwórz pobrany plik .zip.
3. Następnie otwórz plik XilicaDesigner.exe.
4. Otworzy się okno instalacyjne. Kliknij „Install”, aby kontynuować.

5. Poczekaj, aż instalacja dobiegnie końca. Może to potrwać kilka minut.
6. Jeśli instalacja przebiegnie pomyślnie, Windows poprosi o pozwolenie na dostęp do zapory firewall. Zalecamy takie ustawienie systemu, aby 

komunikacja Xilica Designer była możliwa w sieciach prywatnych, tzn. w domu lub miejscu pracy. Zezwolenie na dostęp w sieciach publicznych 
jest możliwe, jeśli istnieje taka potrzeba. 

Zaznacz pożądane opcje w panelu sterowania, a następnie kliknij „Allow Access”, aby zakończyć konfigurację.

7. Oprogramowanie Xilica Designer zostało zainstalowane.
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URUCHAMIANIE OPROGRAMOWANIA
Znajdź program Xilica Designer na pulpicie lub w folderze aplikacji. Kliknij dwukrotnie ikonę programu, aby go uruchomić.
Możesz teraz stworzyć nowy projekt designu lub otworzyć istniejący albo otworzyć widok sieciowy lub widok Dante.

WIDOK SIECIOWY
Widok sieciowy wyświetla wszystkie procesory i urządzenia sterujące w danej sieci. Możesz tu znaleźć informacje dotyczące urządzenia, takie jak 
status połączenia, adres IP komputera, adres IP urządzenia, adres Mac, nazwę urządzenia, producenta oraz wersję oprogramowania lokalnego.

W widoku sieciowym powinny być widoczne podłączone procesory. W każdym bloku urządzeń w górnym lewym rogu znajduje się wskaźnik statusu 
połączenia.

Zielony: Urządzenie jest podłączone i gotowe do działania.

Żółty: Urządzenie jest podłączone i online, ale nie jest gotowe do działania. Przesuń kursor na wskaźnik sieci, aby wyświetlić okno z komunikatem 
o wykrytym problemie. (Komunikat zazwyczaj informuje, że nie pobrano żadnego designu urządzenia).

Czerwony:  Urządzenie nie jest podłączone i jest offline. Brak komunikacji między programem Xilica Designer a urządzeniem. Sprawdź wszystkie 
kable i połączenia, a następnie upewnij się, że urządzenie jest włączone. Jeśli procesor przeprowadza aktualizację oprogramowania układowego lub 
ponownie się uruchamia, może nastąpić chwilowa przerwa w łączności. 

Od czasu do czasu może się wyświetlić wykrzyknik (!). To oznacza, że dostępna jest nowsza wersja oprogramowania układowego. Nie wymaga to 
podjęcia natychmiastowego działania, jednak projekt nie zawiera aktualnych modeli, ponieważ wcześniejsza wersja oprogramowania układowego 
nie jest obsługiwana. Dodatkowe informacje na ten temat można znaleźć w pliku pomocy Xilica Designer lub w najczęściej zadawanych pytaniach 
LD Systems ZoneX.
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AKTUALIZACJA OPROGRAMOWANIA UKŁADOWEGO
Pamiętaj, że korzystanie ze starej wersji programu przy nowym oprogramowaniu układowym lub korzystanie z nowej wersji programu przy starym 
oprogramowaniu układowym jest teoretycznie możliwe. Jednak zakres funkcji może być ograniczony i w niektórych przypadkach pewne opcje mogą 
działać w sposób nieoptymalny. 

Zalecamy korzystanie z najnowszej wersji zarówno programu, jak i oprogramowania układowego.

Zanim rozpoczniesz, sprawdź wersje programu i oprogramowania układowego.

Aby sprawdzić, z jakiej wersji oprogramowania układowego korzystasz, upewnij się, że urządzenie jest włączone i online. Widok sieciowy 
oznacza żółtym trójkątem z wykrzyknikiem urządzenia, dla których jest dostępna nowsza wersja oprogramowania układowego. Ponadto wersja 
oprogramowania układowego znajduje się w bloku urządzeń przy danym urządzeniu.

Aktualna wersja programu wyświetla się po kliknięciu przycisku Informacje w menu na górnym pasku.

PROCEDURA AKTUALIZACJI OPROGRAMOWANIA UKŁADOWEGO
Zapisz plik design urządzenia na komputerze, ponieważ wszystkie zaprogramowane dane zostaną usunięte podczas aktualizacji urządzenia.  
Po zakończeniu aktualizacji oprogramowania układowego można ponownie zainstalować plik design na urządzeniu.

•	 Aby przeprowadzić aktualizację oprogramowania układowego, urządzenie musi być online i gotowe do działania.

•	 Najnowszą wersję oprogramowania układowego dla danego modelu ZoneX można pobrać na stronie internetowej LD Systems  
(www.ld-systems.com).

•	 W bloku urządzeń prawym przyciskiem myszy kliknij widok sieciowy i wybierz „Firmware Upgrade”.

DE
UT

SC
H

EN
GL

ISH
FR

AN
ÇA

IS
ES

PA
ÑO

L
PO

LS
KI

ITA
LIA

NO



112

Pojawi się komunikat ostrzegawczy informujący o usunięciu wszystkich danych z urządzenia podczas procesu aktualizacji. Aby kontynuować, kliknij „OK”.

Następnie pojawi się rozwijane menu, w którym należy wybrać odpowiedni plik oprogramowania układowego z systemu plików lub odpowiednią 
wersję oprogramowania układowego wcześniej pobraną przez „Device Firmware Manager” (w menu „Device Management”). Kliknij „OK” i znajdź 
folder, w którym zapisała się nowa wersja oprogramowania. Wybierz plik i kliknij „Open”.
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Stan aktualizacji wyświetli się w postaci paska postępu w oknie dialogowym urządzenia.

NIE WYŁĄCZAJ ANI NIE ODŁĄCZAJ URZĄDZENIA OD KOMPUTERA. W przypadku wyłączenia urządzenia lub odłączenia go od komputera w trakcie 
aktualizacji oprogramowania układowego procesor może ulec całkowitemu zniszczeniu. Wówczas należy przeprowadzić „odzyskiwanie 
oprogramowania układowego z USB” („USB Firmware Recovery”).

Kiedy plik oprogramowania układowego zostanie pobrane, urządzenie automatycznie uruchomi się ponownie i zaktualizuje dane wewnętrzne. Może 
to potrwać kilka minut. W tym czasie wskaźnik sieciowy pozostaje CZERWONY, a urządzenie jest offline.

Po zakończeniu aktualizacji oprogramowania układowego ponownie się pojawia zielony napis „ON”. 

UWAGA! Żółte pole z komunikatem „No Data” oznacza, że żaden design nie został załadowany do urządzenia.
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WIDOK PROJEKTU
Są dwa sposoby tworzenia nowego projektu:

AUTOKONFIGURACJA
Jeśli urządzenie wyświetla się na liście w widoku sieciowym, zaznacz je i kliknij Create New Project from Selected Device(s) w prawym górnym rogu. 
Nastąpi automatyczne przeniesienie do widoku projektu i można wybrać szablon designu.

PUSTY PROJEKT

Drugą możliwością jest utworzenie nowego projektu poprzez File > New Project.
Jeśli rozpoczniesz od pustego projektu, Xilica Designer zapyta, z której serii DSP chcesz skorzystać. ZoneX opiera się na serii Solaro DSP, powinieneś 
więc wybrać Solaro Series.

1. MENU „COMPONENT LIBRARY”
To menu wyświetla listę urządzeń i modułów designu, które możesz wykorzystać w swoim projekcie. Znajdź procesor ZoneX w LD Systems > 
Processors.

2. OBSZAR ROBOCZY
Obszar roboczy służy do tworzenia i konfiguracji urządzeń.

3. MENU „OBJECT PROPERTY”
 To menu pozwala skonfigurować właściwości obiektu dla danego designu.

1

2
3
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DESIGN
Dla przykładu wykorzystany zostanie tu tylko jeden blok urządzenia DSP, jednak design może zawierać kilka obiektów sprzętowych DSP.
Projekt designu może zostać utworzony offline (bez podłączonego sprzętu) i później załadowany na urządzenie.

1. Przeciągnij i upuść wybrany moduł DSP – w tym przypadku ZoneX1208 – z „Component Library” do obszaru pracy.

2. Pojawi się okno wyboru ze wszystkimi szablonami designu (Select Design Template). Wybierz jeden z dostępnych szablonów. Pojawi się krótki 
opis jego głównych właściwości. Wybierz szablon odpowiedni do swojego projektu i zatwierdź OK. 

Szczegółowe opisy różnych szablonów można znaleźć w najczęściej zadawanych pytaniach LD System ZoneX.

3. Procesor ZoneX zostanie odpowiednio skonfigurowany.
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4. Wybierz moduł ZoneX, aby go podświetlić. Możesz teraz dostosować właściwości urządzenia w menu „Object Property” po prawej stronie.
 Uwaga! Właściwości obiektu zależą od urządzenia i mogą różnić się w zależności od wybranego obiektu. 

5. Aby wyświetlić schematyczny podgląd designu, kliknij dwukrotnie moduł ZoneX. W tym przykładzie wybraliśmy szablon „Global Dante”. Rozmiar 
okna można zmienić, przeciągając kursorem jego róg.
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6. Wszystkie moduły DSP można przetwarzać offline. Aby otworzyć wybrany moduł, kliknij go dwukrotnie. Możesz następnie dostosować ustawienia 
modułu DSP do wymagań swojego projektu.

W tym przykładzie aktywowano zasilanie pochodne i dostosowano wartości wzmocnienia w dwóch pierwszych kanałach ustawień wejściowych.  
Dodatkowo zmieniliśmy nazwy pierwszych czterech kanałów w audio input modules i przetworzyliśmy kanał 1.

7. Teraz kliknij dwukrotnie main matrix mixer module, aby przekierować sygnały wejściowe do odpowiednich wyjść.  
Można je również przetworzyć poprzez output processing module.

DE
UT

SC
H

EN
GL

ISH
FR

AN
ÇA

IS
ES

PA
ÑO

L
PO

LS
KI

ITA
LIA

NO



118

8. Jeśli zmieniono ustawienia na offline, zapisz projekt w wybranej lokalizacji, klikając File > Save As. Jeśli wprowadzono modyfikacje do istniejącego 
pliku projektowe, zapisz, klikając File > Save. Ten sam efekt uzyskasz, klikając symbol „Save” w prawym górnym rogu obszaru pracy. 

Dobrym pomysłem jest robienie kopii zapasowych plików projektowych na dyskach zewnętrznych.
Rozszerzenie plików zapisanego projektu to .pjxml.

TRYB ONLINE
Jeśli wybierzesz tryb online, plik designu zostanie pobrany na podłączone urządzenie(-nia). Wtedy możesz wprowadzać zmiany w czasie rzeczywistym.
W takim przypadku, wszystkie urządzenia muszą być włączone i online (zielony wskaźnik „ON” w widoku sieciowym).

Aby przełączyć się na tryb online, moduł urządzenia musi być przypisany do fizycznego sprzętu.

1. Wybierz moduł urządzenia, które chcesz przypisać z widoku projektu.
2. Kliknij moduł urządzenia prawym przyciskiem myszy i wybierz Map to Physical Device.
3. Rozpoznane urządzenia wyświetlą się w postaci listy z adresami Mac. Jeśli kilka identycznych urządzeń zostało podłączonych do tej samej sieci, 

można je rozróżnić przez adresy Mac. Widok sieciowy wyświetla adresy Mac poszczególnych urządzeń.

Bardzo ważne jest, aby nazwa bloku urządzenia w pliku designu dokładnie odpowiadała urządzeniu w widoku sieciowym, w przeciwnym razie 
design nie zostanie załadowany na odpowiedni sprzęt.
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Kiedy wszystko zostanie przypisane, kolor modułu zmieni się na ciągły zielony, a adres Mac urządzenia wyświetli się pod modułem urządzenia.

4. Teraz kliknij Load Design to Device(s) u góry obszaru roboczego.
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5. Pojawi się okno, w którym możesz zaznaczyć urządzenia, do których chcesz załadować design. 
Potwierdź, klikając Ok.

Przełączenie się na tryb online może potrwać kilka minut. Nie przerywaj procesu! Postęp procesu jest widoczny w formie procentów na pasku 
postępu u góry okna.
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Kiedy tylko kolor obszaru pracy zmieni się na ciągły zielony, uruchamia się tryb online, a menu designu nie będzie już dostępne.

6. Jeśli chcesz zmieniać ustawienia w czasie rzeczywistym, możesz kliknąć dwukrotnie moduł DSP w widoku projektu lub w bloku urządzeń w widoku 
projektu. Wtedy zobaczysz schemat odpowiadającego urządzenia.

DE
UT

SC
H

EN
GL

ISH
FR

AN
ÇA

IS
ES

PA
ÑO

L
PO

LS
KI

ITA
LIA

NO



122

7. Aby zmienić ustawienia w czasie rzeczywistym, kliknij dwukrotnie wybrany moduł DSP lub blok I/O.

W każdej chwili możesz powrócić do trybu design, klikając przycisk Go Back to Design Mode u góry obszaru roboczego.
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Program zapyta, czy chcesz skopiować do projektu zmiany wprowadzone w trybie online.

Aby zapisać ustawienia wprowadzone do projektu w trybie online, potwierdź kliknięciem Yes.
Aby powrócić do poprzedniego pliku designu, kliknij No.

Po przeniesieniu ustawień z trybu online do projektu wybierz opcję File > Save, aby nadpisać zmiany na istniejącym pliku.  
Aby utworzyć i zapisać nowy plik projektu, wybierz File > Save As.

Dobrym pomysłem jest robienie kopii zapasowych plików projektowych na dyskach zewnętrznych.
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GPI/O – PRZYKŁADOWE PODŁĄCZENIA
8 WEJŚĆ LOGICZNYCH (WEJŚCIA BINARNE, GPI)

Sterowanie masą (G)

8 WYJŚĆ LOGICZNYCH (WYJŚCIA BINARNE, GPO)

dostępne 2 tryby wyjścia:
•	 LED (3 mA)
•	 Połączenie do masy (300 mA) 

Przykład podłączenia: 

•	 Każde GPI posiada dwa stany przełączenia (przez oprogramowanie) 
•	 Oznacza to, że można równolegle prowadzić dwa różne zestawy ustawień  
 Otwórz i zamknij kontakty
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DANE TECHNICZNE
Numer produktu LDZONEX1208 / D

Typ produktu Matryca audio DSP do instalacji na stałe

Dane ogólne

Wejścia audio 12 zbalansowanych wejść mikrofon/linia + 1 wejście audio magistrali zdalnej

Wyjścia audio 8 zbalansowanych linii wyjściowych

Wejścia logiczne 8 GPI – sterowanie masą

Wyjścia logiczne 8 GPO – tryby: LED (3 mA) lub połączenie do masy (300 mA), na wybrane wyjście

Magistrala zdalna Tak

Złącza Wejście/wyjście: 3-stykowe złącza łączówki (R=3,81 mm);  
złącze serwisowe micro USB B, zdalne sterowanie IN RJ45, Ethernet RJ45
ZoneX1208D: Główne i zastępcze połączenie z Dante RJ45

Diody Przód: „POWER”, „NETWORK”, „REMOTE”, wejścia 1 – 12 i wyjścia 1 – 8: Biały sygnał LED, czerwony clip LED

Kontrolki panelu przedniego Nie

Kontrolki panelu tylnego Zasilanie sieciowe ON/OFF, „IP RESET”

Gniazda rozszerzenia do kart Ethernet (ZONEX1208) lub Ethernet + Dante (ZONEX1208D)

Chłodzenie Chłodzenie konwekcyjne pasywne

Zasilacz Szerokozakresowy zasilacz impulsowy SMPS

Złącze zasilacza 3-stykowe gniazdo zasilania (IEC)

Napięcie robocze 90 – 240 V AC; 50/60 Hz

Bezpiecznik sieciowy T2.5 A L / 250 V 

Prąd rozruchowy OFF-ON sieci 21 A  

Zużycie prądu, tryb czuwania 23 W

Maks. Zużycie prądu 60 W

Temperatura robocza 0°C ... +40°C (maks. 60% wilgoci względnej)

Szerokość Stojak 19" (483 mm)

Wysokość 1 HE (44,5 mm)

Głębokość 315 mm (ze złączami)

Waga 3,8 kg

Odległość od kolejnego 
urządzenia na stojaku (wysokość)

1 HE

Głębokość stojaka (wymagana) 350 mm

Specyfikacje techniczne

Nominalna czułość wejściowa –22 dBu (sinusoida, 1 kHz, maks. wzmocnienie)

Nominalne obcinanie sygnału 
wejściowego

+20 dBu (sinusoida, 1 kHz)

Zniekształcenia harmoniczne 
(THD+N)

<0,003% (Linia IN – OUT, sygnał +13 dBu, 20 Hz – 20 kHz, wzmocnienie 0 dB)

Zniekształcenia intermodulacyjne 
(IMD), SMPTE:

<0,01% (–10 dB w przesterowaniu), analizator przepustowości 90 kHz

Reakcja na częstotliwość 15 Hz – 22 kHz (+/–0,15 dB)

Impedancja wejściowa Linia: 4 kOhm (zbalansowane)
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Numer produktu LDZONEX1208 / D

Stosunek sygnału do szumu >117 dB @ +20 dBu, wzmocnienie 0 dB, przepustowość 20 kHz, skorygowanie krzywą korekcyjną A 

Zakres dynamiki (AES17) 112 dB

Przesłuchy między kanałami 120 dB @ 100 Hz, 120 dB @ 1 kHz, 105 dB @ 10 kHz

Tłumienia zakłóceń wspólnych, 
współczynnik CMRR

>60 dB (1 kHz)

Maks. Wzmocnienie 42 dB

Specyfikacje cyfrowe

DSP 40-bitowy procesor z obsługą liczb zmiennopozycyjnych z dwurdzeniowym Analog Devices SHARC+

Opóźnienie systemu 4,3 ms

Rozdzielczość przetwornika 
AD/DA

32 Bit 

Częstotliwość próbkowania 
przetwornika AD/DA

48 kHz

Specyfikacje magistrali zdalnej mierzone między REM In i REM Out

Nominalna czułość wejściowa 20 dBu

Nominalne obcinanie sygnału 
wejściowego

20 dBu

Zniekształcenia harmoniczne 
(THD+N)

<0,006% (+18 dBu, 20 Hz – 20 kHz)

Reakcja na częstotliwość 20 Hz – 20 kHz (0,1 dB)

Impedancja wejściowa  50 kOhm (zbalansowane)

Stosunek sygnału do szumu >105 dB (+20 dBu, przepustowość 20 kHz, skorygowanie krzywą korekcyjną A) 

Tłumienia zakłóceń wspólnych, 
współczynnik CMRR

>65 dB @ 1 kHz

Wzmocnienie 0 dB

Zasilanie pochodne +48 V DC / 500 mA

Zabezpieczenia Bezpiecznik z możliwością zresetowania (wewnętrzny)

DEUTSCH
ENGLISH

FRANÇAIS
ESPAÑOL

POLSKI
ITALIANO



127

OŚWIADCZENIA PRODUCENTA
GWARANCJA PRODUCENTA I OGRANICZENIE ODPOWIEDZIALNOŚCI 
Nasze aktualne warunki gwarancji i informacje dotyczące ograniczenia odpowiedzialności znajdą Państwo na stronie: https://cdn-shop.adamhall.
com/media/pdf/MANUFACTURERS-DECLARATIONS_LD_SYSTEMS.pdf. W razie konieczności skorzystania z serwisu proszę skontaktować się z firmą Adam 
Hall GmbH, Adam-Hall-Str. 1, 61267 Neu Anspach / e-mail Info@adamhall.com / +49 (0)6081 / 9419-0.

PRAWIDŁOWA UTYLIZACJA NINIEJSZEGO PRODUKTU 
(Obowiązuje w Unii Europejskiej i innych krajach europejskich stosujących system sortowania odpadów) Niniejszy symbol na produkcie lub 
związanych z nim dokumentach wskazuje, iż urządzenie po zakończeniu okresu użytkowania nie może być utylizowane razem ze standar-

dowymi odpadami domowymi, aby uniknąć szkód w środowisku lub szkód na osobie powstałych w wyniku niekontrolowanego usuwania odpadów. 
Niniejszy produkt należy utylizować oddzielnie od innych odpadów i przekazać do punktu recyklingu w celu ponownego wykorzystania użytych w 
nim materiałów w ramach idei zrównoważonego rozwoju. Klienci prywatni otrzymują informacje w zakresie przyjaznych dla środowiska możliwości 
usuwania odpadów od sprzedawcy, u którego produkt został zakupiony, lub w odpowiednich placówkach regionalnych. Użytkownicy będący przed-
siębiorcami proszeni są o kontakt ze swoimi dostawcami i ewentualne sprawdzenie uzgodnionych umownie warunków utylizacji urządzeń. Niniejszy 
produkt nie może być utylizowany razem z innymi odpadami przemysłowymi.

DEKLARACJA ZGODNOŚCI CE
Firma Adam Hall GmbH niniejszym oświadcza, że produkt ten jest zgodny z następującymi dyrektywami (o ile mają zastosowanie):
dyrektywa w sprawie urządzeń radiowych i końcowych urządzeń telekomunikacyjnych (1999/5/WE) lub dyrektywa w sprawie urządzeń radiowych 
(2014/53/UE) od czerwca 2017 r.
dyrektywa niskonapięciowa (2014/35/UE)
dyrektywa w sprawie kompatybilności elektromagnetycznej (2014/30/UE)
dyrektywa w sprawie ograniczenia stosowania niektórych niebezpiecznych substancji w sprzęcie elektrycznym i elektronicznym (2011/65/UE)
Pełna wersja deklaracji zgodności znajduje się na stronie internetowej www.adamhall.com. 
Ponadto zapytania w tej sprawie można przesyłać na adres e-mail info@adamhall.com.

DEKLARACJA ZGODNOŚCI WE
Adam Hall GmbH niniejszym oświadcza, że ten typ sprzętu radiowego jest zgodny z dyrektywą 2014/53/UE.
Pełny tekst deklaracji zgodności UE jest dostępny pod następującym adresem
Dostępny adres internetowy: www.adamhall.com/compliance/

Błędy w druku i błędy, jak również zmiany techniczne i inne zmiany są zastrzeżone!
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ITALIANO

HAI FATTO LA SCELTA GIUSTA!
Abbiamo sviluppato questo prodotto perché funzioni in modo affidabile per molti anni. Questo è l'impegno di LD Systems, con il suo nome e tanti 
anni di esperienza come produttore di soluzioni audio di alta qualità. Leggi attentamente il Manuale utente per iniziare sin da subito a sfruttare al 
meglio il tuo prodotto LD Systems.
Puoi trovare maggiori informazioni su LD-SYSTEMS sul nostro sito Web: WWW.LD-SYSTEMS.COM

INFORMAZIONI SULLA SICUREZZA
1.	 Leggere attentamente le presenti istruzioni. 
2.	 Conservare tutte le informazioni e le istruzioni in un luogo sicuro. 
3.	 Seguire le istruzioni. 
4.	 Osservare tutte le avvertenze di sicurezza. Non rimuovere mai le avvertenze di sicurezza o altre informazioni dall'apparecchio. 
5.	 Utilizzare l'apparecchio esclusivamente nel modo e per lo scopo previsti. 
6.	 Utilizzare solo cavalletti e/o supporti sufficientemente stabili e compatibili (per installazioni fisse). Assicurarsi che i supporti a parete siano 

installati e fissati correttamente. Assicurarsi che l'apparecchio sia installato in modo sicuro, senza rischi di caduta. 
7.	 Durante l'installazione, osservare i regolamenti in materia di sicurezza applicabili per il proprio paese. 
8.	 Non installare né utilizzare mai l'apparecchio vicino a radiatori, termoregolatori, forni o altre fonti di calore. Assicurarsi che l'apparecchio sia 

sempre installato in modo da raffreddarsi sufficientemente e non surriscaldarsi. 
9.	 Non posizionare mai fonti di accensione, ad esempio candele accese, sull'apparecchio. 
10.	 Le fessure di ventilazione non devono essere ostruite.
11.	 Non utilizzare questo apparecchio nelle immediate vicinanze dell'acqua (non si applica ad apparecchi specifici per ambienti esterni; in questo 

caso, osservare le istruzioni specifiche indicate di seguito). Non esporre l'apparecchio a materiali, liquidi o gas infiammabili. Evitare l’esposizione 
diretta alla luce solare!

12.	 Assicurarsi che gocce o schizzi d’acqua non entrino nell'apparecchio. Non collocare contenitori con liquidi, come vasi o recipienti per bere, 
sull'apparecchio. 

13.	 Assicurarsi che non cadano oggetti nell'apparecchio. 
14.	 Utilizzare l'apparecchio esclusivamente con gli accessori raccomandati e previsti dal produttore. 
15.	 Non aprire né apportare modifiche all'apparecchio. 
16.	 Dopo aver collegato l'apparecchio, controllare tutti i cavi per evitare danni o incidenti, ad es. dovuti al rischio di inciampo. 
17.	 Durante il trasporto, assicurarsi che l'apparecchio non cada causando potenziali danni alla proprietà o lesioni personali.
18.	 Se l'apparecchio non funziona più correttamente, se fluidi o oggetti sono entrati all'interno dell'apparecchio o se è stato danneggiato in altro 

modo, spegnerlo immediatamente e scollegarlo dalla presa di corrente (se si tratta di un dispositivo alimentato). L'apparecchio può essere 
riparato esclusivamente da personale qualificato autorizzato. 

19.	 Pulire l'apparecchio con un panno asciutto. 
20.	Rispettare tutte le leggi in materia di smaltimento applicabili nel proprio paese. Durante lo smaltimento dell'imballaggio, separare la plastica e 

la carta/il cartone. 
21.	 I sacchetti di plastica devono essere tenuti fuori dalla portata dei bambini.
22.	Cambiamenti o modifiche non espressamente approvati dalla parte responsabile della conformità potrebbero invalidare l'autorità dell'utente a 

utilizzare l'apparecchio.

PER GLI APPARECCHI CHE SI COLLEGANO ALLA RETE ELETTRICA
23.	ATTENZIONE: se il cavo di alimentazione del dispositivo è dotato di un contatto di messa a terra, deve essere collegato a una presa con messa a 

terra di protezione. Non disattivare mai la messa a terra di protezione di un cavo di alimentazione. 
24.	Se l'apparecchio è stato esposto a forti sbalzi di temperatura (ad esempio, dopo il trasporto), non accenderlo immediatamente. L'umidità e la 

condensa potrebbero danneggiare l'apparecchio. Non accendere il dispositivo finché non ha raggiunto la temperatura ambiente. 
25.	Prima di collegare l'apparecchio alla presa di corrente, verificare innanzitutto che la tensione e la frequenza della rete elettrica corrispondano 

ai valori specificati sull'apparecchio. Se l'apparecchio dispone di un interruttore di selezione della tensione, collegare l'apparecchio alla presa di 
corrente solo se i valori dell'apparecchio e i valori di alimentazione della rete elettrica corrispondono. Se il cavo o l'adattatore di alimentazione 
in dotazione non si adattano alla presa a muro, contattare l'elettricista. 

26.	Non calpestare il cavo di alimentazione. Assicurarsi che il cavo di alimentazione non si attorcigli, soprattutto sulla presa di rete e/o 
sull'adattatore di alimentazione e sul connettore dell'apparecchio. 

27.	 Quando si collega l'apparecchio, assicurarsi che il cavo o l'adattatore di alimentazione siano sempre liberamente accessibili. Scollegare sempre 
l'apparecchio dall'alimentazione se non è in uso o se si desidera pulirlo. Scollegare sempre il cavo e l'adattatore di alimentazione dalla presa di 
corrente della spina o dell'adattatore, senza tirare il cavo. Non toccare mai il cavo di alimentazione e l'adattatore di alimentazione con le mani 
bagnate. 

28.	Ove possibile, evitare di accendere e spegnere l'apparecchio in rapida successione in quanto ciò può ridurre la vita utile dell'apparecchio.
29.	INFORMAZIONI IMPORTANTI: sostituire i fusibili solamente con fusibili dello stesso tipo e della stessa potenza. Se un fusibile si brucia 

ripetutamente, contattare un centro di assistenza autorizzato. 
30.	Per scollegare completamente l'apparecchio dalla rete elettrica, scollegare il cavo o l'adattatore di alimentazione dalla presa di corrente. 
31.	 Se il dispositivo è dotato di un connettore di alimentazione Volex, il connettore di accoppiamento Volex dell'apparecchio deve essere sbloccato 

prima di essere rimosso. Tuttavia, ciò significa anche che l'apparecchio può scivolare e cadere se il cavo di alimentazione viene tirato, il che può 
causare lesioni personali e/o altri danni. Per questo motivo, fare sempre attenzione quando durante la posa dei cavi. 

32.	Scollegare il cavo e l'adattatore di alimentazione dalla presa di corrente se esiste il rischio di fulmini o prima di periodi di inutilizzo prolungati.
33.	 L'apparecchio non deve essere utilizzato da persone (bambini compresi) con capacità fisiche, sensoriali o mentali ridotte o con mancanza di 
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esperienza e conoscenze in materia.
34.	Proibire a bambini di giocare con il dispositivo.
35.	Se il cavo di alimentazione del dispositivo è danneggiato, non utilizzare il dispositivo. Il cavo di alimentazione deve essere sostituito con un cavo 

o un gruppo adeguato da un centro di assistenza autorizzato.

ATTENZIONE:
per ridurre il rischio di scosse elettriche, non rimuovere il coperchio (o il retro). All'interno non 
sono presenti parti riparabili dall'utente. La manutenzione e le riparazioni devono essere eseguite 
esclusivamente da personale di assistenza qualificato.

Il triangolo di avvertenza con il simbolo di un fulmine indica una tensione pericolosa non isolata all'interno dell'unità, che può 
causare una scossa elettrica.

Il triangolo di avvertenza con punto esclamativo indica importanti istruzioni per l'uso e la manutenzione.

Attenzione! Questo simbolo indica una superficie calda. Alcune parti dell'alloggiamento possono scaldarsi durante il funzionamento. 
Dopo l'uso, attendere almeno 10 minuti per il raffreddamento prima di maneggiare o trasportare il dispositivo.

Attenzione! Questo dispositivo è stato progettato per essere utilizzato al di sotto dei 2.000 metri di altitudine.

Attenzione! Questo prodotto non è destinato all'uso nei climi tropicali.

ATTENZIONE! VOLUMI ELEVATI NEI PRODOTTI AUDIO!
Questo dispositivo è destinato all’uso professionale. Pertanto, l'uso commerciale di questo apparecchio è soggetto alle norme e ai regolamenti 
nazionali rispettivamente applicabili in materia di prevenzione degli incidenti. In qualità di produttore, Adam Hall è tenuto a informare formalmente 
l’utente dell'esistenza di potenziali rischi per la salute. Danni all'udito dovuti a un volume elevato e a un'esposizione prolungata: quando è in uso, 
questo prodotto è in grado di produrre livelli di pressione sonora (SPL) elevati che possono provocare danni irreversibili all'udito in artisti, personale 
tecnico e spettatori. Per questo motivo, evitare l'esposizione prolungata a volumi superiori a 90 dB.

NOTA: questo apparecchio è stato testato ed è risultato conforme ai limiti per un dispositivo digitale di Classe B, ai sensi della Parte 15 delle 
norme FCC. Questi limiti sono intesi a fornire un'adeguata protezione da interferenze dannose in un'installazione residenziale. Questo apparecchio 
genera, utilizza e può irradiare energia a radiofrequenza e, se non installato e utilizzato secondo le istruzioni, può causare interferenze dannose 
alle comunicazioni radio. Tuttavia, non vi è alcuna garanzia che non si verificheranno interferenze in una particolare installazione. Se questo 
apparecchio causa interferenze dannose alla ricezione radiofonica o televisiva, potenzialmente determinate dall'accensione e dallo spegnimento 
dell'apparecchio, l'utente è invitato a cercare di correggere l'interferenza adottando una o più delle seguenti misure:
– Riorientare o riposizionare l'antenna ricevente.
– Aumentare la distanza tra l'apparecchio e il ricevitore.
– Collegare l'apparecchio a una presa su un circuito diverso da quello a cui è collegato il ricevitore.
– Consultare il rivenditore o un tecnico radio/TV esperto per assistenza.
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CARATTERISTICHE
•	 Processore DSP ad architettura ibrida 
•	 Modelli DSP disponibili per diversi requisiti di installazione
•	 Motore DSP a virgola mobile a 40 bit con dispositivi analogici dual core SHARC+ e processore ARM Cortex A5
•	 Sistema operativo Linux di nuova generazione
•	 Preamplificatori microfonici di qualità superiore e convertitori AD/DA a 32 bit ad alte prestazioni
•	 12 ingressi di linea/microfono bilanciati con selezione di alimentazione phantom 48 V per ingresso
•	 8 uscite bilanciate
•	 8 porte logiche GPI e 8 porte logiche GPO
•	 Connettori per morsettiera a 6 poli (passo 3,81 mm) per tutti gli ingressi/le uscite audio e di controllo
•	 Bus REMOTO per integrazione con pannelli a parete e microfoni di paging di LD Systems
•	 Design del pannello frontale semplice e intuitivo
•	 Interfaccia Ethernet per il controllo remoto tramite il software di controllo universale Xilica Designer
•	 App di controllo remoto disponibili sia su iOS che su Android, per pannelli utente personalizzati
•	 Utilità di pianificazione eventi integrata
•	 Espansione Dante 64x64 facoltativa (connettività audio su IP)
•	 Dispositivo rack 19", 1 RU

CONTENUTO DELLA CONFEZIONE
•	 Hardware LD Zone X
•	 Cavo di alimentazione
•	 Manuale utente

COLLEGAMENTI, CONTROLLI ED ELEMENTI DEL DISPLAY
PARTE FRONTALE 

1  LED DI STATO GENERALE
POWER = il dispositivo è acceso
NETWORK = connessione di rete stabilita
REMOTE = dispositivi remoti LD Systems collegati  
		  (microfoni di paging, pannelli di controllo ecc.)

2  LED INGRESSO E USCITA
Bianco = segnale presente
Rosso = segnale in overdrive
 

2 1 2

RETRO

3  CONNETTORE DI ALIMENTAZIONE E PORTAFUSIBILE
Connettore di alimentazione IEC con portafusibile. Il contenuto della confezione include un cavo di alimentazione apposito.
ATTENZIONE: sostituire il fusibile solamente con un altro dello stesso tipo e con gli stessi valori di potenza. Consultare le informazioni 
sull'alloggiamento. Se il fusibile si brucia ripetutamente, contattare un centro di assistenza autorizzato. 

4  INTERRUTTORE ON/OFF
Interruttore a bilanciere per accendere e spegnere il dispositivo.

5  ETHERNET - USB - RESET
Scheda di espansione di comunicazione con connettore Ethernet o Ethernet + Dante (64 x 64 I/O) sul modello "D", per la comunicazione tra il 
processore Zone X e il computer host, Porta di ripristino micro USB per il ripristino del firmware e Pulsante di reset IP.

6  REMOTE
Bus remoto LD Systems per l'integrazione con futuri pannelli di controllo e microfoni di paging di LD Systems. Questo connettore supporta solo 
dispositivi compatibili con bus remoto LD Systems e non porte switch Ethernet!

7  GPO
8 uscite GPO (porte logiche) con due modalità selezionabili per uscita: LED (3 mA) o sink (300 mA). Morsettiere a 3 poli (passo 3,81 mm). Osservare 
inoltre gli esempi di collegamento in questo manuale utente (consultare GPI/O - ESEMPI DI COLLEGAMENTO)

8  GPI
8 ingressi GPI (porte logiche), con attivazione cortocircuito verso massa. Morsettiere a 3 poli (passo 3,81 mm). Osservare inoltre gli esempi di 
collegamento in questo manuale utente (consultare GPI/O - ESEMPI DI COLLEGAMENTO)

9   USCITE
8 uscite di linea bilanciate. Morsettiere a 3 poli (passo 3,81 mm).

10   INGRESSI
12 ingressi audio di linea/microfono bilanciati con alimentazione phantom 48 V commutabile per canale. Morsettiere a 3 poli (passo 3,81 mm).

COLLEGAMENTO DI DISPOSITVI
Il processore DSP Zone X di LD Systems e altre unità di controllo funzionano su un'infrastruttura di rete e sono configurati e controllati tramite un 
computer con il software Xilica Designer.

PREREQUISITI PER IL FUNZIONAMENTO
•	 Computer
•	 Interfaccia di rete (router, switch PoE) 

È necessario un router per l'assegnazione dell'indirizzo IP e per la connessione rapida e semplice al computer e alle unità di controllo collegate. 
Per le unità di controllo senza alimentazione locale è necessario uno switch PoE.

•	 Cavo Ethernet. Tutte le connessioni cablate utilizzano un cavo Ethernet RJ45 standard (Cat 5e o superiore).

4

6

3

7 8 9 10

5

Don‘t connect to any 
ethernet switch port!

This port is only for LD 
Systems remote bus 
compatible devices.
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CARATTERISTICHE
•	 Processore DSP ad architettura ibrida 
•	 Modelli DSP disponibili per diversi requisiti di installazione
•	 Motore DSP a virgola mobile a 40 bit con dispositivi analogici dual core SHARC+ e processore ARM Cortex A5
•	 Sistema operativo Linux di nuova generazione
•	 Preamplificatori microfonici di qualità superiore e convertitori AD/DA a 32 bit ad alte prestazioni
•	 12 ingressi di linea/microfono bilanciati con selezione di alimentazione phantom 48 V per ingresso
•	 8 uscite bilanciate
•	 8 porte logiche GPI e 8 porte logiche GPO
•	 Connettori per morsettiera a 6 poli (passo 3,81 mm) per tutti gli ingressi/le uscite audio e di controllo
•	 Bus REMOTO per integrazione con pannelli a parete e microfoni di paging di LD Systems
•	 Design del pannello frontale semplice e intuitivo
•	 Interfaccia Ethernet per il controllo remoto tramite il software di controllo universale Xilica Designer
•	 App di controllo remoto disponibili sia su iOS che su Android, per pannelli utente personalizzati
•	 Utilità di pianificazione eventi integrata
•	 Espansione Dante 64x64 facoltativa (connettività audio su IP)
•	 Dispositivo rack 19", 1 RU

CONTENUTO DELLA CONFEZIONE
•	 Hardware LD Zone X
•	 Cavo di alimentazione
•	 Manuale utente

COLLEGAMENTI, CONTROLLI ED ELEMENTI DEL DISPLAY
PARTE FRONTALE 

1  LED DI STATO GENERALE
POWER = il dispositivo è acceso
NETWORK = connessione di rete stabilita
REMOTE = dispositivi remoti LD Systems collegati  
		  (microfoni di paging, pannelli di controllo ecc.)

2  LED INGRESSO E USCITA
Bianco = segnale presente
Rosso = segnale in overdrive
 

2 1 2

RETRO

3  CONNETTORE DI ALIMENTAZIONE E PORTAFUSIBILE
Connettore di alimentazione IEC con portafusibile. Il contenuto della confezione include un cavo di alimentazione apposito.
ATTENZIONE: sostituire il fusibile solamente con un altro dello stesso tipo e con gli stessi valori di potenza. Consultare le informazioni 
sull'alloggiamento. Se il fusibile si brucia ripetutamente, contattare un centro di assistenza autorizzato. 

4  INTERRUTTORE ON/OFF
Interruttore a bilanciere per accendere e spegnere il dispositivo.

5  ETHERNET - USB - RESET
Scheda di espansione di comunicazione con connettore Ethernet o Ethernet + Dante (64 x 64 I/O) sul modello "D", per la comunicazione tra il 
processore Zone X e il computer host, Porta di ripristino micro USB per il ripristino del firmware e Pulsante di reset IP.

6  REMOTE
Bus remoto LD Systems per l'integrazione con futuri pannelli di controllo e microfoni di paging di LD Systems. Questo connettore supporta solo 
dispositivi compatibili con bus remoto LD Systems e non porte switch Ethernet!

7  GPO
8 uscite GPO (porte logiche) con due modalità selezionabili per uscita: LED (3 mA) o sink (300 mA). Morsettiere a 3 poli (passo 3,81 mm). Osservare 
inoltre gli esempi di collegamento in questo manuale utente (consultare GPI/O - ESEMPI DI COLLEGAMENTO)

8  GPI
8 ingressi GPI (porte logiche), con attivazione cortocircuito verso massa. Morsettiere a 3 poli (passo 3,81 mm). Osservare inoltre gli esempi di 
collegamento in questo manuale utente (consultare GPI/O - ESEMPI DI COLLEGAMENTO)

9   USCITE
8 uscite di linea bilanciate. Morsettiere a 3 poli (passo 3,81 mm).

10   INGRESSI
12 ingressi audio di linea/microfono bilanciati con alimentazione phantom 48 V commutabile per canale. Morsettiere a 3 poli (passo 3,81 mm).

COLLEGAMENTO DI DISPOSITVI
Il processore DSP Zone X di LD Systems e altre unità di controllo funzionano su un'infrastruttura di rete e sono configurati e controllati tramite un 
computer con il software Xilica Designer.

PREREQUISITI PER IL FUNZIONAMENTO
•	 Computer
•	 Interfaccia di rete (router, switch PoE) 

È necessario un router per l'assegnazione dell'indirizzo IP e per la connessione rapida e semplice al computer e alle unità di controllo collegate. 
Per le unità di controllo senza alimentazione locale è necessario uno switch PoE.

•	 Cavo Ethernet. Tutte le connessioni cablate utilizzano un cavo Ethernet RJ45 standard (Cat 5e o superiore).
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7 8 9 10

5

Don‘t connect to any 
ethernet switch port!

This port is only for LD 
Systems remote bus 
compatible devices.
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È POSSIBILE CREARE UNA CONNESSIONE DI RETE TRA IL COMPUTER HOST E IL PROCESSORE ZONE X COME SEGUE:

A. ROUTER CON SERVER DHCP ATTIVATO (RACCOMANDATO)
Quando si utilizza un router con un server DHCP abilitato, il processore Zone X acquisisce automaticamente l'indirizzo IP durante l'avvio, non appena 
viene stabilita la connessione. Si consiglia di utilizzare un router e uno switch PoE se più unità di controllo/controller di altri produttori sono 
collegati alla rete. Questa combinazione fornisce un server DHCP e facilita inoltre l'alimentazione per i dispositivi collegati. Si consiglia di utilizzare 
router Linksys e switch Netgear.

Nota: in genere i router/gli switch con server DHCP attivato devono essere accesi per primi. Inoltre, tutti i cavi Ethernet devono essere collegati 
all'hardware prima che i dispositivi vengano accesi. Ciò consentirà una corretta assegnazione dell'indirizzo IP.

•	 Innanzitutto, accendere il router/lo switch.
•	 Quindi collegare il computer host a un router abilitato DHCP tramite un cavo Ethernet.
•	 Collegare il router al processore Zone X tramite un cavo Ethernet.
•	 Collegare il processore Zone X alla rete elettrica e accenderlo.

B. COLLEGAMENTO DIRETTO BASATO SU DHCP O COLLEGAMENTO INDIRETTO TRAMITE SWITCH ETHERNET
Se il processore è collegato direttamente a un computer o indirettamente tramite uno switch e non è disponibile alcun server DHCP, il collegamento 
non può essere stabilito automaticamente.
Pertanto, i collegamenti non basati su DHCP devono essere configurati manualmente. È possibile trovare ulteriori dettagli nel file della guida di 
Xilica Designer o nelle domande frequenti su Zone X di LD Systems.
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SOFTWARE XILICA DESIGNER
Oltre a consentire una configurazione dettagliata del processore Zone X, il software Xilica Designer offre inoltre l’accesso alla configurazione di 
unità di controllo remoto di terze parti, facilita la gestione dei dispositivi di rete Dante opzionali e fornisce l'integrazione universale del controllo di 
dispositivi di terze parti.

INSTALLAZIONE MAC OS X
Requisiti di sistema:
•	 Mac OS X 10.8 o versioni successive
•	 Processore da 1 GHz o superiore
•	 500 MB di spazio libero su disco rigido
•	 Scheda grafica da 1 GB
•	 RAM da 4 GB

1. Scaricare la versione più recente del software Xilica Designer sul computer dal sito Web di LD Systems (www.ld-systems.com).
2. Aprire il file ZIP scaricato.
3. Quindi aprire il file XilicaDesigner.mpkg.
4. Viene visualizzata la finestra di installazione. Seguire i singoli passaggi.

5. Se il processo di installazione è andato a buon fine, la finestra di installazione mostra il messaggio: "L'installazione è andata a buon fine".

7. Il software Xilica Designer è ora installato.
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INSTALLAZIONE WINDOWS
Requisiti di sistema:
•	 Windows 7 o versioni successive
•	 Processore da 1 GHz o superiore
•	 500 MB di spazio libero su disco rigido
•	 Scheda grafica da 1 GB
•	 RAM da 4 GB

1. Scaricare la versione più recente del software Xilica Designer sul computer dal sito Web di LD Systems (www.ld-systems.com).
2. Aprire il file ZIP scaricato.
3. Quindi aprire il file XilicaDesigner.exe.
4. Viene visualizzata la finestra di installazione. Fare clic su "Installa" per continuare.

5. Attendere finché il processo di installazione non viene completato. Tale operazione potrebbe richiedere alcuni minuti.
6. Se il processo di installazione è andato a buon fine, Windows richiede l'autorizzazione per consentire l'accesso al firewall. Si consiglia di 

configurare il sistema in modo che la comunicazione per Xilica Designer sia autorizzata su reti private come reti domestiche o aziendali. Se 
necessario, possono essere incluse le reti pubbliche. 

Selezionare le opzioni desiderate tramite il pannello di controllo, quindi fare clic su "Consenti accesso" per completare la configurazione.

7. Il software Xilica Designer è ora installato.
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AVVIO DEL SOFTWARE
Cercare il software Xilica Designer sul desktop o nella cartella delle applicazioni. Fare doppio clic sul software per avviarlo.
È ora possibile creare un nuovo progetto o aprirne uno esistente, avviare la network view o la Dante view.

NETWORK VIEW
La network view mostra tutti i processori e le unità di controllo sulla rete. Qui si possono trovare informazioni sul dispositivo tra cui: stato della 
connessione, indirizzo IP del computer, indirizzo IP del dispositivo, indirizzo Mac, nome del dispositivo, produttore e versione del firmware.

I processori collegati dovrebbero essere visibili nella network view. È presente un indicatore di stato della connessione nell'angolo in alto a sinistra 
di ciascun blocco dispositivo.

Verde: il dispositivo è connesso ed pronto per il funzionamento.

Giallo: il dispositivo è connesso ma non è pronto per il funzionamento. Spostare il cursore sull'indicatore di rete e una finestra a comparsa 
visualizzerà un messaggio con le informazioni sul problema rilevato. (Il messaggio di solito dice che nessun progetto di dispositivo è stato caricato).

Rosso:  il dispositivo non è connesso ed è offline. La comunicazione tra il software Xilica Designer e il dispositivo è assente. Controllare tutti i cavi 
e i collegamenti e assicurarsi che il dispositivo sia acceso. Se il processore sta eseguendo un aggiornamento del firmware o un riavvio, potrebbe 
esserci un'interruzione temporanea. 

Di tanto in tanto, è possibile che compaia un punto esclamativo (!). Ciò significa che è disponibile un aggiornamento del firmware. Normalmente 
non viene richiesto un intervento immediato, ma il file di progetto non contiene i modelli aggiornati dal momento che il firmware precedente non è 
supportato. È possibile trovare ulteriori dettagli nel file della guida di Xilica Designer o nelle domande frequenti su Zone X di LD Systems.
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AGGIORNAMENTO DEL FIRMWARE
Tenere presente che, in linea di principio, l'uso di una versione non recente del software con un nuovo firmware o l'uso di un nuovo software con il 
firmware precedente funziona, ma la gamma di funzioni potrebbe essere limitata o la funzionalità potrebbe non essere ottimale in tutti i casi. 

Si consiglia di utilizzare sempre le ultime versioni del software e del firmware.

Prima di iniziare, controllare le versioni del software e del firmware.

Per controllare la versione del firmware del dispositivo, assicurarsi che il dispositivo sia acceso e online. La network view segnala con un triangolo 
giallo e un punto esclamativo i dispositivi per cui è disponibile un aggiornamento del firmware. Inoltre, la versione del firmware del dispositivo è 
elencata anche nel blocco dispositivo per il rispettivo dispositivo.

La versione corrente del software viene visualizzata quando si fa clic su “About” (Informazioni) nel menu nella barra in alto.

PROCEDURA DI AGGIORNAMENTO DEL FIRMWARE
Salvare il file di progettazione del dispositivo sul computer poiché durante l'aggiornamento tutti i dati programmati verranno eliminati dal 
dispositivo. Quando l'aggiornamento del firmware è stato completato, il file di progettazione può essere ricaricato sul dispositivo.

•	 Per eseguire un aggiornamento del firmware, il dispositivo deve essere online e pronto per il funzionamento.

•	 La versione più recente del firmware per il modello Zone X corrispondente può essere scaricata dal sito Web di LD Systems (www.ld-systems.com).
•	 Fare clic con il tasto destro nella network view su un blocco dispositivo e selezionare "Firmware Upgrade” (Aggiornamento firmware).
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Viene quindi visualizzata un’avvertenza che informa che l'aggiornamento del firmware eliminerà tutti i dati dal dispositivo. Dare conferma con "OK" 
per continuare.

A questo punto, compare un menu a discesa dal quale si può selezionare il file del firmware desiderato da un file system o da una versione del 
firmware precedentemente scaricata tramite "Device Firmware Manager" (nel menu "Device Management"). Dare conferma con "OK" e cercare la 
cartella dove è stato salvato il nuovo file del firmware. Selezionare il file e fare clic su "Open” (Apri).
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Una barra di stato nella finestra del dispositivo mostra l'avanzamento dell'aggiornamento del firmware.

NON SPEGNERE IL DISPOSITIVO NÉ SCOLLEGARLO DAL COMPUTER. Se il dispositivo è spento o scollegato dal computer durante l'aggiornamento del 
firmware, potrebbe verificarsi un danneggiamento completo del processore. In questo caso, è necessario eseguire un "USB Firmware Recovery” 
(Ripristino firmware USB).

Non appena il file del firmware viene scaricato correttamente sul dispositivo, si riavvia automaticamente e i dati interni vengono aggiornati. Tale 
operazione potrebbe richiedere alcuni minuti. Durante questo periodo, l'indicatore di rete è ROSSO e il dispositivo è offline.

Quando l'aggiornamento del firmware è stato completato, ricompare l'indicazione "ON" in verde. 

NOTA: l'area gialla con il messaggio "No Data" (Nessun dato) significa che non è stato caricato alcun progetto sul dispositivo.
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PROJECT VIEW
Esistono due modi per creare un nuovo progetto:

CONFIGURAZIONE AUTOMATICA
Se il dispositivo è elencato nella network view, selezionarlo e fare clic in alto a destra su Create New Project from Selected Device(s) (Crea nuovo 
progetto da dispositivi selezionati). Si aprirà automaticamente la project view e sarà possibile selezionare un modello di progettazione.

PROGETTO VUOTO

La seconda opzione è quella di creare un nuovo progetto tramite File > New Project (Nuovo progetto).
Se si comincia con un progetto vuoto, Xilica Designer chiede quale serie DSP si desidera utilizzare. Zone X si basa sulla serie DSP Solaro, pertanto 
scegliere Solaro Series.

1. MENU "COMPONENT LIBRARY"
Questo menu fornisce un elenco dei dispositivi e dei moduli di progettazione per l'uso nel progetto. Cercare il processore Zone X in LD Systems > 
Processors.

2. AREA DI LAVORO
L'area di lavoro viene utilizzata per creare e configurare i dispositivi.

3. MENU "OBJECT PROPERTY"
 Questo menu consente di configurare le funzioni oggetto per la progettazione corrispondente.

1

2
3

DE
UT

SC
H

EN
GL

ISH
FR

AN
ÇA

IS
ES

PA
ÑO

L
PO

LS
KI

ITA
LIA

NO



140

DESIGN
A scopo dimostrativo, in questo caso verrà utilizzato un solo blocco hardware DSP; tuttavia un progetto può includere anche diversi oggetti hardware DSP.
Un progetto può essere creato offline (senza hardware collegato) e caricato sul dispositivo in un secondo momento.

1. Trascinare e rilasciare il modulo DSP desiderato, Zone X1208 in questo caso, dalla "Component Library" nell'area di lavoro.

2. Compare una finestra di selezione con tutti i modelli di progettazione (Select Design Template). Selezionare uno dei modelli offerti e comparirà 
una breve descrizione e una panoramica delle relative funzioni chiave. Selezionare un modello adatto al proprio progetto e dare conferma con Ok. 

È possibile trovare descrizioni dettagliate dei diversi modelli nelle Domande frequenti su Zone X di LD Systems.

3. Il processore di Zone X viene configurato di conseguenza.
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4. Selezionare il modulo Zone X per evidenziarlo. È ora possibile regolare le funzioni del dispositivo nel menu "Object Property" sulla destra.
 Nota: le funzioni oggetto dipendono dal dispositivo e variano in base all'oggetto selezionato. 

5. Fare doppio clic sul modulo Zone X per aprire la panoramica di progettazione schematica. In questo esempio viene selezionato il modello "Global 
Dante". Le dimensioni della finestra possono essere modificate tramite trascinamento sull'angolo della finestra.
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6. Tutti i moduli DSP possono essere elaborati offline. Fare doppio clic sul modulo desiderato per aprirlo. È possibile regolare le impostazioni per il 
modulo DSP in base ai requisiti del progetto.

In questo esempio, l'alimentazione phantom è stata attivata e i valori di guadagno sono stati regolati nei primi due canali delle impostazioni di 
ingresso.  Inoltre abbiamo ridenominato i primi quattro canali nei moduli di ingresso audio ed elaborato il canale 1 di ingresso.

7. Fare ora doppio clic sul modulo main matrix mixer per instradare i segnali di ingresso alle uscite corrispondenti.  
Questi possono anche essere elaborati con un modulo output processing.
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8. Se sono state modificate le impostazioni offline, salvare il progetto nella posizione desiderata facendo clic su File > Save As. Se è stato modificato 
un file progetto esistente, salvarlo facendo clic su File > Save. Si ottiene lo stesso risultato facendo clic sul simbolo "Save" in alto a destra 
nell'area di lavoro. 

Si consiglia di salvare i backup dei file di progetto esternamente.
L'estensione file (estensione di denominazione) per i file di progetto salvati è .pjxml.

MODALITÀ ONLINE
Se si seleziona la modalità online, il file di progettazione viene caricato sui dispositivi collegati e si potranno apportare modifiche in tempo reale.
In questo caso, tutti i dispositivi devono essere collegati e in modalità online (indicatore "ON" in verde nella network view).

Per passare alla modalità online, il modulo del dispositivo deve essere assegnato all'hardware fisico.

1. Selezionare il modulo del dispositivo che si desidera assegnare dalla project view.
2. Fare clic con il tasto destro sul modulo del dispositivo e selezionare Map to Physical Device.
3. I dispositivi riconosciuti vengono ora elencati con i relativi indirizzi Mac. Se più dispositivi identici sono collegati alla rete, possono essere 

identificati tramite i relativi indirizzi Mac. La network view mostra gli indirizzi Mac per i singoli dispositivi.

È molto importante che il nome del blocco dispositivo nel file di progettazione corrisponda esattamente all'unità nella network view, altrimenti 
il progetto non può essere caricato sull'hardware corrispondente.
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Se tutto è associato, il colore del modulo diventa verde fisso e l'indirizzo Mac del dispositivo viene visualizzato nella sezione del modulo del dispositivo.

4. Ora fare clic su Load Design to Device(s) nella parte superiore dell'area di lavoro.
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5. Compare una finestra nella quale è possibile controllare i dispositivi sui quali si desidera caricare il progetto. 
Dare conferma con Ok.

Il passaggio alla modalità online potrebbe richiedere alcuni minuti. Non interrompere il processo! L'avanzamento del processo viene mostrato in 
percentuale in una barra di stato nella parte superiore della finestra.
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Non appena l'area di lavoro appare in verde fisso, si entra in modalità online e il menu di progettazione non è più disponibile.

6. Se si desiderano modificare le impostazioni in tempo reale, si può fare doppio clic sul modulo DSP nella project view o sul blocco dispositivo nella 
project view e verrà quindi visualizzata la rappresentazione schematica del dispositivo corrispondente.
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7. Fare doppio clic sul modulo DSP desiderato o su un blocco I/O per modificare le impostazioni in tempo reale.

È possibile tornare alla modalità di progettazione in qualsiasi momento tramite il pulsante Go Back to Design Mode nella parte superiore dell'area 
di lavoro.
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Verrà richiesto se si desidera copiare nel progetto le modifiche apportate online.

Dare conferma con Yes per salvare le impostazioni online nel progetto.
Fare clic su No per tornare al file di progettazione precedente.

Dopo aver eseguito il trasferimento delle impostazioni online nel progetto, l'opzione File > Save sovrascrive il file di progetto originale.  
Selezionare File > Save As per creare e salvare un nuovo file di progetto.

Si consiglia di salvare copie di backup dei file di progetto esternamente.
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GPI/O - ESEMPI DI COLLEGAMENTI
8 INGRESSI LOGICI (INGRESSI BINARI, GPI)

Attivazione tramite collegamento di messa a terra (G)

8 USCITE LOGICHE (USCITE BINARIE, GPO)

2 modalità di uscita disponibili:
•	 LED (3 mA)
•	 Sink a terra (300 mA) 

Esempio di collegamento: 

•	 Ciascun GPI offre due stati di commutazione (tramite software) 
•	 Ciò significa che è possibile controllare due diversi preset:  
 Aprire e chiudere i contatti
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DATI TECNICI
Numero articolo LDZONEX1208 / D

Tipo di prodotto Matrice audio DSP per installazione fissa

Dati generali

Ingressi audio 12 ingressi di linea/microfono bilanciati + 1 ingresso audio bus remoto

Uscite audio 8 uscite di linea bilanciate

Ingressi logici 8 GPI - attivazione tramite collegamento di messa a terra.

Uscite logiche 8 GPO - modalità: LED (3 mA) o sink (300 mA), per uscita selezionabile

Bus remoto Sì

Connettori Ingressi/uscite: morsettiera a 3 poli, passo 3,81 mm;  
connettore di servizio micro USB B, ingresso remoto RJ45, Ethernet RJ45
Zone X1208D: Dante Primaria e Secondaria RJ45

LED Parte frontale: "POWER", "NETWORK", "REMOTE", ingressi 1 - 12 e uscite 1 - 8: LED segnale bianco, LED clip rosso

Controlli del pannello frontale No

Controlli del pannello posteriore Rete elettrica ON/OFF, "IP RESET"

Slot di espansione per schede Ethernet (ZONE X1208) o Ethernet + Dante (ZONE X1208D)

Raffreddamento Raffreddamento a convezione passivo

Alimentazione Alimentatore switching ad ampia gamma

Connettore di alimentazione Presa di alimentazione a 3 poli (IEC)

Tensione di esercizio 90 - 240 V CA; 50/60 Hz

Fusibile di rete T2,5 A L / 250 V 

Corrente di spunto rete OFF-ON 21 A  

Consumo energetico,  
modalità inattiva

23 W

Consumo energetico massimo 60 W

Temperatura di esercizio 0 °C ... +40 °C (max umidità relativa del 60%)

Larghezza rack 19" (483 mm)

Altezza 1 HE (44,5 mm)

Profondità 315 mm (con morsettiere)

Peso 3,8 kg

Distanza del rack dal 
dispositivo successivo (altezza)

1 HE

Profondità del rack (richiesta) 350 mm

Specifiche relative alle prestazioni

Sensibilità di ingresso nominale -22 dBu (onda sinusoidale, 1 kHz, guadagno massimo)

Ritaglio di ingresso nominale +20 dBu (onda sinusoidale, 1 kHz)

Distorsione armonica (THD+N) < 0,003 percento (linea IN - OUT, segnale +13 dBu, 20 Hz - 20 kHz, guadagno 0 dB)

Distorsione di intermodulazione 
(IMD), SMPTE:

< 0,01 percento (-10 dB sotto clip), larghezza di banda dell'analizzatore 90 kHz

Risposta in frequenza 15 Hz - 22 kHz (+/-0,15 dB)

Impedenza di ingresso Linea: 4 kOhm (bilanciati)
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Numero articolo LDZONEX1208 / D

Rapporto segnale-rumore > 117 dB a +20 dBu, guadagno 0 dB, larghezza di banda 20 kHz, ponderato A 

Gamma dinamica (AES17) 112 dB

Diafonia dei canali 120 dB a 100 Hz, 120 dB a 1 kHz, 105 dB a 10 kHz

Reiezione di modo comune, 
CMRR IEC

> 60 dB (1 kHz)

Guadagno massimo 42 dB

Specifiche digitali

DSP Elaborazione in virgola mobile a 40 bit, processore di dispositivi analogici dual core SHARC+

Latenza di sistema 4,3 ms

Risoluzione convertitore AD/DA 32 Bit 

Frequenza di campionamento 
convertitore AD/DA

48 kHz

Specifiche del bus remoto, misurate tra REM In e REM Out

Sensibilità di ingresso nominale 20 dBu

Ritaglio di ingresso nominale 20 dBu

Distorsione armonica (THD+N) < 0,006% (+18 dBu, 20 Hz - 20 kHz)

Risposta in frequenza 20 Hz - 20 kHz (0,1 dB)

Impedenza di ingresso  50 kOhm (bilanciati)

Rapporto segnale-rumore > 105 dB (+20 dBu, larghezza di banda 20 kHz, ponderato A) 

Reiezione di modo comune, 
CMRR IEC

> 65 dB a 1 kHz

massimo 0 dB

Alimentazione phantom +48 V CC / 500 mA

Protezione Fusibile ripristinabile (interno)
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DICHIARAZIONI DEL PRODUTTORE
GARANZIA DEL PRODUTTORE E LIMITAZIONE DI RESPONSABILITÀ
Le nostre attuali condizioni di garanzia e la limitazione di responsabilità sono consultabili alla pagina: https://cdn-shop.adamhall.com/media/pdf/
MANUFACTURERS-DECLARATIONS_LD_SYSTEMS.pdf. In caso di assistenza, rivolgersi a Adam Hall GmbH, Adam-Hall-Str. 1, 
61267 Neu Anspach / E-mail Info@adamhall.com / +49 (0)6081 / 9419-0.

CORRETTO SMALTIMENTO DEL PRODOTTO
(In vigore nell‘Unione Europea e in altri Paesi europei in cui si attui la raccolta differenziata) Questo simbolo apposto sul prodotto o sui relativi 
documenti indica che, per evitare danni all‘ambiente e alle persone causati da uno smaltimento incontrollato dei rifiuti, alla fine del suo 

ciclo di vita l‘apparecchio non deve essere smaltito insieme ai normali rifiuti domestici. Il prodotto deve quindi essere smaltito separatamente da 
altri rifiuti e riciclato nell‘ottica dell‘incentivazione di cicli economici sostenibili. I clienti privati possono richiedere informazioni sulle possibilità di 
smaltimento ecosostenibile al rivenditore presso il quale è stato acquistato il prodotto o presso le autorità regionali competenti. I clienti aziendali 
devono invece contattare il proprio fornitore e controllare le eventuali condizioni contrattuali inerenti allo smaltimento degli apparecchi. Questo 
prodotto non deve essere smaltito assieme ad altri rifiuti industriali.

CONFORMITÀ CE
Con la presente Adam Hall GmbH dichiara che questo prodotto soddisfa le seguenti direttive (ove pertinente):
Direttiva R&TTE (1999/5/CE) e RED (2014/53/UE) da giugno 2017
Direttiva bassa tensione (2014/35/CE)
Direttiva CEM (2014/30/UE)
RoHS (2011/65/UE)
La dichiarazione di conformità completa è reperibile al sito www.adamhall.com. 
Per ulteriori informazioni è inoltre possibile scrivere a info@adamhall.com.

DICHIARAZIONE CE DI CONFORMITÀ
Adam Hall GmbH dichiara che questo tipo di apparecchiature radio è conforme alla direttiva 2014/53/UE.
Il testo integrale della dichiarazione di conformità UE è disponibile al seguente indirizzo
Indirizzo Internet: www.adamhall.com/compliance/

Sono riservati errori e refusi, nonché modifiche tecniche o di altro tipo!
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